# TABLE OF CONTENTS

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. INTRODUCTION</td>
<td>1-1</td>
</tr>
<tr>
<td>1.1 Purpose</td>
<td>1-1</td>
</tr>
<tr>
<td>1.2 Audience</td>
<td>1-1</td>
</tr>
<tr>
<td>1.3 IEN System Privileges</td>
<td>1-1</td>
</tr>
<tr>
<td>1.4 Document conventions</td>
<td>1-1</td>
</tr>
<tr>
<td>2. OVERVIEW</td>
<td>2-1</td>
</tr>
<tr>
<td>2.1 Goals</td>
<td>2-1</td>
</tr>
<tr>
<td>2.2 Operator Workstation Software</td>
<td>2-1</td>
</tr>
<tr>
<td>2.3 Logging on to an IEN Workstation</td>
<td>2-1</td>
</tr>
</tbody>
</table>
## REVISION HISTORY

<table>
<thead>
<tr>
<th>VERSION</th>
<th>DATE</th>
<th>DESCRIPTION</th>
<th>REVIEWED BY</th>
</tr>
</thead>
<tbody>
<tr>
<td>DRAFT</td>
<td>12/13/02</td>
<td>Initial Draft</td>
<td>Michael Bayer</td>
</tr>
<tr>
<td>Interim FINAL</td>
<td>3/30/05</td>
<td>COTS Migration Updates</td>
<td>Jack Schneider</td>
</tr>
<tr>
<td>FINAL</td>
<td>4/2/07</td>
<td>Updated for IEN Software Version 1.09</td>
<td>Kevin Leamon</td>
</tr>
<tr>
<td>FINAL, Revision 1</td>
<td>9/20/11</td>
<td>Updated for IEN Multiple Corridor Server Project (IEN Software Version 2.02)</td>
<td>Chuck Dankocsik</td>
</tr>
<tr>
<td>Version 2.4.1</td>
<td>4/20/12</td>
<td>Updated for Freeway interface &amp; Outbound interface projects (IEN Software Version 2.4.1)</td>
<td>Chuck Dankocsik</td>
</tr>
</tbody>
</table>
1. INTRODUCTION

1.1 PURPOSE

The IEN System Operator’s Manual describes the use and features of the following Information Exchange Network (IEN) user interfaces:

- TransSuite ATMS Map
- TransSuite ATMS Explorer
- TransSuite Incident Management System (IMS)
- TransSuite Scenario Manager
- IEN Alarm Viewer
- TransSuite ATMS System Log Viewer
- TransSuite Time/Space Diagram

1.2 AUDIENCE

The IEN System Operator’s Manual is designed for system operators and shift supervisors, the primary users of the IEN.

1.3 IEN SYSTEM PRIVILEGES

Each IEN user is granted a set of privileges that determine the functions that are available to that user. User privileges are assigned through the IEN System Configuration Manager, the TransSuite Privilege Configuration Utility, and through membership in special “ATMS” user groups within the IEN’s Microsoft Windows domain. Privileges are described in detail throughout the remaining sections of this document.

The IEN System Administrator's Guide and the online help screens within the System Configuration Manager application contain more information on IEN system privileges.

1.4 DOCUMENT CONVENTIONS

There are locations in this document where formatted text is used, as illustrated below.

<table>
<thead>
<tr>
<th>C:&gt; type readme.txt</th>
<th>A monospaced font is used to indicate prompts and commands or keys typed in at a computer. The bold text is text that should be typed in.</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;Tab&gt;</td>
<td>Text enclosed in brackets indicates keystrokes.</td>
</tr>
<tr>
<td>&lt;Shift&gt;+&lt;F1&gt;</td>
<td>A plus sign indicates that two keys are to be pressed simultaneously; the first key is held down while the second key is pressed.</td>
</tr>
<tr>
<td>File</td>
<td>A bold font represents a button or menu in the application such as the File menu or the OK button.</td>
</tr>
</tbody>
</table>
2. OVERVIEW

2.1 GOALS

The Information Exchange Network (IEN) promotes coordinated traffic monitoring and control as a way to achieve seamless traffic flow between jurisdictions throughout Los Angeles County. IEN system operators and administrators are able to view traffic progression on regionally significant arteries. When unexpected incidents or recurrent events take place, operators are able to manage the resulting congestion by controlling individual devices or by activating pre-planned groups of scenario-based activities.

In addition to the monitoring and control capabilities, the IEN provides enhanced maintenance capabilities. Operators are able to view the characteristics of traffic control system devices and to use the system to diagnose coordination problems.

The IEN currently supports intersection controller, section, and arterial system detector traffic control devices.

2.2 OPERATOR SOFTWARE

The IEN operator software includes a suite of user interfaces:

- **TransSuite ATMS Map** displays a geographically accurate map of roadways in a given region. The map application has the ability to show icons that indicate the locations and status of various types of ATMS equipment and incidents. Users are able to zoom and pan the map to display different areas of the region and are able to activate and deactivate individual icon layers. Users are also able to interact with the icons. For example, a user can change the location of an incident by dragging its icon to a new position. Intersection layer icons provide a way for authorized users to send commands to the controller devices in the field.

- **TransSuite ATMS Explorer** is used to construct and display intersection, section, and regional views of the ATMS. Dynamic traffic control device icons with real-time reporting and control capabilities can be inserted into these diagrams.

- The **TransSuite Incident Management System** presents incident and planned event information to the user.

- The **TransSuite Scenario Manager** is used to monitor and control scenario response plans. When an incident occurs, authorized users can search the plan database for an appropriate response plan and then activate it.

- The **IEN Alarm Viewer** application reports critical device and coordination conditions that have been detected within the system.

- The **TransSuite ATMS System Log Viewer** displays historical event logs to the user.

- The **TransSuite Time/Space Diagram** provides a graphical representation of timing coordination between a set of intersections.

These applications are described in detail in the remaining sections of this document.

2.3 LOGGING ON TO AN IEN WORKSTATION

To access the IEN software, a user must log onto the workstation with a valid user name and password.
## TABLE OF CONTENTS

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
<th>Page #</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. INTRODUCTION</td>
<td>Purpose</td>
<td>1-1</td>
</tr>
<tr>
<td>1.2</td>
<td>ATMS Map Privileges</td>
<td>1-1</td>
</tr>
<tr>
<td>1.3</td>
<td>Opening the ATMS Map Application</td>
<td>1-1</td>
</tr>
<tr>
<td>1.4</td>
<td>Document Conventions</td>
<td>1-2</td>
</tr>
<tr>
<td>2. OVERVIEW</td>
<td></td>
<td>2-1</td>
</tr>
<tr>
<td>3. SCREEN AREAS</td>
<td>Menu Bar</td>
<td>3-1</td>
</tr>
<tr>
<td>3.1.1</td>
<td>File Menu</td>
<td>3-2</td>
</tr>
<tr>
<td>3.1.2</td>
<td>Edit Menu</td>
<td>3-2</td>
</tr>
<tr>
<td>3.1.3</td>
<td>View Menu</td>
<td>3-3</td>
</tr>
<tr>
<td>3.1.4</td>
<td>Layers Menu</td>
<td>3-6</td>
</tr>
<tr>
<td>3.1.5</td>
<td>Help Menu</td>
<td>3-6</td>
</tr>
<tr>
<td>3.2</td>
<td>Map Properties Window</td>
<td>3-6</td>
</tr>
<tr>
<td>3.3</td>
<td>Toolbars</td>
<td>3-6</td>
</tr>
<tr>
<td>3.3.1</td>
<td>Main Toolbar</td>
<td>3-7</td>
</tr>
<tr>
<td>3.3.2</td>
<td>Layers Toolbar</td>
<td>3-7</td>
</tr>
<tr>
<td>3.4</td>
<td>Pop-Up Menus</td>
<td>3-8</td>
</tr>
<tr>
<td>3.5</td>
<td>Status Bar</td>
<td>3-9</td>
</tr>
<tr>
<td>4. MAP LAYERS</td>
<td>Intersection Layer</td>
<td>4-1</td>
</tr>
<tr>
<td>4.1</td>
<td>IEN Intersection Layer Properties</td>
<td>4-2</td>
</tr>
<tr>
<td>4.1.1</td>
<td>Intersection Status Legend</td>
<td>4-2</td>
</tr>
<tr>
<td>4.1.2</td>
<td>Intersection Mode Legend</td>
<td>4-3</td>
</tr>
<tr>
<td>4.1.3</td>
<td>Intersection Operations Legend</td>
<td>4-4</td>
</tr>
<tr>
<td>4.1.4</td>
<td>Intersection Alarms Legend</td>
<td>4-4</td>
</tr>
<tr>
<td>4.1.5</td>
<td>Intersection Cycle Length Legend</td>
<td>4-5</td>
</tr>
<tr>
<td>4.1.6</td>
<td>Intersection Layer Submenu</td>
<td>4-5</td>
</tr>
<tr>
<td>4.1.2</td>
<td>Intersection Pop-Up Menu</td>
<td>4-6</td>
</tr>
<tr>
<td>4.1.3</td>
<td>Intersection Details window</td>
<td>4-7</td>
</tr>
<tr>
<td>4.1.4</td>
<td>Menu Bar</td>
<td>4-8</td>
</tr>
<tr>
<td>4.1.4.1</td>
<td>File Menu</td>
<td>4-8</td>
</tr>
<tr>
<td>4.1.4.2</td>
<td>Edit Menu</td>
<td>4-8</td>
</tr>
<tr>
<td>4.1.4.3</td>
<td>Command Menu</td>
<td>4-8</td>
</tr>
<tr>
<td>4.1.4.4</td>
<td>Show Menu</td>
<td>4-10</td>
</tr>
<tr>
<td>4.1.4.5</td>
<td>Status Bar</td>
<td>4-10</td>
</tr>
<tr>
<td>4.2</td>
<td>Arterial Congestion Link Layer</td>
<td>4-12</td>
</tr>
<tr>
<td>4.2.1</td>
<td>Arterial Congestion Link Layer Properties</td>
<td>4-12</td>
</tr>
<tr>
<td>4.2.1.1</td>
<td>Arterial Link Volume Legend</td>
<td>4-13</td>
</tr>
<tr>
<td>4.2.1.2</td>
<td>Arterial Link Speed Legend</td>
<td>4-14</td>
</tr>
<tr>
<td>4.2.1.3</td>
<td>Arterial Link Occupancy Legend</td>
<td>4-14</td>
</tr>
<tr>
<td>4.2.1.4</td>
<td>Arterial Link V+KO Legend</td>
<td>4-14</td>
</tr>
<tr>
<td>4.2.2</td>
<td>Arterial Link Layer Submenu</td>
<td>4-14</td>
</tr>
</tbody>
</table>
4.2.3 Arterial Congestion Link Pop-Up Menu .......................................................... 4-15
4.3 Incident and Planned Event Layers ...................................................................... 4-16
  4.3.1 Incident Layer Properties ............................................................................. 4-17
    4.3.1.1 Incident Layer Submenu ..................................................................... 4-17
  4.3.2 Incident Pop-Up Menu ................................................................................. 4-18
  4.3.3 Planned Event Layer Properties ................................................................. 4-21
    4.3.4 Planned Event Submenu .......................................................................... 4-21
  4.3.5 Planned Event Pop-Up Menu ...................................................................... 4-22
4.4 Informational Layer ............................................................................................. 4-22
  4.4.1 Informational Layer Properties .................................................................... 4-23
    4.4.1.1 Informational Layer Submenu ............................................................ 4-23
  4.4.2 Informational Polyline Pop-Up Menu .......................................................... 4-25
  4.4.3 Informational Text Pop-Up Menu .................................................................. 4-26
  4.4.4 Polyline Pop-Up Menu ................................................................................ 4-27
  4.4.5 Text Annotation Pop-Up Menu .................................................................... 4-27
4.5 Region Layer ........................................................................................................ 4-28
  4.5.1 Region Layer Properties ............................................................................. 4-28
  4.5.2 Region Layer Submenu ................................................................................ 4-29
  4.5.3 Region Pop-Up Menu .................................................................................. 4-30
4.6 Freeway Link Layer .............................................................................................. 4-31
  4.6.1 Freeway Link Layer Properties ................................................................... 4-32
  4.6.2 Freeway Link Layer Submenu ...................................................................... 4-33
  4.6.3 Freeway Link Pop-up Menu ......................................................................... 4-33
  4.6.4 Freeway Link Properties ............................................................................. 4-34
  4.6.5 Filtering Freeway Links ................................................................................ 4-36
  4.6.6 Adding New Freeway Link Layer Controls .................................................. 4-36

APPENDIX A – INDEX ........................................................................................................... A-1
### REVISION HISTORY

<table>
<thead>
<tr>
<th>VERSION</th>
<th>DATE</th>
<th>DESCRIPTION</th>
<th>REVIEWED BY</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>12/13/02</td>
<td>Initial Draft</td>
<td>Michael Bayer</td>
</tr>
<tr>
<td>2.0</td>
<td>3/30/06</td>
<td>COTS Migration Updates</td>
<td>Jack Schneider</td>
</tr>
<tr>
<td>Final</td>
<td>4/2/07</td>
<td>Updated for IEN Software Version 1.09</td>
<td>Kevin Leamon</td>
</tr>
<tr>
<td>FINAL, Revision 1</td>
<td>9/20/11</td>
<td>Updated for IEN Multiple Corridor Server Project (IEN Software Version 2.02)</td>
<td>Chuck Dankocsik</td>
</tr>
<tr>
<td>Version 2.4.1</td>
<td>4/20/12</td>
<td>Updated for Freeway interface &amp; Outbound interface projects (IEN Software Version 2.4.1)</td>
<td>Chuck Dankocsik</td>
</tr>
</tbody>
</table>
1. INTRODUCTION

1.1 PURPOSE

This document describes the features and use of the TransSuite ATMS Map application.

1.2 ATMS MAP PRIVILEGES

Each ATMS Map user is assigned a specific set of privileges that determine the functions that are available to that user.

Exhibit 1.1 lists the key features of the application that are available to members of each of the ATMS user groups.

### Exhibit 1.1: ATMS Map User Privileges

<table>
<thead>
<tr>
<th>PRIVILEGE</th>
<th>ATMS GROUP</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Supervisor</td>
</tr>
<tr>
<td>Intersection Layer</td>
<td></td>
</tr>
<tr>
<td>• View Intersection Layer Icons</td>
<td>X</td>
</tr>
<tr>
<td>• Add/Edit Intersection Layer Icons</td>
<td>X</td>
</tr>
<tr>
<td>Arterial Congestion Link Layer</td>
<td></td>
</tr>
<tr>
<td>• View Arterial Link Layer Icons</td>
<td>X</td>
</tr>
<tr>
<td>• Add/Edit Arterial Layer Icons</td>
<td>X</td>
</tr>
<tr>
<td>Informational Layer</td>
<td></td>
</tr>
<tr>
<td>• View Informational Layer Icons</td>
<td>X</td>
</tr>
<tr>
<td>• Add/Edit Informational Layer Icons</td>
<td>X</td>
</tr>
<tr>
<td>Freeway Link Layer</td>
<td></td>
</tr>
<tr>
<td>• View Freeway Link Layer Icons</td>
<td>X</td>
</tr>
<tr>
<td>• Add/Edit Freeway Layer Icons</td>
<td>X</td>
</tr>
</tbody>
</table>

The authority to send commands to intersection controllers requires device-level resource privileges that are configured in the IEN System Configuration Manager application. Incident management privileges are configured through the TransSuite Privilege Configuration Utility.

For more information on IEN privileges, see the IEN System Administrator's Guide and the online help screens within the IEN System Configuration Manager application.

1.3 OPENING THE ATMS MAP APPLICATION

The ATMS Map application can be opened by double-clicking the ATMS Map icon on the desktop or by selecting the shortcut from the Windows Start Menu (START > ALL PROGRAMS ➔ LOS ANGELES COUNTY IEN ➔ ATMS Map).
1.4 DOCUMENT CONVENTIONS

There are locations in this document where formatted text is used, as illustrated below.

<table>
<thead>
<tr>
<th>C:&gt; type readme.txt</th>
<th>A mono-spaced font is used to indicate prompts and commands or keys typed in at a computer. The bold text is text that should be typed in.</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;Tab&gt;</td>
<td>Text enclosed in brackets indicates keystrokes.</td>
</tr>
<tr>
<td>&lt;Shift&gt;+&lt;F1&gt;</td>
<td>A plus sign indicates that two keys are to be pressed simultaneously; the first key is held down while the second key is pressed.</td>
</tr>
<tr>
<td>File</td>
<td>A bold font represents a button or menu option in the application such as the <strong>OK</strong> button.</td>
</tr>
</tbody>
</table>
2. OVERVIEW

The ATMS Map application provides a geographically accurate map of the Los Angeles County roadways with dynamic layers that report the locations and status of various types of Advanced Traffic Management Systems (ATMS) equipment and incidents. Users are able to zoom and pan the map to different areas and are able to activate and deactivate individual map layers. Users are also able to interact with the layer icons to perform operations within the system. For example, from an incident icon’s right-click context menu, a user can change the location of that incident or cause the TransSuite Incident Management System (IMS) application to open to show detailed information for the incident.

Exhibit 2.1: ATMS Map
3. **SCREEN AREAS**

As shown in Exhibit 3.1, the ATMS Map user interface includes the following components:

- Menu Bar
- Toolbars
- Main Window
- Map Layers
- Status Bar
- Pop-up menus and dialog windows

**Exhibit 3.1: ATMS Map Window**
3.1 MENU BAR

The menu bar includes five (5) pull-down menus that contain options for manipulating the user interface and the map views:

- File Menu
- Edit Menu
- View Menu
- Layers Menu
- Help Menu

Each of these menus is described in more detail in the following sections.

3.1.1 File Menu

As shown in Exhibit 3.2, the File Menu includes menu items for manipulating map files.

Exhibit 3.2: ATMS Map File Menu

<table>
<thead>
<tr>
<th>MENU ITEM</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open View …</td>
<td>Opens the standard Windows File Open dialog that allows the user to open an existing map view.</td>
</tr>
<tr>
<td>Save View As…</td>
<td>Opens the standard Windows File Save dialog that allows the user to save the current map view to a file.</td>
</tr>
<tr>
<td>Save View With Layers As …</td>
<td>Opens the standard Windows File Save dialog that allows the user to save the current map view along with the enabled layers to a file.</td>
</tr>
<tr>
<td>Print</td>
<td>Opens the standard Window Print dialog. The contents of this dialog are dependent on the type of printer(s) installed.</td>
</tr>
<tr>
<td>Print Preview</td>
<td>Opens a print preview window.</td>
</tr>
<tr>
<td>Print Setup</td>
<td>Opens the standard Window Print setup dialog. The contents of this dialog are dependent on the type of printer(s) installed.</td>
</tr>
<tr>
<td>Recent Files</td>
<td>Lists the most recent views that the user has opened in the map. The user can open one of the views by clicking on it or by typing its number.</td>
</tr>
<tr>
<td>Exit</td>
<td>Closes the application.</td>
</tr>
</tbody>
</table>

3.1.2 Edit Menu

As shown in Exhibit 3.3, the Edit Menu contains a single menu item.

Exhibit 3.3: ATMS Map Edit Menu

<table>
<thead>
<tr>
<th>MENU ITEM</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy Map Image</td>
<td>Copies the current map view to the clipboard as a bitmap. Any other windows (such as monitoring windows) which are open over the map views will also be copied.</td>
</tr>
</tbody>
</table>
3.1.3 View Menu

As shown in Exhibit 3.4, the View Menu contains menu items for tailoring the appearance of the ATMS Map interface and for navigating the map.

**Exhibit 3.4: ATMS Map View Menu**

<table>
<thead>
<tr>
<th>MENU ITEM</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select</td>
<td>Switches to select mode.</td>
</tr>
<tr>
<td>Zoom</td>
<td>Switches to zoom mode.</td>
</tr>
<tr>
<td>Drag</td>
<td>Switches to drag mode.</td>
</tr>
<tr>
<td>Zoom and Center</td>
<td>Zooms in and centers the map view on the location of the mouse cursor.</td>
</tr>
<tr>
<td>Overview</td>
<td>Displays the default map view.</td>
</tr>
<tr>
<td>Zoom In</td>
<td>Zooms in, decreasing the map scale by one-half.</td>
</tr>
<tr>
<td>Zoom Out</td>
<td>Zooms out, increasing the map scale by two.</td>
</tr>
<tr>
<td>More Detail</td>
<td>Increases the level of detail on the background map.</td>
</tr>
<tr>
<td>Less Detail</td>
<td>Decreases the level of detail on the background map.</td>
</tr>
<tr>
<td>Pan Left</td>
<td>Moves the map view to the left</td>
</tr>
<tr>
<td>Pan Right</td>
<td>Moves the map view to the right</td>
</tr>
<tr>
<td>Pan Up</td>
<td>Moves the map view up</td>
</tr>
<tr>
<td>Pan Down</td>
<td>Moves the map view down</td>
</tr>
<tr>
<td>Message Window</td>
<td>Shows the TransCore Message Window component for the application.</td>
</tr>
<tr>
<td>Toolbar</td>
<td>Shows/Hides the main application toolbar.</td>
</tr>
<tr>
<td>Layers Toolbar</td>
<td>Shows/Hides the layers toolbar.</td>
</tr>
<tr>
<td>Status Bar</td>
<td>Shows/Hides the application status bar.</td>
</tr>
<tr>
<td>Show X-Y in Status Bar</td>
<td>Toggles the display of map coordinates in the status bar.</td>
</tr>
<tr>
<td>Map Properties</td>
<td>Displays the map properties. The dialog includes the map's properties as well as any property pages for the layers.</td>
</tr>
<tr>
<td>Set Background Color…</td>
<td>Opens the standard Windows color selection dialog box.</td>
</tr>
<tr>
<td>Refresh</td>
<td>Forces a redraw of the map and its associated layers.</td>
</tr>
</tbody>
</table>

In **Select** mode, the cursor is displayed as an arrowhead, with which the user can select items on the map such as incidents, planned events, and intersections. **Select** is the default mode for the cursor.

In **Zoom** mode, the cursor is displayed as a magnifying glass, with which the user can zoom in to or zoom out from the map. To zoom in on a location, the user places the cursor at the desired location, clicks and holds down the left mouse button, and moves the cursor up (towards the top of the screen). A rectangle appears with arrows pointing into the rectangle, indicating “zoom in.” As the user moves the mouse cursor away from the initial selection point, the rectangle becomes smaller. When the rectangle includes the desired area, the user releases the mouse button. To zoom out from a location, the user places the mouse cursor at the desired location,
clicks and holds down the left mouse button, and moves the cursor down (towards the bottom of the screen). A rectangle appears with arrows pointing out, indicating “zoom out”; releasing the mouse button will cause the view to zoom out.

In **Drag** mode, the cursor is displayed as a hand. The user can then move the map in any direction by clicking and holding down the left mouse button and then moving the mouse cursor in any direction.

In **Zoom and Center** mode, the cursor is displayed as a crosshairs. Left-Clicking the mouse will cause the map to zoom in and center on the location of the cursor. The map then reverts back to Select mode.

**Overview** causes the map to revert to the default map view that is displayed when ATMS Map first opens. **Zoom In** decreases the map scale by half, while **Zoom Out** increases the map scale by two. For example, if the user zooms in on a map that shows a two-mile area, the map will change to show a one-mile area. If the user zooms out on that same map, the map changes to show a four-mile area.

**More Detail** and **Less Detail** control the level of detail displayed on the background map. There are six (6) levels of detail, numbered from 0 (most detailed) to 5 (least detailed).

The **Pan** menu items change the user’s view of the map. For instance, if the user pans left, the new viewed area will be to the left of the previous view, with about a 20 percent overlap. The map scale does not change when the user pans. The user can also pan the map using the direction arrow keys on the keyboard.

**Message Window** toggles the display of the ATMS Map Message Window, shown in Exhibit 3.5. This window provides event information that can be used to troubleshoot the IEN applications.

---

**Exhibit 3.5: ATMS Map Message Window**

![ATMS Map Message Window](image)
The window includes a scrollable list of event messages. The Show panel is used to select which types (informational, failure, warning, and debug) of messages are being displayed. The Always on Top option sets the window to be visible on top of other applications on the desktop. The Auto-Scroll option sets the window to scroll automatically to the bottom of the list so that the user can see the most recent messages. Print… opens a print dialog, allowing the user to print the messages. Close closes the message window. Clear clears all of the messages from the window. Options… opens a dialog window, shown in Exhibit 3.6, which allows the user to select the types of messages that will cause the message window to pop up automatically.

**Exhibit 3.6: Message Window Options**

![Message Window Options](image)

Toolbar toggles the display of the main toolbar. Layers Toolbar toggles the display of the layers toolbar. Status Bar toggles the display of the status bar. Show X-Y in Status Bar toggles the display of the X-Y coordinates in the status bar. A check appears next to a menu item if the display of that item is enabled.

Map Properties opens a window that includes the map layer filters and legends. This window is described in Section 3.2.

**Exhibit 3.7: Set Background Color Window**

![Set Background Color](image)

Set Background Color… opens a dialog, shown in Exhibit 3.7, which allows the user to choose the background color for the map view.

Refresh redraws the screen.
3.1.4 Layers Menu
The Layers Menu contains options for turning on and off the display of different map layers. A check appears next to a layer if its display is enabled.

3.1.5 Help Menu
As shown in Exhibit 3.8, the Help Menu provides access to information about the ATMS Map application.

Exhibit 3.8: ATMS Map Help Menu

<table>
<thead>
<tr>
<th>MENU ITEM</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Help Topics</td>
<td>Opens the online help for the application.</td>
</tr>
<tr>
<td>About ATMS Map…</td>
<td>Opens the ATMS Map version and copyright information window</td>
</tr>
</tbody>
</table>

As shown in Exhibit 3.9, the About ATMS Map dialog displays version and copyright information for the application.

Exhibit 3.9: About ATMS Map Dialog

3.2 MAP PROPERTIES WINDOW
Selection of the Map Properties option from the View Menu, the right-click pop-up menu, or the Toolbar will open a Map Properties window.

The Map Properties window contains properties pages for the map application and layers.

The Map Properties window also includes three (3) option buttons:

- **OK** closes the window and save any changes made.
- **Close** closes the window without saving changes.
- **Apply** applies any changes that have been made and leaves the window open.

The Map page includes a single field named Use Double-buffered Display, which turns on and off a special drawing function that prevents the layer objects from flickering on the map. When the option is enabled, objects should never flicker, but the responsiveness of the application may be slightly degraded. As a rule of thumb, the option should always be enabled.

3.3 TOOLBARS
The ATMS Map interface includes two (2) toolbars:

- Main Toolbar
- Layers Toolbar
Both toolbars are always available unless the user disables them from the View menu. As the user moves the cursor over the toolbar icons, floating tooltips provide a one-word description of the icon function. A more detailed description of the icon function appears on the status bar.

3.3.1 Main Toolbar

The main toolbar contains the most commonly used features of the ATMS Map application. Many of the options are also available from the ATMS Map menus. The complete annotated toolbar is shown in Exhibit 3.10. The icons are discussed from left to right in the order they appear on the toolbar.

Exhibit 3.10: Main Toolbar

- **Open** opens the standard Windows File Open dialog, which allows the user to open an existing saved map view.
- **Save As** opens the standard Windows File Save dialog, which allows the user to save the current map view.
- **Print** opens the standard Window Print dialog. The contents of this dialog are dependent on the type of printer(s) installed on the system.
- **About** opens the ATMS Map version and copyright information window, which displays the application name, version number, release date, and copyright information.
- **Map Properties** opens the map properties window discussed in Section 3.2.
- **Overview** causes the map to revert to the default map view that is displayed when ATMS Map first opens.
- **Zoom Out** increases the map scale by two, while **Zoom In** decreases the map scale by half.
- **Less Detail** decreases the level of detail on the background map, while **More Detail** increases the level of detail.
- **Select** switches the cursor to an arrowhead, indicating that the user is then able to select items on the map such as incidents, planned events, congestion links, intersections, and informational icons.
- **Zoom** changes the cursor to a magnifying glass. The user can then zoom in to or out from the map.
- **Drag** changes the cursor to a hand, indicating that the user can then manually drag the map in any direction, as described in Section 3.1.3.
- **Zoom and Center** changes the mouse cursor to a targeting tool. In this mode, clicking the left mouse button causes the map to center on the location of the cursor and to set the detail level to 1 and the view distance to 2 miles. The cursor is also then reset to Select mode.

3.3.2 Layers Toolbar

The layers toolbar contains a pushbutton for each map layer. These buttons allow the user to enable and disable the display of a layer by “pressing” its corresponding button. The **Hide all Layers** button disables the display of all the map layers.
3.4 POP-UP MENUS

Context-sensitive pop-up menus are accessible from the main window of the user interface. A single right-click on the map or on any of the layer icons will open one of the pop-up menus described below.

The map pop-up menu, shown in Exhibit 3.11, appears when the user right-clicks and the mouse cursor is not over a layer icon or annotation. This menu contains many of the same items found on the View pull-down menu and the main toolbar. A menu item that opens a submenu is shown only if the display of its corresponding layer is enabled.

Exhibit 3.11: Map Pop-Up Menu

<table>
<thead>
<tr>
<th>MENU ITEM</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zoom</td>
<td>Switches to zoom mode.</td>
</tr>
<tr>
<td>Drag</td>
<td>Switches to drag mode.</td>
</tr>
<tr>
<td>Zoom and Center</td>
<td>Switches to zoom and center mode.</td>
</tr>
<tr>
<td>More Detail</td>
<td>Increases the level of detail on the background map.</td>
</tr>
<tr>
<td>Less Detail</td>
<td>Decreases the level of detail on the background map.</td>
</tr>
<tr>
<td>Find Address …</td>
<td>Opens the Locate Address dialog used to find a particular address or set of addresses on the map quickly.</td>
</tr>
</tbody>
</table>

Layer Submenus

Submenus that contain options for each map layer

Map Properties

Displays the map properties set. The dialog includes both the map's properties as well as any property pages for the layers.

Point Information

Displays the longitude and latitude coordinates of the map location that is at the point of the mouse cursor.

Zoom changes the cursor to a magnifying glass. The user can then zoom in to or out from the map, as described in Section 3.1.3. Drag changes the cursor to a hand. The user can then move the map in any direction. Zoom and Center changes the cursor to a crosshairs. The user can then left-click the mouse over a location on the map to zoom in and center on that location.

Exhibit 3.12: Locate Address Window
More Detail increases the level of detail displayed on the background map. There are six (6) levels of detail, numbered from 0 (most detailed) to 5 (least detailed). If the map display level is already at level 0, More Detail will be disabled. Less Detail decreases the level of detail and is disabled if the map display level is already at level 5.

Find Address… opens the dialog shown in Exhibit 3.12. The user can search for an address by entering values in the address fields and then clicking Find Matches. A list of matches will appear in the bottom half of the window. The user then selects the matches of interest and clicks Mark to insert a pushpin icon to mark the location on the map. Clicking Clear Fields clears the top half of the window, allowing new address information to be entered. Clicking Clear Marks removes the pushpins from the map. Clicking Close causes the window to close.

When a particular layer is enabled, a layer-specific option menu will appear on the task bar. The layer option menus are discussed in the following subsections.

Map Properties opens a window that includes the map layer filters and legends, as described in Section 3.2.

3.5 STATUS BAR

The Status Bar, shown in Exhibit 3.13, appears at the bottom of the ATMS Map window.

Exhibit 3.13: Status Bar

- The Current Activity pane shows either the ATMS Map copyright information, or a description of the toolbar icon that is under the mouse cursor, or indications of time-consuming actions, such as database access.
- When enabled from the View menu, the X-Y coordinates (latitude and longitude) of the cursor location on the map appear in the next two status bar panes. As the user moves the mouse cursor, the coordinates change.
- The map scale and detail level are displayed in the next pane. The scale is represented by the number of miles shown in the current map view. Detail level is indicated by a number between 0 (most detailed) to 5 (least detailed). As the user zooms out, the map shows less detail, and as the user zooms in, the detail increases.
- The rightmost pane on the status bar shows the address nearest to the cursor location on the map. As the user holds the cursor over a street or waterway, the name of the street or waterway will appear if it is included in the Map’s streets data.

The status bar can be turned on and off from the View pull-down menu.
4. MAP LAYERS

The ATMS Map application consists of static roadway information in the map background and a set of overlaying dynamic icon layers. The following map layers are provided for the Los Angeles County Information Exchange Network system:

- Intersection Layer: Shows the location and status of arterial intersection controllers.
- Arterial Congestion Link Layer: Shows congestion conditions along arterial roadways.
- Incidents Layer: Shows the location and status of traffic incidents.
- Planned Event Layer: Shows the location of current and future planned events that affect traffic.
- Informational Layer: Shows corridor names and boundaries.
- Region Layer: Provides the ability to annotate segments of roadways for use with scenario plans.
- Freeway Link Layer: Shows freeway volume, speed, and occupancy conditions.

4.1 INTERSECTION LAYER

The Intersection Layer, shown in Exhibit 4.1, contains dynamic icons that display intersection controller information.

Exhibit 4.1: Intersection Layer

Each intersection icon is associated with a single intersection controller, allowing the user to monitor detailed status information from the device.
The layer has two modes: run mode and edit mode. In run mode, intersection icons report the real-time data that the IEN is collecting from their associated intersection controllers. In edit mode, intersection icons can be added, configured, and removed from the map. An edit mode label is displayed at the top of the map view when edit mode is active.

4.1.1 IEN Intersection Layer Properties

The IEN Intersection Layer Properties page allows the user to select the active indication for intersection icons displayed on the map. The intersection layer icons are dynamic and shift colors to reflect changes in the data being collected from the controllers.

The Intersection Layer Properties page includes the following legends:

- Status Legend
- Mode Legend
- Operations Legend
- Alarms Legend
- Cycle Legend

4.1.1.1 Intersection Status Legend

The Intersection Status Legend lists the status indication colors for intersections.

**Exhibit 4.2: Intersection Layer Status Legend**

<table>
<thead>
<tr>
<th>Status</th>
<th>Mode</th>
<th>Operations</th>
<th>Alarms</th>
<th>Cycle</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal</td>
<td>Flash</td>
<td>Preempt</td>
<td>Conflict Flash</td>
<td>Failed</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Other</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Unknown</td>
</tr>
</tbody>
</table>

It also contains the **Configure Colors** and **Show Main Street Direction** options. **Configure Colors** opens the Intersection Color Config screen (see Exhibit 4.3), which can be used to change intersection indication colors. To change an indication color, click the color field and then make a selection from the displayed color palette. Selecting **IEN Default** on the color palette, will reset the color to the IEN default for that indication.
Exhibit 4.3: Intersection Color Configuration

Indication colors are per-user and per-system configuration settings; which means that each user may customize the colors to suit their preferences. Users that log onto multiple IEN systems will need to customize the colors on each of those systems separately.

**Show Main Street Direction** enables/disables the display of main street direction indications. When the indication is enabled, intersection icons will be drawn as arrows that point the direction(s) of their main street movement whenever main street green is active. Intersection icons are drawn in their default shape when main street green is not active, when the main street indication is disabled, or when the intersection’s main street direction is not defined. Main street green direction is a configurable parameter of intersection definitions. See the *IEN System Configuration Manager* application’s help screens for more information on intersection configuration.

4.1.1.2 Intersection Mode Legend

**Exhibit 4.4: Intersection Layer Mode Legend**

The Intersection Mode Legend lists the Intersection Control Mode indication colors.
4.1.1.3 Intersection Operations Legend

As shown in Exhibit 4.5, the Intersection Operations Legend provides three (3) display modes:

- **Main Street Green** indicates the controllers that are in a main-street-green phase.
- **Comm Errors** indicates the controllers that have communication errors.
- **Not Responding** indicates the controllers that are not responding.

Only one of the display modes can be active at a time. To change the mode, the user selects the appropriate radio button with the mouse.

**Exhibit 4.5: Intersection Layer Operations Legend**

4.1.1.4 Intersection Alarms Legend

As seen in Exhibit 4.6, the Intersection Alarms Legend includes four (4) display modes:

- **Conflict Flash** indicates the controllers that are reporting a conflict flash alarm.
- **Door Open** indicates the controllers that are reporting a door open alarm.
- **Internal Error** indicates the controllers that are reporting an internal error alarm.
- **Flash** indicates the controllers that are reporting a flash alarm.

Only one of the display modes can be active at a time. To change the display mode, the user selects the appropriate radio button with the mouse.

**Exhibit 4.6: Intersection Layer Alarms Legend**

4.1.1.5 Intersection Cycle Length Legend

The Intersection Cycle Length Legend, shown in Exhibit 4.7, lists the intersection cycle length indication colors.
Exhibit 4.7: Intersection Cycle Length Legend

When selected, the legend causes intersection icons to indicate which of the following conditions is true for their associated controllers:

- Planned cycle length is less than the low threshold.
- Planned cycle length is between the low and high thresholds.
- Planned cycle length is greater or equal to the high threshold.
- Planned cycle length data is unavailable (icon is white).

The cycle length thresholds are configurable. To change a threshold, enter a new value (number of seconds) into the threshold field. Threshold changes go into effect immediately.

4.1.1.6 Intersection Layer Submenu

The Intersection Layer submenu includes the items shown in Exhibit 4.8.

Exhibit 4.8: Intersection Layer Submenu

<table>
<thead>
<tr>
<th>MENU ITEM</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Intersection</td>
<td>Allows the addition of an intersection icon to the map layer. This option is available only in edit mode.</td>
</tr>
<tr>
<td>Edit Mode</td>
<td>Enables/Disables the Intersection Layer edit mode. This option is available in run and edit modes.</td>
</tr>
<tr>
<td>Filters/Legend</td>
<td>Opens the Intersection Legend, which includes the same indications found in the Intersection Layer Properties window described in Section 4.1.1. This option is available in run and edit modes.</td>
</tr>
<tr>
<td>Location Filter</td>
<td>Opens the Intersection Location Filter, which allows users to choose which intersections are displayed on the map.</td>
</tr>
<tr>
<td>Change Ctrl Size</td>
<td>Allows users to change the size of intersection icons within the map.</td>
</tr>
</tbody>
</table>

Add Intersection allows the user to add intersection icons to the map. When this option is selected, the mouse cursor becomes a crosshair. The user places the intersection icon on the map by left-clicking when the mouse cursor is over the desired map location. If the user right clicks before the intersection icon is placed, another pop-up menu appears with the following two (2) options:

- **Continue New** allows the user to complete the placement of the intersection icon.
- **Cancel New** discontinues the process of adding the intersection icon.
Once the icon has been placed on the map, the Intersection Control Properties window, shown in Exhibit 4.15 will open automatically. The user can associate the new intersection icon with a TCS controller by setting the appropriate corridor, site, system, and entity number values.

### 4.1.2 Intersection Pop-Up Menu

To open a context-sensitive pop-up menu for an intersection, the user right-clicks when the mouse cursor is over the desired intersection control icon. The menu items are shown in Exhibit 4.9.

**Exhibit 4.9: Intersection Pop-Up Layer Menu**

<table>
<thead>
<tr>
<th>MENU ITEM</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Diagram…</td>
<td>Allows the user to open the intersection’s associated ATMS Explorer diagram. This option is available only in run mode.</td>
</tr>
<tr>
<td>Show Legend…</td>
<td>Opens the Intersection Legend, which includes the same indications found in the Intersection Layer Properties Window described in Section 4.1.1. This option is available in run and edit modes.</td>
</tr>
<tr>
<td>Monitor…</td>
<td>Opens the IEN Intersection Details window described in Section 4.1.3. This option is available only in run mode.</td>
</tr>
<tr>
<td>Properties…</td>
<td>Opens the Intersection Control Properties window described in Section 4.1.1.6. This option is available in run and edit modes.</td>
</tr>
<tr>
<td>Zoom to Map…</td>
<td>Allows the user to center the map view on the selected intersection icon. This option is available only in run mode.</td>
</tr>
<tr>
<td>Rotate</td>
<td>Allows the user to rotate the icon on the map. This option is available only in edit mode.</td>
</tr>
<tr>
<td>Move</td>
<td>Allows the user to change the location of the intersection icon on the map. This option is available only in edit mode.</td>
</tr>
<tr>
<td>Delete</td>
<td>Allows the user to remove an intersection icon. This option is available only in edit mode.</td>
</tr>
<tr>
<td>View Coordination History</td>
<td>Opens the ATMS System Log Viewer to show coordination events that have been logged for the selected device. This option is available in run and edit modes.</td>
</tr>
</tbody>
</table>

**Show Diagram…** opens the intersection’s associated ATMS Explorer diagram. Intersection diagram associations are configured within the *IEN System Configuration Manager* application.

**Show Legend…** displays the Intersection Legend, which includes the same indications found in the Intersection Layer Properties Window described in Section 4.1.1.

**Monitor…** opens a more detailed view of the information being collected from the intersection device associated with the selected icon. Through the detailed view, authorized users can send mode change and timing plan change commands to the intersection. The detailed view is described in Section 4.1.3.

**Properties…** opens the Properties Window, which provides access to the configuration settings of the selected control. The Properties Window is read-only when the map layer is in run mode. The Properties Window for intersection controls is described in Section 4.1.1.6.

**Rotate** allows the user to rotate the intersection icon. After selecting this option, drag the icon to the desired position while holding down the left mouse button. Icon rotation angle can also be set on the icon page of the Properties Window.
Move allows the user to change the location of the intersection icon on the map. When this option is selected, the mouse cursor becomes a crosshair. The user can then move the intersection icon by left-clicking when the mouse cursor is over the desired map location. If the user right-clicks before the intersection icon is relocated, another pop-up menu appears with the following two (2) options:

- **Continue Move** allows the user to complete the relocation of the icon.
- **Cancel Move** allows the user to discontinue the process of relocating the icon, returning the icon to its original location.

Delete allows the user to remove the intersection icon from the map.

Zoom to Map… allows the user to center the map view on the selected intersection icon.

### 4.1.3 Intersection Details Window

The IEN Intersection Details window, shown in Exhibit 4.10, allows the user to monitor detailed intersection controller data for a single intersection. The user can open the window from the ATMS Map or ATMS Explorer applications by double-clicking on an intersection icon or by selecting Monitor from the icon's right-click pop-up menu.

**Exhibit 4.10: IEN Intersection Details Window**
4.1.4 Menu Bar

The Intersection Details window contains the following menus:

- File
- Edit
- Command
- Show

These menus are described in the following sections.

4.1.4.1 File Menu

The File menu includes the following two (2) menu items:

- Print sends a copy of the information displayed in the Intersection Details window to the system's default printer.
- Close closes the window.

4.1.4.2 Edit Menu

The Edit menu contains a single menu item, Entity, which launches the dialog window shown in Exhibit 4.11. This dialog can be used to change which intersection is being monitored.

Exhibit 4.11: Intersection Details Window Entity Dialog

The user enters the appropriate Corridor, Site, System, and Entity Number values to identify the desired intersection. The user clicks OK to begin monitoring the specified intersection or Cancel to continue monitoring the originally selected intersection.

4.1.4.3 Command Menu

The Command menu includes the following menu items:

- Change Plan
- Change Mode
- Release IEN Control

- Flash Off
- Flash On

A user is able to send a command to a particular intersection only if that user has been granted the privilege to do so. Please note that the IEN does not directly control intersections. The IEN can request that a traffic control system change the plan or mode of one of its intersections, but it
is up to the traffic control system to implement that command. IEN commands may not be supported or authorized by every connected traffic control system.

**Exhibit 4.12: Change Plan Dialog**

![Change Plan Dialog](image)

**Change Plan** opens the window shown in Exhibit 4.12, which allows authorized users to request that the operational plan of an intersection controller be changed by its native traffic control system.

The plan currently running at the intersection is identified at the top of the window. To change the plan, the user enters the desired plan number and clicks **OK**. A confirmation dialog is displayed: the user selects **Cancel** to retain the current plan or **YES** to confirm the plan change. Clicking **Cancel** in the Change Plan window closes the window without changing the plan.

**Change Mode** opens the window shown in Exhibit 4.13, which allows authorized users to request that the operational mode of an intersection controller be changed by its native traffic control system.

**Exhibit 4.13: Change Mode Dialog**

![Change Mode Dialog](image)

The current mode is identified at the top of the window. The current mode and its radio button are disabled among the choices. To change the mode, the user selects the desired mode and clicks **OK**. A confirmation dialog is displayed: the user selects **Cancel** to retain the current mode or **YES** to confirm the mode change. Clicking **Cancel** in the Change Mode window closes the window without changing the mode.

The **Release IEN Control** menu item releases an intersection from IEN control. A confirmation dialog is displayed: the user selects **Cancel** to retain control or **YES** to release the intersection.

The **Flash On** and **Flash Off** commands allow authorized users to request that an intersection be put into or removed from flash operation by its native traffic control system. A confirmation dialog is displayed: the user selects **Cancel** to drop the command or **YES** to send the command.
4.1.4.4  Show Menu

The **Show** pull-down menu contains a single menu item, **Zoom to Map**, which opens the ATMS Map application, if it is not currently open, and centers the map view on the selected intersection.

4.1.4.5  Status Bar

The status bar, shown in Exhibit 4.14, appears at the bottom of the Intersection Details window.

**Exhibit 4.14: Status Bar**

![Status Bar](image)

The left pane of the status bar displays the application's copyright information by default. It will also indicate time-consuming actions. The right pane displays the current time and date.

**Exhibit 4.15: Intersection Control Properties Window**

![Intersection Control Properties Window](image)

On the Icon page, the user can set the Detail Level of the intersection icon, which determines the detail level at which the icon is drawn on the map. This is useful for filtering smaller arterial intersections from the lower detailed map views.

**Location Filter** opens the Intersection Location Filter window (shown below in Exhibit 4.16), which is used to select which intersection icons are displayed on the map.
Intersections can be filtered based on their corridor or site and system. To apply a filter, choose the filter type and then select/deselect options on the filter list as desired. Intersections that belong to selected corridors or sites/systems are shown on the map. Intersections in deselected corridors or sites/systems are not shown on the map.

**Change Ctrl Size** opens the Select Control Size window (shown in Exhibit 4.17 below), which can be used to change the size of intersections icons within the map.

![Intersection Select Control Size Window](image)

To change the control size, select the desired value (icon diameter in number of pixels) in the Control Size field and click the **OK** button. Click **Use Default** to use the default size for intersection icons. The available sizes in the Control Size field can be changed by clicking the **Change Sizes** button.
4.2 ARTERIAL CONGESTION LINK LAYER

The Arterial Congestion Link Layer, shown in Exhibit 4.18, contains dynamic icons that display volume, speed, occupancy, and V+kO data that has been aggregated from a set of system detectors along an arterial segment.

Exhibit 4.18: Arterial Congestion Link Layer

This layer has two modes, run mode and edit mode. In run mode, the arterial link icons reflect the real-time data that is being collected from their detectors. In edit mode, arterial link icons can be added, configured, and removed. The detector groups that provide the data for the arterial link icons are configured in the IEN System Configuration Manager application, which is described in the IEN System Administrator's Guide.

4.2.1 Arterial Congestion Link Layer Properties

As shown in Exhibit 4.19, the Congestion Links page allows the user to select the active indication for arterial link icons displayed on the map. Arterial congestion link layer icons are dynamic and shift colors to reflect changes in the data being reported by the detectors that make up the link.
Exhibit 4.19: Arterial Congestion Link Properties

The Arterial Link Layer Properties page includes the following legends:

- Volume
- Speed
- Occupancy
- V+KO

Each page includes a series of the user-definable thresholds for the legend indications. Each page also includes a series of display filter checkboxes that are used to select the link thresholds that will be displayed on the map. The Arrowheads filter determines whether directional arrowheads will be shown on the link icons. Links whose level of congestion matches the selected filter are displayed on the map. Save to DB saves the current threshold and filter settings to the database. These settings are applied each time the legend is opened.

Each legend, based on its specified thresholds, classifies the level of congestion using six (6) colors:

- Red = worst
- Pink
- Yellow
- Light Green
- Dark Green = best
- White = unknown

The thresholds, which determine the different colors of the link icons, are configurable by the user. If data is not available for a link, it is drawn as White (unknown).

4.2.1.1 Arterial Link Volume Legend

Exhibit 4.20: Arterial Link Volume Legend

As shown in Exhibit 4.20, the Arterial Link Volume Legend shows the current vehicle-per-hour thresholds of arterial links.
4.2.1.2 Arterial Link Speed Legend
As shown in Exhibit 4.21, the Arterial Link Speed Legend shows the current mile-per-hour thresholds of the arterial links.

Exhibit 4.21: Arterial Link Speed Legend

<table>
<thead>
<tr>
<th>Vol</th>
<th>Spd</th>
<th>Occ</th>
<th>V+K</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>LINK SPEED (mph)</td>
<td>&lt;= 20</td>
<td>&lt;= 30</td>
<td>&lt;= 40</td>
<td>&lt;= 50</td>
</tr>
</tbody>
</table>

4.2.1.3 Arterial Link Occupancy Legend
As shown in Exhibit 4.22, the Arterial Link Occupancy Legend shows the current percent occupancy thresholds of the arterial links.

Exhibit 4.22: Arterial Link Occupancy Legend

<table>
<thead>
<tr>
<th>Vol</th>
<th>Spd</th>
<th>Occ</th>
<th>V+K</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>LINK OCCUPANCY (%)</td>
<td>&gt;= 80</td>
<td>&gt;= 60</td>
<td>&gt;= 40</td>
<td>&gt;= 20</td>
</tr>
</tbody>
</table>

4.2.1.4 Arterial Link V+KO Legend

Exhibit 4.23: Arterial Link V+KO Legend

<table>
<thead>
<tr>
<th>Vol</th>
<th>Spd</th>
<th>Occ</th>
<th>V+K</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>LINK V+KO (%)</td>
<td>&gt;= 80</td>
<td>&gt;= 60</td>
<td>&gt;= 40</td>
<td>&gt;= 20</td>
</tr>
</tbody>
</table>

The Arterial Link V+KO Legend, shown in Exhibit 4.23, shows the V+KO thresholds of the arterial links.

4.2.2 Arterial Link Layer Submenu
The Arterial Link Layer submenu includes the items shown in Exhibit 4.24.
### Exhibit 4.24: Arterial Link Layer Submenu

<table>
<thead>
<tr>
<th>MENU ITEM</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Arterial Link</td>
<td>Allows the user to add an arterial link icon to the map layer. This option is available only in edit mode.</td>
</tr>
<tr>
<td>Filters/Legend</td>
<td>Opens the Arterial Link Legend, which includes the same indications found in the Arterial Link Layer Properties window described in Section 4.2.1. This option is available in run and edit modes.</td>
</tr>
<tr>
<td>Edit Mode</td>
<td>Enables and disables the Arterial Link Layer edit mode. This option is available in run and edit modes.</td>
</tr>
</tbody>
</table>

**New Arterial Congestion Link** allows the user to draw a new arterial link icon on the map. When this option is selected, the mouse cursor becomes a crosshair. The user left-clicks when the mouse cursor is over the desired beginning point of the link. Each subsequent left-click adds a new vertex to the link. Double-clicking on the endpoint or pressing the <Enter> key ends the addition of new vertices and completes the drawing of the new link.

Once the icon has been placed on the map, the ATMS Arterial Link Control Properties window, shown in Exhibit 4.26, will open automatically. The user can then associate the new congestion link icon with one of the IEN congestion links by setting the appropriate entity value.

### 4.2.3 Arterial Congestion Link Pop-Up Menu

To open a context-sensitive pop-up menu for an arterial link, the user right-clicks when the mouse cursor is over the desired congestion link icon. The menu items are shown in Exhibit 4.25.

### Exhibit 4.25: Arterial Congestion Link Pop-Up Menu

<table>
<thead>
<tr>
<th>MENU ITEM</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Legend</td>
<td>Opens the Arterial Link Legend, which includes the same indications found in the Arterial Link Layer Properties window described in Section 4.2.1. This option is available in run and edit modes.</td>
</tr>
<tr>
<td>Properties</td>
<td>Opens the Congestion Link Control Properties window described in Section 4.2.2. This option is available in run and edit modes.</td>
</tr>
<tr>
<td>Edit Link</td>
<td>Allows the user to modify the link icon. This option is available only in edit mode.</td>
</tr>
<tr>
<td>Delete Link</td>
<td>Allows the user to remove the link icon. This option is available only in edit mode.</td>
</tr>
</tbody>
</table>

**Edit Link** allows the user to edit the selected arterial link icon. While the edit mode is active, each link vertex will appear as a small square, and the entire link will be highlighted. The user can change the shape of the link by dragging the link vertices with the mouse cursor. If the user right-clicks on a link while the edit mode is active, a secondary menu will pop up with various editing options.

**Delete Link** enables the user to remove an arterial link icon from the map. A pop-up window appears to request confirmation of the removal of the link.
Exhibit 4.26: Arterial Congestion Link Control Properties Window

On the Icon page, the user can set the Detail Level of the link. This determines the detail level at which the icon is drawn on the map and is useful for filtering smaller arterial segments from the lower detailed map views. The user can also specify a speed limit for the arterial link and add comments. These fields will be displayed in the icon tooltip.

4.3 INCIDENT AND PLANNED EVENT LAYERS

The Incident and Planned Event Layers, shown in Exhibit 4.27, contain dynamic icons that display the status and location of traffic events within the IEN.

Exhibit 4.27: Incident and Planned Event Layers

Each icon is associated with a particular traffic incident or planned event defined within the TransSuite IMS application. These icons allow the user to monitor and track the status of events that affect traffic conditions throughout the roadway system.
4.3.1 Incident Layer Properties

Exhibit 4.28: Incident Properties Window

The Incidents page, shown in Exhibit 4.28, includes the incident icon legend and a series of display filters. The user selects the incident types and other information to be shown on the map.

4.3.1.1 Incident Layer Submenu

The Incident Layer submenu includes the items shown in Exhibit 4.29.

Exhibit 4.29: Incident Layer Submenu

<table>
<thead>
<tr>
<th>MENU ITEM</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Incident</td>
<td>Allows the user to add an incident icon to the map layer.</td>
</tr>
<tr>
<td>Incident Filters</td>
<td>Opens the Incident Filter window that includes the same indications found in the Incident Layer Properties window described in Section 4.3.1.</td>
</tr>
<tr>
<td>Place Incident</td>
<td>Allows the user to add an icon to the map layer for an incident whose geographical location cannot be determined from the information entered into the location fields of the incident record.</td>
</tr>
</tbody>
</table>

New Incident allows the user to declare a new incident by placing an incident icon on the map. When this option is selected, a red diamond symbol will be attached to the mouse cursor. The incident is placed on the map when the user left-clicks with the mouse cursor over the desired icon location. If the user right-clicks before the new incident is placed, another pop-up menu appears with the following two (2) options:

- **Continue New Incident** allows the user to complete the placement of the new incident icon.
- **Cancel New Incident** discontinues the declaration of a new incident.

When a new incident icon is placed, the TransSuite IMS Add Incident dialog will open, in which incident details can be added. Section 5 contains additional information about the TransSuite IMS application.

Incident Filters opens the Incident Filter window, which includes the same indications found in the Incident Layer Properties window discussed in Section 4.3.1.

Place Incident opens the Non-Geocoded Incidents window, which shows a list of incidents that cannot be matched to a map location. To place an incident on the map, select the incident within
the list and click on the **Place On Map** button. Move the mouse cursor to the appropriate location within the map display and then left-click the mouse.

### 4.3.2 Incident Pop-Up Menu

To open a context-sensitive pop-up menu for an incident, the user right-clicks when the mouse cursor is over the desired incident icon. The menu items are shown in Exhibit 4.30.

#### Exhibit 4.30: Incident Pop-Up Menu

<table>
<thead>
<tr>
<th>MENU ITEM</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Polyline Annotation</td>
<td>Allows the user to add a polyline annotation to the map layer.</td>
</tr>
<tr>
<td>Add Text Annotation</td>
<td>Allows the user to add a text annotation to the map layer.</td>
</tr>
<tr>
<td>Move Incident</td>
<td>Allows the user to move the incident icon on the map and update the IMS record with the new location information.</td>
</tr>
<tr>
<td>Acknowledge Incident</td>
<td>Allows the user to acknowledge an incident displayed on the map. This option is available only when an unacknowledged incident icon has been selected.</td>
</tr>
<tr>
<td>Clear Incident</td>
<td>Allows the user to clear an incident from the map. This option is available only when an active incident has been selected.</td>
</tr>
<tr>
<td>Reopen Incident</td>
<td>Allows the user to reactivate a cleared Incident from the map. This option is available only when a cleared incident icon has been selected.</td>
</tr>
<tr>
<td>Show in IMS</td>
<td>Opens the IMS application to display the details of the selected incident.</td>
</tr>
</tbody>
</table>

**Add Polyline Annotation** allows the user to draw a polyline annotation icon on the map. When this option is selected, the mouse cursor becomes a crosshair. The user left-clicks when the mouse cursor is over the desired beginning point of the polyline. Each subsequent left-click adds a new vertex to the polyline. Double-clicking on the endpoint or pressing the `<Enter>` key ends the addition of new vertices and completes the drawing of the new polyline annotation.

Once the icon has been placed on the map, the ATMS Map Polyline Control Properties window, shown in Exhibit 4.31, will automatically open.

#### Exhibit 4.31: ATMS Map Polyline Control Properties Window

On the Polyline page, the Tooltip Text field allows the user to enter text which will be displayed when the mouse cursor is held over the polyline icon. The Line Thickness setting can be varied.
from 1 (thinnest) to 16 (thickest). Six (6) line styles are available from the Line Style dropdown list. If Closed Polygon has been selected, the Fill Style and Hatch Style fields are enabled, allowing the user to select a fill pattern to be used for the icon display. The Detail Level field value determines the detail level at which the icon is drawn on the map. This is useful for preventing icon clutter on the lower detailed map views.

On the Colors page, the user can choose the colors for the polyline and for the fill.

Exhibit 4.32: ATMS Map Text Control Properties Window

Add Text Annotation allows a text annotation to be placed on the map. When this menu item is selected, the mouse cursor becomes a crosshair. The user places the annotation text on the map by left-clicking when the mouse cursor is over the desired map location. Once the text location has been established, the ATMS Map Text Control Properties window, shown in Exhibit 4.32, will automatically open.

On the General page, the user enters in the Display Text field the text to be displayed on the map. Text entered in the Tooltip Text field is displayed in the icon tooltip. The user can set the Detail Level of the annotation, which determines the detail level at which the text annotation is drawn on the map. As long as a True Type text font is selected on the Fonts page, the user can set a rotation angle for the icon. As long as a True Type text font is selected on the Fonts page, the specified rotation angle will be used in drawing the text.

On the Fonts and Colors pages, the user can define how the text will look on the map.

Move Incident allows the user to change the location of the incident icon on the map. When this menu item is selected, the mouse cursor becomes a crosshair. The user can then move the incident icon by left clicking when the mouse cursor is over the desired map location. If the user right-clicks before the incident icon is relocated, another pop-up menu appears with the following two (2) options:

- Continue Move Incident allows the user to complete the relocation of the icon.
- Cancel Move Incident allows the user to discontinue the process of relocating the icon, returning the icon to its original location.

Once the new location has been selected, a dialog will open which allows the user to update the IMS incident address with the new location information.
Acknowledging an Incident appears in the pop-up menu only if the incident is awaiting acknowledgment of a change (i.e., has a pencil on the icon). Clicking **Acknowledge Incident** opens a dialog box to confirm that the user wants to acknowledge the change. The dialog includes the IMS incident description. The user selects **Yes** to acknowledge or selects **No** to close the dialog box without acknowledging the change.

**Clear Incident** opens the window shown in Exhibit 4.33.

**Exhibit 4.33: Clear Incident Window**

The Associated Devices panel lists the devices and actions that have been associated with the incident that is being cleared (see the IMS operators manual for more information on incident associations). The clearing associated devices list reminds the clearing operator of which actions were initiated in response to the incident.

In the Cleared By panel the user selects the department or agency Source and the Contact person reporting the Clearing status. A Clearing status is selected from the drop-down list. The Date and the Time the incident was cleared are specified in the Time Cleared panel. The current date and time are displayed by default when the user opens the window. Either of these fields can be modified by typing in a new value. The Time field can be modified by using the up and down arrow buttons. The Date field can be changed by using the down arrow button, which opens a date-selection calendar. The user clicks **OK** to mark the incident as cleared or **Cancel** to close the window without marking the incident as cleared.

**Reopen Incident** allows the user to reactivate a previously cleared incident. A dialog box is displayed to confirm reactivation of the incident. The user selects **Yes** to reopen the incident or **No** to close the dialog without reopening the incident.
Show in IMS opens the TransSuite IMS application to display the details of the selected incident.

### 4.3.3 Planned Event Layer Properties

**Exhibit 4.34: Planned Event Properties Window**

The Planned Events page, shown in Exhibit 4.34, is used to determine which events are to be displayed on the planned event layer. The user can filter by date, planned event type, or both by checking the boxes next to the filter criteria. If no filters are selected, all active planned events are displayed on the map.

The Date Filters buttons allow the user to filter by a specific date, a date range, or by one of the displayed time periods. The user can define the date range by clicking the down arrow button, which opens a date-selection calendar. If the display of only today’s events is desired, the user can click the Today button to set the date range to today’s date.

The user can choose an event type filter by selecting the event type from Filter by Type drop-down list.

The Show Annotations option allows the user to either show or hide the display of planned event text annotations and polyline annotations.

### 4.3.4 Planned Event Submenu

The Planned Event Layer submenu contains the items shown in Exhibit 4.35.

**Exhibit 4.35: Planned Event Layer Submenu**

<table>
<thead>
<tr>
<th>MENU ITEM</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Planned Event</td>
<td>Allows the user to add a planned event icon to the map layer.</td>
</tr>
<tr>
<td>Planned Event Filters</td>
<td>Opens the Planned Event Filter window that includes the same indications found in the Planned Event Layer Properties window described in Section 4.3.3.</td>
</tr>
<tr>
<td>Place Planned Event</td>
<td>Allows the user to add an icon to the map layer for a planned event whose geographical location cannot be determined from the information entered into the location fields of the planned event record.</td>
</tr>
</tbody>
</table>

**New Planned Event** allows the user to declare a new planned event by placing a planned event icon on the map. When this option is selected, a green diamond symbol is attached to the mouse cursor. The user can then place the planned event icon on the map by left-clicking when the
mouse cursor is over the desired map location. If the user right-clicks before the planned event icon is placed, another pop-up menu appears with the following two (2) options:

- **Continue New Planned Event** allows the user to complete the placement of the planned event icon.
- **Cancel New Planned Event** discontinues the process of adding a new planned event.

When a new planned event icon is placed, the *TransSuite* IMS Add Planned Event dialog will open in which planned event details can be added.

**Planned Event Filters** opens the Planned Events Filter window, which includes the same indications found in the Planned Event Layer Properties window described in Section 4.3.3.

**Place Planned Event** opens the Non-Geocoded Planned Events window, which shows a list of planned events that cannot be matched to a map location. To place a planned event on the map, select the planned event within the list and click on the **Place On Map** button. Move the mouse cursor to the appropriate location within the map display and then left-click the mouse.

### 4.3.5 Planned Event Pop-Up Menu

To open a context-sensitive pop-up menu for a planned event, the user right-clicks when the mouse cursor is over the desired planned event icon. The menu items are shown in Exhibit 4.36.

#### Exhibit 4.36: Planned Event Pop-Up Menu

<table>
<thead>
<tr>
<th>MENU ITEM</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Polyline Annotation</td>
<td>Allows the user to add a polyline annotation to the map layer.</td>
</tr>
<tr>
<td>Add Text Annotation</td>
<td>Allows the user to add a text annotation to the map layer.</td>
</tr>
<tr>
<td>Move Planned Event</td>
<td>Allows the user to move the planned event icon on that map and update the IMS record with the new location information.</td>
</tr>
<tr>
<td>Show in IMS</td>
<td>Opens the IMS application to display the details of the selected planned event.</td>
</tr>
</tbody>
</table>

The planned event pop-up menu items are identical to the incident pop-up menu items with the exception that planned events cannot be acknowledged, cleared, or reopened. Section 4.3.2 contains a description of the planned event pop-up menu items.

### 4.4 INFORMATIONAL LAYER

The Informational Layer, shown in Exhibit 4.37, contains static text and polyline icons that allow the user to display location and boundary notations. Because the detailed roadway information provided by the base map cannot be modified, the informational icons can be used to add additional information to the map views.
Exhibit 4.37: Informational Layer

The layer has two modes, run mode and edit mode. In run mode, informational icons are displayed. In edit mode, informational icons can be added, configured, and removed.

4.4.1 Informational Layer Properties

The Informational Icons page, shown in Exhibit 4.38, is used to specify which types of informational items are displayed on the map. A check beside a display type enables the display of that type of informational item.

Exhibit 4.38: Informational Icons

4.4.1.1 Informational Layer Submenu

The Informational Layer submenu includes the items found in Exhibit 4.39.

Exhibit 4.39 - Informational Layer Submenu

<table>
<thead>
<tr>
<th>MENU ITEM</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Polyline</td>
<td>Allows the user to add an informational polyline icon to the map layer. This option is available only in edit mode.</td>
</tr>
<tr>
<td>MENU ITEM</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
</tr>
<tr>
<td>New Text</td>
<td>Allows the user to add an informational text icon to the map layer. This option is available only in edit mode.</td>
</tr>
<tr>
<td>Filters</td>
<td>Opens the Informational Filters window, which includes the same indications found in the Informational Layer Properties window described in Section 4.4.1. This option is available in run and edit modes.</td>
</tr>
<tr>
<td>Edit Mode</td>
<td>Enables and disables the Informational Layer edit mode. This option is available in run and edit modes.</td>
</tr>
</tbody>
</table>

**New Polyline** allows the user to draw an informational polyline icon on the map. When this option is selected, the mouse cursor will become a crosshair. The user left-clicks when the mouse cursor is over the desired beginning point of the polyline icon. Each subsequent left-click adds a new vertex to the polyline. Double-clicking on the endpoint or pressing the `<Enter>` key ends the addition of new vertices and completes the drawing of the new informational polyline icon.

Once the icon has been placed on the map, the Informational Polyline Control Properties window, shown in Exhibit 4.40, will automatically open.

**Exhibit 4.40: Informational Polyline Control Properties Window**

On the Entity page, the user can set the Detail Level for the polyline icon, which determines the detail level at which the icon is drawn on the map. This is useful for preventing icon clutter on the lower detailed map views. The user can also add a Display ID and Comments for the polyline. These fields are displayed in the icon tooltip. On the Colors page, the user can select the color of the polyline from the provided palette.

**New Text** allows the user to place informational text on the map. When this option is selected, the mouse cursor becomes a crosshair. The user can then place the text on the map by left-clicking when the mouse cursor is over the desired map location. When the text location has been established on the map, the Map Text Control Properties window, shown in Exhibit 4.41, will automatically open.
Exhibit 4.41: Map Text Control Properties Window

On the General page, the user enters in the Display Text field the text to be displayed on the map. Text entered in the Tooltip Text field is displayed in the icon tooltip. The user can set the Detail Level of the informational text, which determines the detail level at which the text is drawn on the map. As long as a True Type text font is selected on the Fonts page, the specified rotation angle will be used in drawing the text.

On the Fonts and Colors pages, the user defines the appearance of the text that will be displayed on the map.

4.4.2 Informational Polyline Pop-Up Menu

To open a context-sensitive pop-up menu for an informational polyline, the user right-clicks when the mouse cursor is over the desired polyline icon. The menu items are shown in Exhibit 4.42:

<table>
<thead>
<tr>
<th>MENU ITEM</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit Informational Polyline</td>
<td>Allows the user to modify the selected polyline annotation icon on the map layer. This menu item is available only in edit mode.</td>
</tr>
<tr>
<td>Delete Informational Polyline</td>
<td>Allows the user to remove the selected polyline annotation icon. This menu item is available only in edit mode.</td>
</tr>
<tr>
<td>Properties</td>
<td>Opens the Informational Control Properties window described in Section 4.4.1. This menu item is available in run and edit modes.</td>
</tr>
<tr>
<td>Add Vertices</td>
<td>Allows the user to add vertices to the end of the selected polyline. This menu item is available only after the Edit Informational Polyline menu item has been selected.</td>
</tr>
<tr>
<td>Insert Vertex Here</td>
<td>Allows the user to add a vertex at the selected point of the polyline. This menu item is available only after the Edit Informational Polyline menu item has been selected.</td>
</tr>
<tr>
<td>Delete Vertex</td>
<td>Allows the user to remove the selected vertex from the polyline. This menu item is available only after the Edit Informational Polyline menu item has been selected.</td>
</tr>
<tr>
<td>Stop Editing Polyline</td>
<td>Returns the polyline to its display mode.</td>
</tr>
</tbody>
</table>
Properties opens the Informational Control Properties window described in Section 4.4.1.

Edit Polyline allows the user to modify the selected polyline annotation icon. When this menu item is selected, the polyline is highlighted with its vertices displayed as small white squares. To move a vertex, select it with the mouse cursor and then drag the icon to the desired position while holding down the left mouse button. While the polyline is being edited, additional menu items are available from the pop-up menu: Add Vertices allows the user to add segments to the end of the selected polyline. When this menu item is selected, the mouse cursor becomes a crosshair. The user left-clicks when the mouse cursor is over the desired endpoint of the segment being added. Each subsequent left-click adds a new segment to the polyline. Double-clicking on the endpoint or pressing the <Enter> key ends the addition of new vertices and completes the modification of the polyline.

Insert Vertex Here allows the user to add a vertex at the selected point on the polyline. Once the vertex has been added, it can be repositioned as needed. Delete Vertex allows the user to delete the selected vertex. Stop Editing Polyline returns the polyline to its default display mode. The polyline will no longer be highlighted and its vertices will no longer be visible.

Delete Informational Polyline allows the user to remove the selected polyline annotation icon. A confirmation dialog will be displayed before the modifications to the polyline are committed to the database. The user selects Yes to save the changes or No to discard the changes.

4.4.3 Informational Text Pop-Up Menu

To open a context-sensitive pop-up menu for informational text, the user right-clicks when the mouse cursor is over the desired informational text. The menu items are shown in Exhibit 4.43.

<table>
<thead>
<tr>
<th>MENU ITEM</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties</td>
<td>Opens the ATMS Map Text Control Properties window described in section 4.3.2. This menu item is available in run and edit modes.</td>
</tr>
<tr>
<td>Move Text Annotation</td>
<td>Allows the user to change the location of the selected text on the map. This menu item is available only in edit mode.</td>
</tr>
<tr>
<td>Delete Text Annotation</td>
<td>Allows the user to remove the selected text annotation icon. This menu item is available only in edit mode.</td>
</tr>
</tbody>
</table>

Properties opens the Informational Polyline Control Properties window described in Section 4.4.1.1.

Move Text Annotation allows the user to change the location of an informational text annotation. When this menu item is selected, the mouse cursor becomes a crosshair. The user can then move the text annotation by left-clicking when the mouse cursor is over the desired map location.

Delete Text Annotation allows the user to remove the selected text annotation from the map. A confirmation dialog will be displayed before the modifications to the text annotation are committed to the database. The user selects Yes to save the changes or No to discard the changes.
4.4.4 Polyline Pop-Up Menu

To open a context-sensitive pop-up menu for an incident or planned event polyline annotation, the user right-clicks when the mouse cursor is over the desired polyline. The menu items are shown in Exhibit 4.44

<table>
<thead>
<tr>
<th>MENU ITEM</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Associated Object</td>
<td>Opens the TransSuite IMS application to display the details of the selected incident or planned event.</td>
</tr>
<tr>
<td>Edit Polyline</td>
<td>Allows the user to modify the selected polyline annotation icon on the map layer.</td>
</tr>
<tr>
<td>Delete Polyline</td>
<td>Allows the user to remove the selected polyline annotation icon.</td>
</tr>
<tr>
<td>Add Vertices</td>
<td>Allows the user to add vertices to the end of the selected polyline. This menu item is available only after the Edit Polyline menu item has been selected.</td>
</tr>
<tr>
<td>Insert Vertices Here</td>
<td>Allows the user to add vertices at the selected point of the polyline. This menu item is available only after the Edit Polyline menu item has been selected.</td>
</tr>
<tr>
<td>Delete Vertex</td>
<td>Allows the user to remove the selected vertex from the polyline. This menu item is available only after the Edit Polyline menu item has been selected.</td>
</tr>
<tr>
<td>Stop Editing Polyline</td>
<td>Returns the polyline to its display mode.</td>
</tr>
<tr>
<td>Properties</td>
<td>Opens the ATMS Map Polyline Control Properties window described in Section 4.3.2.</td>
</tr>
</tbody>
</table>

**Show Associated Object** opens the TransSuite IMS application to display the details of the selected incident or planned event.

**Edit Polyline** allows the user to modify the selected incident or planned event polyline annotation icon. This process is identical to that of editing an informational polyline annotation, which is described in Section 4.4.1.

**Delete Polyline** allows the user to remove the selected incident or planned event polyline annotation icon.

A confirmation dialog will be displayed before the modifications to the polyline are committed to the database. The user selects Yes to save the changes or No to discard the changes.

**Properties** opens the ATMS Map Polyline Control Properties window, shown previously in Exhibit 4.42.

4.4.5 Text Annotation Pop-Up Menu

To open a context-sensitive pop-up menu for an incident or planned event text annotation, the user right-clicks when the mouse cursor is over the desired text. The menu items are shown in Exhibit 4.45.
Exhibit 4.45: Text Pop-Up Menu

<table>
<thead>
<tr>
<th>MENU ITEM</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties</td>
<td>Opens the ATMS Map Text Control Properties window, shown in Exhibit 4.41.</td>
</tr>
<tr>
<td>Move Text Annotation</td>
<td>Allows the user to change the location of the selected text on the map.</td>
</tr>
<tr>
<td>Delete Text Annotation</td>
<td>Allows the user to remove the selected text annotation icon.</td>
</tr>
</tbody>
</table>

The procedures for moving or deleting an incident or planned event text annotation are identical to those for an informational text annotation, as described in Section 4.4.1.

4.5 REGION LAYER

The Region Layer, shown in Exhibit 4.46 contains icons that define discrete areas within the overall roadway network. Scenario plans within the TransSuite Scenario Manager can be associated with one or more regions. This helps users find scenario plans that affect the location of an incident or planned event.

Exhibit 4.46: Regions Layer

The layer has two modes, run mode and edit mode. In run mode, region icons are displayed. In edit mode, region icons can be added, configured, and removed.

4.5.1 Region Layer Properties

The Region Layer page, shown in Exhibit 4.47 specifies which types of regional icons are displayed on the map.
4.5.2 Region Layer Submenu

The Region Layer submenu includes the items found in Exhibit 4.48

Exhibit 4.48 - Region Layer Submenu

<table>
<thead>
<tr>
<th>MENU ITEM</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Region</td>
<td>Allows the user to create a new region and draw its icon on the map layer. This option is available only in edit mode.</td>
</tr>
<tr>
<td>Place Region</td>
<td>Allows the user to draw an icon for a non-geocoded region on the map. This option is available only in edit mode.</td>
</tr>
<tr>
<td>Filters/Legend</td>
<td>Opens the Region Layer Legend window (see Section 4.5.1). This option is available in run and edit modes.</td>
</tr>
<tr>
<td>Edit Mode</td>
<td>Enables and disables the Region Layer edit mode. This option is available in run and edit modes.</td>
</tr>
</tbody>
</table>

**New Region** allows the user to draw a new region icon on the map. When this option is selected, the mouse cursor will become a crosshair. The user left-clicks when the mouse cursor is over the desired beginning point of the icon. Each subsequent left-click adds a new vertex to the icon. Double-clicking or pressing the `<Enter>` key ends the addition of new vertices and completes the drawing of the icon.

Once the icon has been placed on the map, the Region Control Properties window, shown in Exhibit 4.49 will open.

Exhibit 4.49: Region Control Properties Window
### 4.5.3 Region Pop-Up Menu

A context-sensitive pop-up menu is displayed when the mouse is right-clicked while the cursor is over a region icon. The region pop-up menu includes the following options:

**Exhibit 4.50: Region Pop-Up Menu**

<table>
<thead>
<tr>
<th>MENU ITEM</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit Region</td>
<td>Enables vertex editing options for the selected icon. This menu item is available only in edit mode.</td>
</tr>
<tr>
<td>Delete Region</td>
<td>Allows the user to remove the selected region icon. This menu item is available only in edit mode.</td>
</tr>
<tr>
<td>Add Text Annotation</td>
<td>Not supported.</td>
</tr>
<tr>
<td>Add Polyline Annotation</td>
<td>Not supported.</td>
</tr>
<tr>
<td>Add Image Annotation</td>
<td>Not supported.</td>
</tr>
<tr>
<td>Properties</td>
<td>Opens the Region Properties window described in section 4.5.2. This menu item is available in run and edit modes.</td>
</tr>
<tr>
<td>Add Vertices</td>
<td>Allows the user to add vertices to the end of the selected icon. This menu item is available only after the Edit Region menu item has been selected.</td>
</tr>
<tr>
<td>Insert Vertex Here</td>
<td>Allows the user to add a vertex at the selected point of the icon. This menu item is available only after the Edit Region menu item has been selected.</td>
</tr>
<tr>
<td>Delete Vertex</td>
<td>Allows the user to remove the selected vertex from the icon. This menu item is available only after the Edit Region menu item has been selected.</td>
</tr>
<tr>
<td>Stop Editing Polyline</td>
<td>Disables vertex editing options. This menu item is available only after the Edit Region menu item has been selected.</td>
</tr>
</tbody>
</table>

The **Region ID** is the unique identification number for the region. The **Organization** is the owning organization for the region. The **Detail Level** determines the detail level at which the icon is drawn on the map. The **Description** is a freeform field that can be used to explain the scope or purpose of the region.

**Place Region** allows the user to draw an icon on the map for a region that has been defined in the Regions Configuration Utility (see the *IEN Administrators Guide* for more information about the utility). When this option is selected, a list of un-geocoded regions is displayed. The user selects the desired region and then clicks OK. The cursor then changes to a crosshair so that the icon vertices can be marked on the map. Double-clicking or pressing the *Enter* key ends the addition of new vertices and completes the drawing of the icon. The properties window will open to allow the user to modify the region if necessary.
4.6 FREEWAY LINK LAYER

The Freeway Congestion Link Layer contains dynamic controls that display volume, speed, and occupancy data from freeway vehicle detector stations.

**Exhibit 4.51: Freeway Congestion Link Layer**

The layer has two modes: run mode and edit mode. In run mode, link controls continuously update to report the latest data from their associated detector stations. In edit mode, link controls can be added, configured, and removed.

The IEN reports real-time detector station data by default. Real-time data is collected from detector stations once per minute. If real-time data is not available for a detector station, the IEN will instead report processed detector station data. Processed data is generated from algorithms that include historical data and data from neighboring detector stations. Processed data is updated every five minutes and lags 10-15 minutes behind the current time. The type of data being reported is identified in each link's tool tip.

Links are colored to indicate their current speed, volume, or occupancy level based on the selected layer filter and legend options. The following information is reported in a tool tip when the mouse cursor is hovered over a link control:

<table>
<thead>
<tr>
<th>DATA</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Freeway Congestion Link</td>
<td>Identification number and name of the link.</td>
</tr>
<tr>
<td>Main Roadway</td>
<td>Name of the freeway on which the link is located.</td>
</tr>
</tbody>
</table>
Freeway congestion links only react to the mouse cursor when the map view is close in such as zoomed in on a few Cities. Link interaction is turned off in larger views where it is difficult to differentiate and select individual links. As a result, link tool tips are displayed only when the map scale is below 16 miles (this threshold is configurable). The current view scale is reported on the map status bar.

A message is displayed on the map when the view scale is above the configured interaction threshold. The message reminds users to zoom in closer if they want to interact with link controls. The reminder message can be enabled/disabled from the Freeway Layer Legend.

**4.6.1 Freeway Link Layer Properties**

The Freeway Congestion Link Layer Properties window, shown below, appears when you select Filters/Legend from the Freeway Congestion Link Layer Menu. It is also accessible from the Map Properties window.

**Exhibit 4.52: IEN Freeway Link Layer Properties**

Freeway Congestion Link controls are colored to reflect the data of a particular freeway detector station. By default, Freeway Link Layer controls are colored to indicate speed. When a different tab of the legend is selected, they change to the indication that matches the latest data from their associated detector station.

The Freeway Congestion Link Legend contains Spd (Speed), Vol (Volume), and Occ (Occupancy) tabs. Each tab includes a series of the user-definable thresholds for the legend.
indications. Each legend, based on its specified thresholds, classifies the level of congestion using five (5) colors:

- Red = worst
- Pink
- Yellow
- Light Green
- Dark Green = best

The thresholds are configurable by the user. If data is not available for a link, it is colored White (data unknown).

The Properties window also includes a series of display filters that determine which links are displayed on the map. The **Arrowheads** filter specifies whether directional arrowheads are shown on the link controls. Links with congestion levels that match one of the enabled congestion filters are shown on the map. Links that do not match the enabled congestion level filters are shown in a low contrast gray color.

The **Map Message** option toggles on/off the display of the freeway layer's link interaction warning message.

### 4.6.2 Freeway Link Layer Submenu

When the map background is right-clicked, a context menu is displayed that contains options for each enabled map layer. The following options are provided for the Freeway Congestion Link Layer:

<table>
<thead>
<tr>
<th>OPTION</th>
<th>DESCRIPTION</th>
<th>RUN MODE</th>
<th>EDIT MODE</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Freeway Link</td>
<td>Adds a new freeway congestion link control to the map.</td>
<td></td>
<td>x</td>
</tr>
<tr>
<td>Filters/Legend</td>
<td>Opens the Freeway Congestion Link Layer filters.</td>
<td>x x</td>
<td></td>
</tr>
<tr>
<td>Edit Mode</td>
<td>Enables/disables edit mode for the layer.</td>
<td>x x</td>
<td></td>
</tr>
<tr>
<td>Freeway Filter</td>
<td>Opens the Freeway Filter, which allows users to choose which freeway links are displayed on the map.</td>
<td>x x</td>
<td></td>
</tr>
</tbody>
</table>

### 4.6.3 Freeway Link Pop-up Menu

When a freeway link is right-clicked, a context menu is displayed. The context menu contains the following options:

<table>
<thead>
<tr>
<th>OPTION</th>
<th>DESCRIPTION</th>
<th>RUN MODE</th>
<th>EDIT MODE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Legend</td>
<td>Opens the Freeway Congestion Link Layer filters/legend.</td>
<td>x x</td>
<td></td>
</tr>
<tr>
<td>Properties</td>
<td>Opens the Freeway Congestion Link Control Properties window.</td>
<td>x x</td>
<td></td>
</tr>
<tr>
<td>Delete Link</td>
<td>Removes the selected control.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Edit Link</td>
<td>Enables vertex editing options for the selected control.</td>
<td></td>
<td>x</td>
</tr>
<tr>
<td>Add Vertices</td>
<td>Allows the user to add vertices to the end of the selected control. This menu item is available only after the Edit Link menu item has been selected.</td>
<td></td>
<td>x</td>
</tr>
<tr>
<td>OPTION</td>
<td>DESCRIPTION</td>
<td>RUN MODE</td>
<td>EDIT MODE</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>----------</td>
<td>-----------</td>
</tr>
<tr>
<td>Insert Vertex Here</td>
<td>Allows the user to add a vertex at the selected point of the control. This menu item is available only after the Edit Link menu item has been selected.</td>
<td></td>
<td>x</td>
</tr>
<tr>
<td>Delete Vertex</td>
<td>Allows the user to remove the selected vertex from the control. This menu item is available only after the Edit Link menu item has been selected.</td>
<td></td>
<td>x</td>
</tr>
<tr>
<td>Stop Editing Polyline</td>
<td>Disables vertex editing options. This menu item is available only after the Edit Link menu item has been selected.</td>
<td></td>
<td>x</td>
</tr>
</tbody>
</table>

### 4.6.4 Freeway Link Properties

The Freeway Link Control Properties window contains configuration parameters for a Freeway Link Layer control. To open the window, right-click a layer control and select Properties off the context menu.

**Exhibit 4.53: IEN Freeway Link Properties (General)**

![Exhibit 4.53: IEN Freeway Link Properties (General)](image)

**Exhibit 4.54: IEN Freeway Link Properties (Detector Station)**

![Exhibit 4.54: IEN Freeway Link Properties (Detector Station)](image)
Freeway Congestion Link Layer control properties are described below:

<table>
<thead>
<tr>
<th>TAB</th>
<th>PROPERTY</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>Link Id</td>
<td>Identification number of the link. Must be unique across all other freeway links within the system.</td>
</tr>
<tr>
<td></td>
<td>Name</td>
<td>Textual name of the freeway link.</td>
</tr>
<tr>
<td></td>
<td>Description</td>
<td>Free form field to provide additional information about the link.</td>
</tr>
<tr>
<td></td>
<td>Freeway</td>
<td>Freeway on which the link is located. Used by the Freeway Filter.</td>
</tr>
<tr>
<td></td>
<td>Detail Level</td>
<td>Determines the detail level at which the control is shown on the map.</td>
</tr>
<tr>
<td>Detector Station</td>
<td>Associated Detector Station</td>
<td>The freeway detector station whose data is reported by the link. Click the Choose Detector Station button to select the associated detector station for the link.</td>
</tr>
</tbody>
</table>

The **OK** button closes the Properties window, saving any changes that were made. **Apply** also saves any changes, but leaves the Properties window open. **Cancel** discards any unsaved changes and closes the Properties window.

The Choose Detector Station dialog is used to select the freeway detector station whose data will be reported by the freeway link control.

**Exhibit 4.55: Filtering Detector Stations**
The dialog has two filter options that affect the list of detector stations presented in the Matching Detector Station list box:

- No filter: Displays all defined detector stations.
- Filter by Road and Direction: Displays detector stations that match the selected freeway name and direction criteria.

Click the **Apply Filter** button to apply filter changes. Select the desired detector station in the Matching Detector Stations list box and then click **OK** to save the selection. Click **Cancel** to drop all changes and close the dialog.

### 4.6.5 Filtering Freeway Links

Users can choose which freeway link controls are shown on their map. Select the Freeway Filter option from the Freeway link Layer Menu to open the Freeway Filter window.

Freeway links are filtered based on their freeway assignments. Links on the selected freeways are shown on the map. Links on unselected freeways are not shown on the map.

Click on individual freeways to select/unselect them. Click **Select All** to select all freeways. Click **Clear All** to unselect all freeways. Click **OK** to apply filter changes. Click **Cancel** to revert to previous filter settings.

### 4.6.6 Adding New Freeway Link Layer Controls

To add a Freeway Link Layer control to the Map, follow these steps:

1. Enable the Freeway Congestion Link Layer.
2. Right-click the map background and select the **Freeway Congestion Link Layer > Edit Mode** option to place the layer in edit mode.
3. Right-click the map background and select the **Freeway Congestion Link Layer > New Freeway Link** option.
4. The mouse cursor will become a crosshair. Position the mouse cursor over the desired beginning point of the link and then left-click the mouse. Each subsequent left-click adds a new vertex to the link with a line drawn back to the preceding vertex. Double-clicking or pressing the `<ENTER>` key ends the addition of new vertices and completes the drawing of the link.
5. Configure the link by entering appropriate values on the displayed Freeway Congestion Link Control Properties window.

6. Click OK to close the Properties window.

7. Right-click the map background and select the Freeway Congestion Link Layer > Edit Mode option to place the layer in run mode.

Draw the link in the direction of traffic flow along the segment of roadway so that the arrowhead portion of the control points in the appropriate direction. It is better to draw links from close in map views (around 0.5 miles) where roadway curves are more pronounced and easier to follow. This will result in tighter link/roadway overlays in farther out map views. The view scale must be below the configured link interaction threshold (16 miles by default).
APPENDIX A – INDEX

About ATMS Map, 3-8
Acknowledge incident, 4-22
Add Image Annotation, 4-33
Add Polyline Annotation, 4-33
Add Text Annotation, 4-33
Add Vertices, 4-33
Always on top, 3-6
applications, 2-1, 3-2, 3-3, 3-7, 3-9
Arrowheads, 4-14
Arterial Congestion Link filters, 4-14
Arterial Congestion Link Layer, 4-13
Arterial Congestion Link Layer Properties, 4-13
Arterial Congestion Link Occupancy Legend, 4-15
Arterial Congestion Link Speed Legend, 4-15
Arterial Congestion Link V+KO Legend, 4-15
Arterial Congestion Link Volume Legend, 4-15
Arterial Congestion links layer submenu, 4-15
ATMS Navigator, 2-1, 3-7
Auto-scroll, 3-6
Background color, 3-7
Change Ctrl Size, 4-12
Change Mode, 4-10
Change Plan, 4-9
Clear incident, 4-22
Comm Errors, 4-4
Configure Colors, 4-2
Conflict Flash Alarm, 4-4
Congestion links
deleting, 4-17
edit, 4-17
Delete
congestion link, 4-17
Delete Region, 4-33
Delete Vertex, 4-33
Detail level, 3-8, 3-10, 3-11
dialog boxes, 3-2, 3-3, 3-7, 3-8, 3-9
Door Open Alarm, 4-4
Double-buffered display, 3-7
Drag, 3-4, 3-9
Edit
Congestion links, 4-17
Edit Menu, 3-2
Edit Region, 4-33
File Menu, 3-2
Fill style, 4-21
Find address, 3-10
Flash Alarm, 4-4
Flash Off, 4-10
Flash On, 4-10
Hatch style, 4-21
Help menu, 3-7
Hide All Layers, 3-9
Incident
acknowledge, 4-22
clear, 4-22
filters, 4-19
layer submenu, 4-19
new, 4-19
pop-up menu, 4-29, 4-30
Incident Layer, 4-18
incidents, 1-1, 2-1
Informational Layer, 4-25, 4-31
Informational Layer Submenu, 4-26
Insert Vertex Here, 4-33
Intersection Alarms Legend, 4-4
Intersection Cycle Legend, 4-5
Intersection Layer, 4-1
Intersection Layer Properties, 4-2
Intersection Mode Legend, 4-3
Intersection Operations Legend, 4-4
Intersection Status Legend, 4-2
Layers menu, 3-7
Less detail, 3-8, 3-10
Line style, 4-21
Line thickness, 4-21
Location Filter, 4-11
Main Street Green, 4-4
Map pop-up menu, 3-9
Map properties, 3-6, 3-7, 3-10
Map Properties, 3-7
Menu bar, 3-2
Menus
incident layer pop-up, 4-19
incident pop-up, 4-29, 4-30
map pop-up, 3-9
planned event layer pop-up, 4-24
Message window, 3-4
options, 3-6
print, 3-6
More detail, 3-4, 3-8, 3-10
New incident, 4-19
New Region, 4-32
Not Responding, 4-4
Open, 3-8
Overview, 3-8
Pan, 3-4
Place Region, 4-34
Planned Region, 4-34
Planned Event Layer, 4-18
Planned event filters, 4-24
Planned Event Layer, 4-18
Planned event layer submenu, 4-24
Polyline
annotation, 4-27
closed, 4-21
fill style, 4-21
hatch style, 4-21
properties, 4-30
style, 4-21
thickness, 4-21
Pop-up menus, 3-9

Properties
  - incidents, 4-19
  - map, 3-6, 3-7, 3-10
  - planned events, 4-24
  - polyline, 4-30

Region
  - Description, 4-34
  - Detail Level, 4-34
  - Organization, 4-34
  - Region ID, 4-34

Region Layer, 4-31
Region Layer Submenu, 4-32
Region pop-up menu, 4-33

Release IEN Control, 4-10

Save to DB, 4-14
Save view as, 3-8
Scale, 3-11
Select, 3-3, 3-8

Show associated object, 4-30
Show in IMS, 4-23
Show Main Street Direction, 4-3
Status bar, 3-6, 3-10
Stop Editing Polyline, 4-33
Text annotation, 4-21, 4-24

Toolbar
  - layers, 3-6, 3-9
  - main, 3-6, 3-8

TransSuite IMS, 2-1
View Menu, 3-3
X-Y coordinates, 3-6, 3-11
Zoom, 3-3, 3-8, 3-9
Zoom and Center, 3-9
Zoom in, 3-3, 3-4, 3-8
Zoom out, 3-4, 3-8
# TABLE OF CONTENTS

<table>
<thead>
<tr>
<th>SECTION</th>
<th>PAGE #</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. INTRODUCTION</td>
<td>1-1</td>
</tr>
<tr>
<td>1.1 Purpose</td>
<td>1-1</td>
</tr>
<tr>
<td>1.2 ATMS Explorer Privileges</td>
<td>1-1</td>
</tr>
<tr>
<td>1.3 Starting ATMS Explorer</td>
<td>1-1</td>
</tr>
<tr>
<td>1.4 Document Conventions</td>
<td>1-1</td>
</tr>
<tr>
<td>2. OVERVIEW</td>
<td>2-1</td>
</tr>
<tr>
<td>2.1 The ATMS Explorer Diagram</td>
<td>2-1</td>
</tr>
<tr>
<td>2.2 Navigation in ATMS Explorer</td>
<td>2-2</td>
</tr>
<tr>
<td>3. CREATING AN ATMS EXPLORER DIAGRAM</td>
<td>3-1</td>
</tr>
<tr>
<td>3.1 Determining the Area of Interest</td>
<td>3-1</td>
</tr>
<tr>
<td>3.2 Creating the Background</td>
<td>3-2</td>
</tr>
<tr>
<td>3.3 Adding the Dynamic Controls</td>
<td>3-3</td>
</tr>
<tr>
<td>4. ATMS EXPLORER MENUS AND TOOLS</td>
<td>4-1</td>
</tr>
<tr>
<td>4.1 File Menu</td>
<td>4-1</td>
</tr>
<tr>
<td>4.1.1 New</td>
<td>4-1</td>
</tr>
<tr>
<td>4.1.2 Open</td>
<td>4-2</td>
</tr>
<tr>
<td>4.1.3 Save</td>
<td>4-2</td>
</tr>
<tr>
<td>4.1.4 Save As</td>
<td>4-2</td>
</tr>
<tr>
<td>4.1.5 Import Background</td>
<td>4-2</td>
</tr>
<tr>
<td>4.1.6 Properties</td>
<td>4-2</td>
</tr>
<tr>
<td>4.1.7 Print</td>
<td>4-3</td>
</tr>
<tr>
<td>4.1.8 Print Preview</td>
<td>4-3</td>
</tr>
<tr>
<td>4.1.9 Print Setup</td>
<td>4-3</td>
</tr>
<tr>
<td>4.1.10 Send</td>
<td>4-3</td>
</tr>
<tr>
<td>4.1.11 Recent File</td>
<td>4-4</td>
</tr>
<tr>
<td>4.1.12 Exit</td>
<td>4-4</td>
</tr>
<tr>
<td>4.2 Edit Menu</td>
<td>4-4</td>
</tr>
<tr>
<td>4.2.1 Undo</td>
<td>4-4</td>
</tr>
<tr>
<td>4.2.2 Redo</td>
<td>4-4</td>
</tr>
<tr>
<td>4.2.3 Cut</td>
<td>4-5</td>
</tr>
<tr>
<td>4.2.4 Copy</td>
<td>4-5</td>
</tr>
<tr>
<td>4.2.5 Paste</td>
<td>4-5</td>
</tr>
<tr>
<td>4.2.6 Paste Special</td>
<td>4-5</td>
</tr>
<tr>
<td>4.2.7 Delete</td>
<td>4-5</td>
</tr>
<tr>
<td>4.2.8 Select All</td>
<td>4-5</td>
</tr>
<tr>
<td>4.2.9 Properties</td>
<td>4-5</td>
</tr>
<tr>
<td>4.2.10 Insert OLE Control</td>
<td>4-5</td>
</tr>
<tr>
<td>4.2.11 Insert Object</td>
<td>4-7</td>
</tr>
<tr>
<td>4.2.12 Links</td>
<td>4-7</td>
</tr>
<tr>
<td>4.2.13 Object</td>
<td>4-7</td>
</tr>
<tr>
<td>4.2.14 Design Mode</td>
<td>4-8</td>
</tr>
<tr>
<td>4.3 View Menu</td>
<td>4-8</td>
</tr>
<tr>
<td>4.3.1 Match Window Size to Document Size</td>
<td>4-9</td>
</tr>
</tbody>
</table>
4.3.2 Stretch Document to Fit Window ................................................................. 4-9
4.3.3 Show Object Outlines .................................................................................. 4-9
4.3.4 Show Grid ..................................................................................................... 4-9
4.3.5 Message Window ......................................................................................... 4-9
4.3.6 Main Toolbar ............................................................................................... 4-10
4.3.7 Design Toolbar ........................................................................................... 4-10
4.3.8 Insert Control Toolbar ............................................................................... 4-10
4.3.9 Status Bar .................................................................................................. 4-10
4.3.10 Refresh ...................................................................................................... 4-10
4.3.11 Options .................................................................................................... 4-10
  4.3.11.1 General Tab ......................................................................................... 4-11
  4.3.11.2 Grid Tab .............................................................................................. 4-11
  4.3.11.3 Run Tab ............................................................................................... 4-12
4.4 Layout Menu ................................................................................................ 4-13
  4.4.1 Align Commands .................................................................................... 4-14
  4.4.2 Space Commands .................................................................................... 4-14
  4.4.3 Same Commands .................................................................................... 4-14
  4.4.4 Bring and Send Commands .................................................................... 4-14
  4.4.5 Expand to Fill Document ......................................................................... 4-14
  4.4.6 Snap to Grid ........................................................................................... 4-14
4.5 Script Menu .................................................................................................. 4-14
  4.5.1 Execute Script .......................................................................................... 4-15
  4.5.2 Run Procedure ......................................................................................... 4-15
4.6 Help Menu .................................................................................................... 4-16
  4.6.1 Help Topics ............................................................................................. 4-16
  4.6.2 About ATMS Explorer ........................................................................... 4-16
4.7 ATMS Explorer Toolbars ............................................................................ 4-16
  4.7.1 Main Toolbar .......................................................................................... 4-17
  4.7.2 Design Toolbar ....................................................................................... 4-18
  4.7.3 Insert Control Toolbar ............................................................................ 4-18
4.8 ATMS Explorer Status Bar .......................................................................... 4-19

5. ATMS EXPLORER DIAGRAM AREA ................................................................. 5-1
5.1 Background Color ......................................................................................... 5-1
5.2 Grid ............................................................................................................... 5-1
5.3 Objects ......................................................................................................... 5-2
5.4 Shortcut Menus ............................................................................................ 5-2
5.5 Monitoring Windows ..................................................................................... 5-3
  5.5.1 Intersection Detail Window ..................................................................... 5-3
    5.5.1.1 Menu Bar .......................................................................................... 5-4
    5.5.1.2 File Menu .......................................................................................... 5-4
    5.5.1.3 Edit Menu .......................................................................................... 5-4
    5.5.1.4 Command Menu .............................................................................. 5-5
    5.5.1.5 Show Menu ....................................................................................... 5-6
    5.5.1.6 Status Bar .......................................................................................... 5-6
  5.5.2 Detector Detail Window ............................................................................. 5-6
  5.5.3 Section Detail Window .............................................................................. 5-7
    5.5.3.1 File Menu .......................................................................................... 5-8
6. ATMS CONTROLS

6.1 IEN Intersection Controls
6.2 Intersection Legend Controls
6.2.1 Intersection Legend Status Tab
6.2.2 Intersection Legend Mode Tab
6.2.3 Intersection Legend Operations Tab
6.2.4 Intersection Legend Alarms Tab
6.2.5 Intersection Cycle Legend
6.3 Intersection Status Text Controls
6.4 Intersection Header Controls
6.5 Intersection With Green Indications Control
6.6 Green Indication Controls
6.7 Pedestrian Indication Controls
6.8 Vehicle Call Controls
6.9 Detector Controls
6.9.1 Detector Legend Controls
6.9.2 Detector Legend Status Tab
6.9.3 Detector Legend Volume, Speed, Occupancy, and V+\( k \)O Tabs
6.9.4 Detector Status Text Controls
6.10 Section Controls
6.11 Section Legend Controls
6.12 Section Status Text Controls
6.13 ATMS Hyperlink Controls

7. FOR THE ADVANCED EXPLORER USER

7.1 Different Ways to Start Explorer
7.2 Command Line Options for Explorer
7.2.1 No Options
7.2.2 Filename
7.2.3 Design
7.2.4 Print Filename
7.2.5 Fit to Window
7.2.6 NoFit to Window
7.2.7 Fit to Document
7.2.8 NoFit to Document
7.2.9 Size
7.3 Command Line Options for Monitoring Windows
7.3.1 Universal Identifier
7.3.2 Area Computer and Logical Number
7.4 Generation of Baseline Intersection Diagrams
7.4.1 GenerateIENXpl.vbs Usage
7.4.2 Input File Format
## LIST OF TABLES

<table>
<thead>
<tr>
<th>Table Number</th>
<th>Description</th>
<th>Page #</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.1</td>
<td>ATMS Explorer User Privileges</td>
<td>1-1</td>
</tr>
<tr>
<td>4.1</td>
<td>File Menu Commands</td>
<td>4-1</td>
</tr>
<tr>
<td>4.2</td>
<td>Edit Menu Commands</td>
<td>4-4</td>
</tr>
<tr>
<td>4.3</td>
<td>View Menu Commands</td>
<td>4-8</td>
</tr>
<tr>
<td>4.4</td>
<td>Layout Menu Commands</td>
<td>4-13</td>
</tr>
<tr>
<td>4.5</td>
<td>ATMS Explorer Script Menu Commands</td>
<td>4-15</td>
</tr>
<tr>
<td>4.6</td>
<td>Help Menu Commands</td>
<td>4-16</td>
</tr>
<tr>
<td>5.1</td>
<td>Design Mode Shortcut Menu Commands</td>
<td>5-2</td>
</tr>
<tr>
<td>5.2</td>
<td>Design Mode Control Shortcut Menu Commands</td>
<td>5-3</td>
</tr>
<tr>
<td>6.1</td>
<td>Green Indication States</td>
<td>6-9</td>
</tr>
<tr>
<td>6.2</td>
<td>Pedestrian Indication States</td>
<td>6-11</td>
</tr>
<tr>
<td>6.3</td>
<td>Vehicle Call Control States</td>
<td>6-12</td>
</tr>
<tr>
<td>6.4</td>
<td>Detector Legend Indications</td>
<td>6-14</td>
</tr>
<tr>
<td>7.1</td>
<td>GenerateIENXpl.vbs Arguments</td>
<td>7-3</td>
</tr>
<tr>
<td>7.2</td>
<td>Diagrams Definition Parameters</td>
<td>7-4</td>
</tr>
</tbody>
</table>
### LIST OF EXHIBITS

<table>
<thead>
<tr>
<th>Exhibit</th>
<th>Description</th>
<th>Page #</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exhibit 2.1</td>
<td>ATMS Explorer Diagram</td>
<td>2-1</td>
</tr>
<tr>
<td>Exhibit 4.1</td>
<td>Document Properties Window</td>
<td>4-3</td>
</tr>
<tr>
<td>Exhibit 4.2</td>
<td>Object Properties Window</td>
<td>4-5</td>
</tr>
<tr>
<td>Exhibit 4.3</td>
<td>Insert Control Window</td>
<td>4-6</td>
</tr>
<tr>
<td>Exhibit 4.4</td>
<td>Insert Object Window</td>
<td>4-7</td>
</tr>
<tr>
<td>Exhibit 4.5</td>
<td>ATMS Explorer Message Window</td>
<td>4-9</td>
</tr>
<tr>
<td>Exhibit 4.6</td>
<td>Message Window Options</td>
<td>4-10</td>
</tr>
<tr>
<td>Exhibit 4.7</td>
<td>Options Window - General Tab</td>
<td>4-11</td>
</tr>
<tr>
<td>Exhibit 4.8</td>
<td>Options Window – Grid Tab</td>
<td>4-12</td>
</tr>
<tr>
<td>Exhibit 4.9</td>
<td>Options Window – Run Tab</td>
<td>4-12</td>
</tr>
<tr>
<td>Exhibit 4.10</td>
<td>Execute Script Window</td>
<td>4-15</td>
</tr>
<tr>
<td>Exhibit 4.11</td>
<td>Run Procedure Window</td>
<td>4-16</td>
</tr>
<tr>
<td>Exhibit 4.12</td>
<td>Main Toolbar</td>
<td>4-17</td>
</tr>
<tr>
<td>Exhibit 4.13</td>
<td>Design Toolbar</td>
<td>4-18</td>
</tr>
<tr>
<td>Exhibit 4.14</td>
<td>Insert Control Toolbar</td>
<td>4-19</td>
</tr>
<tr>
<td>Exhibit 4.15</td>
<td>Status Bar</td>
<td>4-19</td>
</tr>
<tr>
<td>Exhibit 5.1</td>
<td>ATMS Explorer Diagram Area</td>
<td>5-1</td>
</tr>
<tr>
<td>Exhibit 5.2</td>
<td>Intersection Detail Window</td>
<td>5-4</td>
</tr>
<tr>
<td>Exhibit 5.3</td>
<td>Intersection Detail Entity Window</td>
<td>5-5</td>
</tr>
<tr>
<td>Exhibit 5.4</td>
<td>Change Plan Window</td>
<td>5-5</td>
</tr>
<tr>
<td>Exhibit 5.5</td>
<td>Change Mode Window</td>
<td>5-6</td>
</tr>
<tr>
<td>Exhibit 5.6</td>
<td>Status Bar</td>
<td>5-6</td>
</tr>
<tr>
<td>Exhibit 5.7</td>
<td>Detector Detail Window</td>
<td>5-7</td>
</tr>
<tr>
<td>Exhibit 5.8</td>
<td>Section Detail Window</td>
<td>5-8</td>
</tr>
<tr>
<td>Exhibit 6.1</td>
<td>Intersection Controls</td>
<td>6-1</td>
</tr>
<tr>
<td>Exhibit 6.2</td>
<td>Intersection Control Properties Window</td>
<td>6-2</td>
</tr>
<tr>
<td>Exhibit 6.3</td>
<td>Intersection Status Legend</td>
<td>6-2</td>
</tr>
<tr>
<td>Exhibit 6.4</td>
<td>Intersection Color Config</td>
<td>6-3</td>
</tr>
<tr>
<td>Exhibit 6.5</td>
<td>Intersection Mode Legend</td>
<td>6-3</td>
</tr>
<tr>
<td>Exhibit 6.6</td>
<td>Intersection Operations Legend</td>
<td>6-4</td>
</tr>
<tr>
<td>Exhibit 6.7</td>
<td>Intersection Alarms Legend</td>
<td>6-5</td>
</tr>
<tr>
<td>Exhibit 6.8</td>
<td>Intersection Cycle Length Legend</td>
<td>6-5</td>
</tr>
<tr>
<td>Exhibit 6.9</td>
<td>Intersection Status Text Control Object Properties Window</td>
<td>6-6</td>
</tr>
<tr>
<td>Exhibit 6.10</td>
<td>Intersection Header Control</td>
<td>6-7</td>
</tr>
<tr>
<td>Exhibit 6.11</td>
<td>Intersection Header Control Properties Window</td>
<td>6-7</td>
</tr>
<tr>
<td>Exhibit 6.12</td>
<td>Intersection with Green Indications Control</td>
<td>6-7</td>
</tr>
<tr>
<td>Exhibit 6.13</td>
<td>Intersection with Green Indications Control Object Properties Window</td>
<td>6-8</td>
</tr>
<tr>
<td>Exhibit 6.14</td>
<td>Green Indication Control Shapes</td>
<td>6-9</td>
</tr>
<tr>
<td>Exhibit 6.15</td>
<td>Green Indication Control Properties Window</td>
<td>6-10</td>
</tr>
<tr>
<td>Exhibit 6.16</td>
<td>Pedestrian Indication Controls</td>
<td>6-11</td>
</tr>
<tr>
<td>Exhibit 6.17</td>
<td>Pedestrian Indication Control Properties Window</td>
<td>6-12</td>
</tr>
<tr>
<td>Exhibit 6.18</td>
<td>Vehicle Call Control</td>
<td>6-12</td>
</tr>
<tr>
<td>Exhibit 6.19</td>
<td>Vehicle Call Control Properties Window</td>
<td>6-13</td>
</tr>
<tr>
<td>Exhibit 6.20</td>
<td>Detector Controls</td>
<td>6-13</td>
</tr>
<tr>
<td>Exhibit 6.21</td>
<td>Detector Control Properties Window</td>
<td>6-13</td>
</tr>
<tr>
<td>Exhibit 6.22</td>
<td>Detector Status Legend</td>
<td>6-15</td>
</tr>
</tbody>
</table>
Exhibit 6.23: Detector Volume Legend................................................................. 6-15
Exhibit 6.24: Detector Text Control Properties Window ............................... 6-16
Exhibit 6.25: IEN Section Controls ............................................................... 6-16
Exhibit 6.26: IEN Section Legend ................................................................. 6-17
Exhibit 6.27: Hyperlink Control Object Properties Window .......................... 6-18
<table>
<thead>
<tr>
<th>VERSION</th>
<th>DATE</th>
<th>DESCRIPTION</th>
<th>REVIEWED BY</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>12/13/02</td>
<td>Initial Draft</td>
<td>Michael Bayer</td>
</tr>
<tr>
<td>2.0</td>
<td>3/30/06</td>
<td>COTS Migration Updates</td>
<td>Jack Schneider</td>
</tr>
<tr>
<td>Final</td>
<td>3/31/07</td>
<td>Updated for IEN Software Version 1.09</td>
<td>Kevin Leamon</td>
</tr>
<tr>
<td>FINAL, Revision 1</td>
<td>9/20/11</td>
<td>Updated for IEN Multiple Corridor Server Project (IEN Software Version 2.02)</td>
<td>Chuck Dankocsik</td>
</tr>
<tr>
<td>Version 2.4.1</td>
<td>4/20/12</td>
<td>Updated for Freeway interface &amp; Outbound interface projects (IEN Software Version 2.4.1)</td>
<td>Chuck Dankocsik</td>
</tr>
</tbody>
</table>
1. INTRODUCTION

1.1 PURPOSE

This document describes the features and use of the TransSuite ATMS Explorer program and Los Angeles County Information Exchange Network (IEN) controls.

1.2 ATMS EXPLORER PRIVILEGES

Each ATMS Explorer user is assigned a specific set of privileges that determine the functions that are available to that user. Table 1.1 details the key features of the application that are available to each ATMS user group.

Table 1.1: ATMS Explorer User Privileges

<table>
<thead>
<tr>
<th>PRIVILEGE</th>
<th>ATMS GROUP</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Supervisor</td>
</tr>
<tr>
<td>View ATMS Explorer Diagrams</td>
<td>x</td>
</tr>
<tr>
<td>Build ATMS Explorer Diagrams</td>
<td>x</td>
</tr>
</tbody>
</table>

The authority to send commands to intersection controllers and sections requires device-level resource privileges that are configured within the IEN System Configuration Manager program. Information on IEN privileges is provided in the IEN System Administrator's Guide and the online help screens within the IEN System Configuration Manager.

1.3 STARTING ATMS EXPLORER

ATMS Explorer can be started by double-clicking the ATMS Explorer icon on the desktop or by clicking ATMS Explorer shortcut on the Windows Start menu (START > ALL PROGRAMS > LOS ANGELES COUNTY IEN > ATMS EXPLORER).

1.4 DOCUMENT CONVENTIONS

There are locations in this document where formatted text is used, as illustrated below.

| C:> edit readme.txt | A monospace font is used to show displayed prompts and typed commands. The bold text is text that should be typed. |
| <TAB>              | Text enclosed in brackets indicates keystrokes. |
| <SHIFT>+<F1>       | A plus sign indicates that two keys are to be pressed simultaneously; the first key is held down while the second key is pressed. |
| File               | Bold formatting represents a button or menu option such as the OK button. |
2. OVERVIEW

ATMS Explorer allows users to create and display custom views of traffic management equipment. Some examples would be a diagram that shows the layout, status, and operation of an intersection or a diagram that shows how several intersections along an arterial are interacting.

An ATMS Explorer diagram consists of a set of embedded objects drawn on top of a static background. These objects can be custom controls that represent ATMS devices or other types of embeddable OLE and ActiveX objects, such as CorelDraw drawings or Excel spreadsheets.

ATMS controls display data collected from the components that make up the system, such as intersection controllers and system detectors. Some ATMS controls enable the user to send commands to devices. Because these controls are not dependent on ATMS Explorer or any other program, they can be used in other programs that support OLE and ActiveX controls.

2.1 THE ATMS EXPLORER DIAGRAM

An ATMS Explorer diagram, such as the one shown in Exhibit 2.1 is a user-constructed display that contains a static background and a set of dynamic controls that represent aspects of the system.

Exhibit 2.1: ATMS Explorer Diagram
In Exhibit 2.1, the background depicts the lane configuration of the intersection. Users can embed dynamic OLE and ActiveX controls in ATMS Explorer diagrams that are displayed over the static background. There are many different types of controls and the functionality that they provide varies. Controls are often included with commercial software applications such as Microsoft Office. The set of software installed on a system determines the types of controls that are available within ATMS Explorer.

A set of custom ATMS controls is included with the IEN software. These controls report data for particular entities within the system and allow users to interact with those entities.

The ATMS controls include the following:

- **Intersection Controls** display the performance status, operating characteristics, timing information, plan selection information, and communication status of their associated intersection controllers.
- **Intersection Status Text Controls** display a particular aspect, in a textual format, of the information collected from their associated intersection controllers.
- **Intersection Header Controls** display detailed information collected for their associated intersection controllers.
- **Intersection Legend Controls** provide an indication legend for the Intersection Controls.
- **Intersection with Green Indications Controls** display the same information as the Intersection controls; in addition, they indicate the traffic signal display being shown at each leg of the intersection.
- **Green Indication Controls** indicate the traffic signal display being shown to a particular lane of traffic. **Pedestrian Controls** indicate the pedestrian signal display being shown on a particular side of an intersection.
- **Vehicle Call Controls** indicate the vehicle presence-state of their associated sensors.
- **Detector Controls** display status, volume, speed, occupancy, or V+kJO data from their associated VOS detectors.
- **Detector Legend Controls** provide an indication legend for the Detector Controls.
- **Detector Status Text Controls** display a particular aspect, in a textual format, of the information collected from their associated VOS detectors.
- **Section Controls** display timing information for a group of intersection controllers.
- **Section Status Text Controls** display a particular aspect, in a textual format, of the information collected from their associated sections.
- **Section Legend Controls** provide an indication legend for Section Controls.
- **ATMS Hyperlink Controls** allow the user to navigate from diagram to diagram via embedded shortcuts.

### 2.2 NAVIGATION IN ATMS EXPLORER

The navigation techniques in ATMS Explorer are similar to those used in most Windows-based applications. Scroll bars on the right side and bottom of the window shift the document if its size exceeds that of the window.
As the user becomes more involved in the creation and operation of diagrams, the ability to manipulate selected controls in ATMS Explorer is useful. Some of these manipulations are:

- Selecting a control by clicking on it.
- Adding more controls to the selection by holding down `<CTRL>` and clicking the mouse button.
- Canceling the selection by holding down `<CTRL>` and clicking the mouse button.
- Extending the group selection by holding down `<SHIFT>` and clicking the mouse button, which will select all the controls between the anchor and the clicked control.

The first control the user selects in a document is the anchor. Explorer draws its handles (the bounding box displayed around a selected control) differently from the rest of the selected controls. ATMS Explorer will move, resize, or align all other select controls in relation to the anchor. Users can change the anchor simply by clicking a different selected control.

Users can view important information by holding the mouse pointer over a control to display a ToolTip. The properties of each control depend on the type of control. ATMS Explorer has two modes: Run mode and Design mode. In Run mode, the controls embedded in the current diagram will be active, displaying dynamic data from their associated IEN entities. In Design mode, the controls show static images, and users can configure them and the diagram as a whole. Many of the ATMS Explorer menu and toolbar commands are available only in one of the modes.
3. CREATING AN ATMS EXPLORER DIAGRAM

ATMS Explorer enables the user to create detailed traffic management diagrams. This section describes some of the prerequisite design considerations in the creation of an ATMS Explorer diagram. This document assumes that users who create diagrams have some knowledge of Windows and the graphical programs used to create diagram backgrounds. The product documentation provided by the manufacturers of graphics editing programs should provide additional instruction in basic operating techniques.

There are several steps in creating an ATMS Explorer diagram:

1. Determining the area of interest
2. Creating and inserting the static components
3. Inserting and configuring the dynamic components

The following sections describe these steps in more detail.

3.1 DETERMINING THE AREA OF INTEREST

One of the prerequisites for diagram creation is the determination of the geographic region of interest, whether it is an intersection or a section (a group of intersections). The user describes the region, keeping in mind the resolution and aspect ratio of the available screens. The aspect ratio of most screens presents a display area that is wider than it is taller. Users should select these regions of interest, then, with this fact in mind. An aspect ratio of 4:3 is typical.

Users should consider the following items if the area of interest is a section:

- Roads
- Landmarks
- Boundaries
- Geographical features
- Annotations

Users should identify all instrumented roadways to be included in the diagram. In addition, they should designate secondary roadways, significant landmarks, and natural or artificial boundaries that might aid in geographical identification. Other annotations of interest might be roadway names, county boundaries, and waterway names.

Users should consider the following items if the area of interest is an intersection:

- An accurate depiction of medians
- Lanes of travel, including right or left turn lanes
- Pedestrian crossings
3.2 CREATING THE BACKGROUND

Users can create the static background portion of the diagram by using commercial graphics software. These programs typically offer many tools and capabilities that can make entry and maintenance of the data much easier. Because of the amount of data that may eventually be included in some of the diagrams and because of the fine-tuning that is inevitable near the end of this process, it is highly recommended that the diagram creator become familiar with these capabilities.

An understanding of the concept of layers, a common feature of most drawing packages, is very helpful in creating backgrounds. Layers can be created, named, edited, and manipulated separately from other layers. The use of layering is especially helpful during the fine-tuning stage of the background creation process, where colors and sizes are reviewed and changed.

Some basic layers that should be considered include the following:

- Background - for the background matte, grid, logos, emblems, or other aids
- Water - for waterways, bays, rivers, lakes
- Boundaries - for county, city, or other boundaries
- Text - for all types of textual annotations
- Secondary roadways - for un-instrumented and secondary roadways
- Primary roadways - for instrumented roadways

There are a number of ways to generate roadway information, including the following:

- Scan using an optical scanner. The image is then scaled to the appropriate size and placed in the document in a temporary layer, where relevant geographical information can be traced into the document. This method is convenient for a large-scale map, such as an area or section.
- Using a tablet: a drawing tablet input device is available commercially. A map with an appropriate scale factor is affixed to the tablet. A digitizing pen or an equivalent entry device is used to enter the data. This method is also convenient for an area or section map.
- Freehand sketch: this method is the least accurate and involves freehand sketching of the image; however, it may be the fastest method and provides the greatest opportunity for an "artist’s rendering" for a more attractive map. This method is appropriate for an intersection drawing.
- Using a template: template diagrams can be created to depict typical intersection configurations, such as 3-way and 4-way intersections of both one-way and two-way streets. New diagrams may then be based on one of the standard templates.
- Once the roadways have been entered, additional features may be added by using the drawing software.

After the diagram background is completed, it can be inserted into an ATMS Explorer document. This is accomplished by starting ATMS Explorer and clicking New File on the toolbar. A new diagram opens in Design mode. The user then right-clicks the diagram and clicks Import Background. A standard Windows browse window opens, enabling the user to specify the location of the background file.
### 3.3 ADDING THE DYNAMIC CONTROLS

After the background and any other static components have been placed in the diagram, the dynamic components can be added, such as controllers, detectors, pedestrian indications, green arrows. The controls that should be included in the document depend on the level of detail that is appropriate for the diagram. For example, a section diagram might include controllers and green arrows, while an intersection might include controllers, detectors, vehicle calls, green arrows, and pedestrian indications.

To add a dynamic component (for example, a pedestrian indication) to the diagram, the user clicks **Insert OLE Control** on the **Edit** menu and then selects **IEN Pedestrian Indication Control** from the list. All of the OLE controls found by the system are in the list. The controls that begin with “ATMS” or “IEN” were created for ATMS Explorer; the others may not necessarily work in Explorer diagrams. When all the dynamic components are in place, the user is ready to move on to the next step.

Components can be moved from one open diagram to another by starting at least two instances of Explorer. The components can be copied or moved from one open diagram to another by using a drag-and-drop operation or by using copy and paste operations.
4. ATMS EXPLORER MENUS AND TOOLS

The ATMS Explorer menu bar contains the following six menus with various commands for manipulating the diagrams and their embedded controls:

- **File menu**
- **Edit menu**
- **View menu**
- **Layout menu**
- **Script menu**
- **Help menu**

Many of the menu commands are also found on the toolbars or are accessible using keyboard shortcuts. The status bar displays a helpful description as the mouse pointer is moved over the menu commands.

### 4.1 FILE MENU

The **File** menu contains commands that provide overall document control, as shown in Table 4.1.

#### Table 4.1: File Menu Commands

<table>
<thead>
<tr>
<th>MENU COMMAND</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Opens a new diagram in Design mode.</td>
</tr>
<tr>
<td>Open</td>
<td>Opens the standard Windows file <strong>Open</strong> window, which enables the user to open an existing diagram.</td>
</tr>
<tr>
<td>Save</td>
<td>Opens the standard Windows file <strong>Save</strong> window, which enables the user to save the current diagram to a file.</td>
</tr>
<tr>
<td>Save As</td>
<td>Opens the standard Windows file <strong>Save As</strong> window, which enables the user to rename and then save the current diagram to a file.</td>
</tr>
<tr>
<td>Import Background</td>
<td>Opens a browse window, which enables the user to select a background to import into the current diagram.</td>
</tr>
<tr>
<td>Properties</td>
<td>Opens the <strong>Document Properties</strong> window shown in Exhibit 4.1.</td>
</tr>
<tr>
<td>Print</td>
<td>Opens the standard Window <strong>Print</strong> window (the contents of print windows is dependent on the type of printer(s) installed).</td>
</tr>
<tr>
<td>Print Preview</td>
<td>Opens a print preview window.</td>
</tr>
<tr>
<td>Print Setup</td>
<td>Opens the standard Windows <strong>Print Setup</strong> window.</td>
</tr>
<tr>
<td>Send</td>
<td>Enables the transmission of the current diagram to another user via email.</td>
</tr>
<tr>
<td>Recent File</td>
<td>Lists the most recent diagrams that have been opened in Explorer. Any of the listed diagrams can be opened by clicking the name or by typing its number.</td>
</tr>
<tr>
<td>Exit</td>
<td>Exits the program.</td>
</tr>
</tbody>
</table>

#### 4.1.1 New

**New** clears the document area. If the current document has not been saved, a confirmation box asks if the changes to the current document should be saved. Clicking **Yes** saves the current document before starting a new one; clicking **No** starts a new document without saving the
current one. Clicking **Cancel** returns to the current document and does not start a new document.

### 4.1.2 Open

**Open** brings up a file selection box in which an existing diagram can be selected to open.

### 4.1.3 Save

**Save** saves the current diagram and any modifications made to it. If the diagram has not been saved previously, a name for the diagram must be typed.

### 4.1.4 Save As

**Save As** opens a file selection box in which the diagram can be renamed prior to being saved.

### 4.1.5 Import Background

**Import Background** opens a file selection box in which a background for the document can be selected. The background will be placed behind any controls that are embedded in the diagram.

### 4.1.6 Properties

- **Properties** opens the **Document Properties** window, in which several document-specific properties can be selected. Right-clicking the document background and then clicking **Properties** on the shortcut menu that appears can also open this window. The Document Properties window is shown in Exhibit 4.1. On the **General** tab, the dimensions of the document, in pixels, can be set by selecting one of the standard sizes or setting custom dimensions (width by height).

- The **Style** tab contains the following areas: **Background Color**, **Foreground Color**, and **Font**. The initial settings can be used or custom colors and fonts can be selected. Clicking **Custom Color** selects the custom color shown to the right. Clicking **Choose Color** enables the selection of a different custom color from a palette of 48 basic colors. Defining additional custom colors is not implemented. Clicking **Custom Font** selects the custom font shown to the right. Clicking **Choose Font** enables the selection of a different custom font.

- On the **Picture** tab, a background picture can be specified and whether it should be embedded in the document or stored as a file name only. If the picture is embedded in the document, it will load faster. Storing the file name is advantageous if multiple documents use the same background, because not embedding multiple copies of the pictures saves space. Another advantage of storing the file name is that when changes are made to the background picture, the changes take effect in each document that uses that background, eliminating the need to re-import the background.

Clicking **OK** in the **Document Properties** window to applies the settings and closes the window; clicking **Cancel** closes the window without saving any changes. **Help** is not implemented at this time.
4.1.7 Print

Print opens the Print window in which the printer (or file), print range, and number of copies can be chosen. Clicking Properties opens the Print Properties window in which the paper size and orientation can be chosen. Clicking OK prints the document; clicking Cancel closes the window without printing.

4.1.8 Print Preview

Print Preview opens the Print Preview window that presents the document as it will look when printed. Clicking Print opens the Print window discussed earlier. Clicking Zoom In and Zoom Out, or clicking on the document image, zooms. Clicking Close closes the window.

4.1.9 Print Setup

Print Setup opens the Print Setup window in which the printer, paper size, paper source, and paper orientation can be chosen. Clicking Properties opens the Document Properties window discussed earlier. Clicking Network enables connecting to other printers on the network. Clicking OK saves any changes before closing the window; clicking Cancel closes the window without saving any changes.

4.1.10 Send

Send opens a "compose mail" window in the user’s primary e-mail program. A copy of the current Explorer document is inserted automatically into the body of the message.
4.1.11 Recent File

The Recent File list includes the 16 most recent documents that have been opened in ATMS Explorer. A document form the list can be opened by clicking on its name or by typing its number.

4.1.12 Exit

Exit exits ATMS Explorer. If the current document has not been saved, a confirmation message is displayed. Clicking Yes saves the document before exiting; clicking No exits without saving the current document. Clicking Cancel returns to the current document.

4.2 EDIT MENU

The Edit menu, shown in Table 4.2, contains common document editing commands and commands related to the embedded objects.

<table>
<thead>
<tr>
<th>MENU COMMAND</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo</td>
<td>Rolls back the most recent edit action</td>
</tr>
<tr>
<td>Redo</td>
<td>Reapplies the most recently rolled back edit action</td>
</tr>
<tr>
<td>Cut</td>
<td>Moves the selected object to the clipboard</td>
</tr>
<tr>
<td>Copy</td>
<td>Sends a copy of the selected object to the clipboard</td>
</tr>
<tr>
<td>Paste</td>
<td>Copies the contents of the clipboard to the current diagram</td>
</tr>
<tr>
<td>Paste Special</td>
<td>Enables the formatting of the contents of the clipboard and then copies it to the current diagram</td>
</tr>
<tr>
<td>Delete</td>
<td>Removes the selected object</td>
</tr>
<tr>
<td>Select All</td>
<td>Selects all embedded objects in the current diagram</td>
</tr>
<tr>
<td>Properties</td>
<td>Opens the Object Properties window shown in Exhibit 4.2</td>
</tr>
<tr>
<td>Insert OLE Control</td>
<td>Adds an OLE control to the current diagram</td>
</tr>
<tr>
<td>Insert Object</td>
<td>Adds an Object to the current diagram</td>
</tr>
<tr>
<td>Links</td>
<td>Opens a Link Property window for the selected object</td>
</tr>
<tr>
<td>Object</td>
<td>An Object-specific submenu that contains commands related to the selected object</td>
</tr>
<tr>
<td>Design Mode</td>
<td>Switches between Run mode and Design mode</td>
</tr>
</tbody>
</table>

4.2.1 Undo

Undo undoes the most recent editing action. Repeatedly choosing Undo continues to step backward through the editing actions, undoing one action at a time, up to the action taken immediately after a file save.

4.2.2 Redo

Redo does the exact opposite of Undo, reaplying the most recent editing actions one at a time.
4.2.3 Cut
Cut moves the selected item(s) to the clipboard.

4.2.4 Copy
Copy copies the selected item(s) to the clipboard.

4.2.5 Paste
Paste copies the contents of the clipboard to the active document.

4.2.6 Paste Special
Paste Special provides choices for the format for the contents of the clipboard, such as pasting a linked object. A linked object updates in ATMS Explorer when the user updates the original object.

4.2.7 Delete
Delete deletes the selected item(s).

4.2.8 Select All
Select All selects all of the selectable items in the document.

4.2.9 Properties
Properties opens the object properties window, shown in Exhibit 4.2, where object-specific properties can be set for the selected object(s).

Exhibit 4.2: Object Properties Window

This window can also be opened by right clicking an object and then clicking Properties on the shortcut menu that appears.

4.2.10 Insert OLE Control
Insert OLE Control opens the Insert Control window, shown in Exhibit 4.3. A control to be inserted in the current diagram can be selected from the list of controls.
Note that inserting ATMS controls with the Insert Control toolbar buttons, as described in Section 4.7.3, is much simpler than using the Insert Control window. This dialog is recommended primarily for inserting controls defined by other applications.

**Exhibit 4.3: Insert Control Window**

![Insert Control Window]

An **OLE control** is an object that displays dynamic data or enables the control of something. ATMS controls include:

- Intersection controls
- Intersection Status Text controls
- Intersection Header controls
- Intersection Legend controls
- Intersection with Green Indications controls
- Green Indication controls
- Pedestrian Indication controls
- Vehicle Call controls
- Detector controls
- Detector Status Text controls
- Section controls
- ATMS Hyperlink controls

Controls in the **Insert Control** window other than ATMS controls may not be applicable to the IEN Explorer.

The control to be inserted in the current document is selected from the list. Clicking **OK** inserts the control; clicking **Cancel** closes the window without inserting a control. The control is inserted at the top left corner of the document with its "handles" visible, allowing the control to be moved or resized. The control can be moved one pixel at a time by using the arrow keys. Each of the ATMS controls has a unique set of properties that need to be configured as the document is created. The ATMS controls and their properties are discussed in detail in Section 6.
4.2.11 Insert Object

Insert Object opens the Insert Object window, shown in Exhibit 4.4. A new object can be created or an existing object can be inserted.

Exhibit 4.4: Insert Object Window

An object does not change when Explorer is in Run mode.

To create a new object, the user selects Create New and then selects the object type from the Object Type list. Clicking OK creates the object. The object is inserted at the top left corner of the document.

To insert an existing object, the user:

- Selects Create from File.
- Selects or types the file name or clicks Browse to find the file.
- Clicks Link to link the object in the document to the original file.
- Clicks OK to insert the object or clicks Cancel to close the window without inserting an existing object.

4.2.12 Links

Links opens a window in which the status of a linked object can be changed: the link can be broken or re-established.

4.2.13 Object

The available Object menu commands change depending on the type of object that is selected; it is preceded by the object type (worksheet, bitmap image). The Object submenu contains three commands, which also change depending on whether an object or an OLE control is selected. If an object is selected, the submenu commands are Edit, Open, and Convert; if an OLE control is selected, the submenu commands are Properties, Rotate, and Convert:

- Edit opens the object’s associated program within the ATMS Explorer document; clicking anywhere in the ATMS Explorer diagram outside the object closes the object’s associated program.
• **Open** opens the object’s associated program in a separate window.

• **Convert** opens a window in which a format for converting the object can be chosen. The commands for conversion vary depending on the object type, and not all objects can be converted.

• **Properties** opens the OLE control’s properties window, shown in.

• **Rotate** makes the control rotatable, which is indicated by a hatched border drawn around the control. Rotation is accomplished by clicking inside of the control’s outline and dragging it until the control is at the desired angle.

• **Convert** opens a window in which a format for converting the object can be chosen. The commands for conversion vary depending on the object type, and not all objects can be converted. ATMS controls cannot be converted.

### 4.2.14 Design Mode

**Design Mode** switches between Run mode and Design mode. In addition, clicking the pencil-shaped button on the **Design** toolbar also switches between Run mode and Design mode. The ATMS Explorer title bar indicates which mode is active.

In Design mode, objects can be created, moved, placed, and edited within the current document. The title bar contains a “design” label. The grid is visible if that feature is turned on.

In Run mode, controls are active and are dynamically updated. The grid is not visible.

### 4.3 VIEW MENU

The **View** menu, shown in Table 4.3, contains commands that alter how the document window appears.

**Table 4.3: View Menu Commands**

<table>
<thead>
<tr>
<th>MENU COMMAND</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Match Window Size to Document Size</td>
<td>Resizes the Explorer window to match the size of the selected document</td>
</tr>
<tr>
<td>Stretch Document to Fit Window</td>
<td>Resizes a document to fit the current size of the ATMS Explorer window</td>
</tr>
<tr>
<td>Show Object Outlines</td>
<td>Shows or hides a bounding box around the objects embedded in the diagram</td>
</tr>
<tr>
<td>Show Grid</td>
<td>Shows or hides the background grid displayed while in Design mode</td>
</tr>
<tr>
<td>Message Window</td>
<td>Shows or hides the <strong>ATMS Explorer Message Window</strong> component for the program</td>
</tr>
<tr>
<td>Main Toolbar</td>
<td>Shows or hides the <strong>Main</strong> toolbar</td>
</tr>
<tr>
<td>Design Toolbar</td>
<td>Shows or hides the <strong>Design</strong> toolbar</td>
</tr>
<tr>
<td>Insert Control Toolbar</td>
<td>Shows or hides the <strong>Insert Control</strong> toolbar</td>
</tr>
<tr>
<td>Status Bar</td>
<td>Shows or hides the status bar</td>
</tr>
<tr>
<td>Options</td>
<td>Opens the <strong>Options</strong> window, described later, where program settings can be changed</td>
</tr>
<tr>
<td>MENU COMMAND</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Refresh View</td>
<td>Refreshes the information being displayed through the embedded controls</td>
</tr>
</tbody>
</table>

All of the View menu commands, except Options and Refresh View, are checked commands that turn a feature on or off. If a command is checked, then the feature is turned on; otherwise, the feature is turned off.

4.3.1 Match Window Size to Document Size

Match Window Size to Document Size resizes the Explorer window to match the size of the document when it is opened. The window can be resized, if desired.

4.3.2 Stretch Document to Fit Window

Stretch Document to Fit Window scales the document, the grid, and all the objects in the document to fit in the ATMS Explorer window. If the size of the window is changed when Fit to Window is turned on, the document will also change to maintain the fit. Grid spacing is not accurate when Stretch Document to Fit Window is turned on.

4.3.3 Show Object Outlines

Show Object Outlines draws a bounding box around each object in the document, making the objects easier to see.

4.3.4 Show Grid

Show Grid turns on the background grid in the document area; the grid spacing and color are set on the Grid tab of the Options window (see Section 4.3.11.2).

4.3.5 Message Window

Message Window opens the ATMS Explorer Message Window, shown in Exhibit 4.5. This window contains messages generated by ATMS Explorer that match the filters set in the Show area: (Informational, Warning, Failure, and Debug).

Exhibit 4.5: ATMS Explorer Message Window

There are several commands within the ATMS Explorer Message Window:
- **Always on Top** puts the message window in front of all other windows when a new message is generated.

- **Auto-Scroll** causes the list box to scroll automatically to the bottom of the list whenever a new message is added.

- **Print** opens a typical Windows Print window where either all or only selected messages can be printed.

- **Clear** clears the list.

- **Close** closes the window and turns off the **Message Window** display on the **View** menu.

- **Options** opens the window shown in Exhibit 4.6, in which the types of messages that cause the message window to automatically appear can be selected; the message window then appears regardless of the **Message Window** mode.

Exhibit 4.6: Message Window Options

4.3.6 Main Toolbar

**Main Toolbar** turns on or off the **Main** toolbar, which is described in Section 4.7.1.

4.3.7 Design Toolbar

**Design Toolbar** turns on or off the **Design** toolbar, which is discussed in Section 4.7.2.

4.3.8 Insert Control Toolbar

**Insert Control Toolbar** turns on or off the **Insert Control** toolbar discussed in Section 4.7.3.

4.3.9 Status Bar

**Status Bar** turns on or off the status bar shown at the bottom of the ATMS Explorer window and is discussed in Section 4.8.

4.3.10 Refresh

**Refresh** redraws the entire window.

4.3.11 Options

**Options** open the **Options** window, where several program settings can be changed.
4.3.11.1 General Tab

The General tab, shown in Exhibit 4.7, contains a series of check boxes and buttons:

**Exhibit 4.7: Options Window - General Tab**

- **Show Outlines around Embedded Objects**, **Match Window Size to Document Size**, and **Stretch Document to Fit Window** are also commands on the View menu and are discussed in Section 4.3.

- **Use Double-buffered Drawing** turns on or off a special drawing function that prevents the layer objects from flickering on the map. When this feature is selected, objects should never flicker; but the program’s responsiveness may slow somewhat. It is recommended that this feature be selected.

- **Choose Color** opens a color selection window in which the ATMS Explorer’s base foreground and background colors can be selected. The colors selected here appear as the initial colors in the Document Properties window described in Section 4.1. These colors are used for any document that does not use custom colors.

- **Choose Font** opens a font selection window in which the base font, font style, and font size for ATMS Explorer can be chosen. The font selected here appears as the initial font in the Document Properties window described in Section 4.1. This font is used for any document that does not use a custom font.

4.3.11.2 Grid Tab

The Grid tab, shown in Exhibit 4.8, contains commands for configuring the design mode grid:
Exhibit 4.8: Options Window – Grid Tab

- **Show Grid** turns the display of the grid on or off.
- **Snap Objects to Grid** causes Explorer to align the embedded controls to the grid points automatically.
- **Grid Spacing** can be set in pixels, which is used by the **Snap Objects to Grid** feature. Only every **fourth** line of the snap grid is drawn on the display. For example, if the grid spacing is set to 10 pixels, the visible grid lines are spaced 40 pixels apart.
- **Choose Color** opens a color selection window for setting the grid color.

4.3.11.3 **Run** Tab

The **Run** tab, shown in Exhibit 4.9, contains settings that are used when ATMS Explorer starts:

Exhibit 4.9: Options Window – Run Tab
• Default Document provides an area to type the name of the document that is opened each time Explorer starts in Run mode. The name of the document can be typed or it can be selected by clicking Browse to look for the document.

• In the Reuse area, several types of windows can be selected. A window of any selected type opens once and is then refilled as new objects are selected. For example, if Monitor windows is selected and an intersection is double-clicked, a monitor window appears. The selected intersection is being monitored. Now when another intersection is double-clicked, that intersection’s information replaces the first intersection's information in the monitor window. If Monitor windows is not selected, each time an intersection is double-clicked, a new monitor window opens.

• Clicking OK closes the Options window and applies any changes that have been made; clicking Cancel closes the window without saving any changes.

4.4 LAYOUT MENU

The Layout menu, shown in Table 4.4, provides commands to align, resize, and move objects backward and forward in the document. Many of the Layout menu commands are also found on the Design toolbar.

Table 4.4: Layout Menu Commands

<table>
<thead>
<tr>
<th>MENU COMMAND</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Align Left</td>
<td>Aligns the selected objects along the vertical axis by their left edge.</td>
</tr>
<tr>
<td>Align Vertical</td>
<td>Aligns the selected objects along the vertical axis by their center.</td>
</tr>
<tr>
<td>Align Right</td>
<td>Aligns the selected objects along the vertical axis by their right edge.</td>
</tr>
<tr>
<td>Align Top</td>
<td>Aligns the selected objects along the horizontal axis by their top edge.</td>
</tr>
<tr>
<td>Align Horizontal</td>
<td>Aligns the selected objects along the horizontal axis by their center.</td>
</tr>
<tr>
<td>Align Bottom</td>
<td>Aligns the selected objects along the horizontal axis by their bottom edge.</td>
</tr>
<tr>
<td>Space Evenly Across</td>
<td>If three or more objects are selected, the selected objects are moved so</td>
</tr>
<tr>
<td></td>
<td>that they are evenly spaced from left to right (the leftmost and rightmost</td>
</tr>
<tr>
<td></td>
<td>objects do not move; only the objects in between move).</td>
</tr>
<tr>
<td>Space Evenly Down</td>
<td>If three or more objects are selected, the selected objects are moved so</td>
</tr>
<tr>
<td></td>
<td>that they are evenly spaced from top to bottom (the top and bottom objects</td>
</tr>
<tr>
<td></td>
<td>do not move; only the objects in between move).</td>
</tr>
<tr>
<td>Same Height</td>
<td>Makes all selected objects the same height.</td>
</tr>
<tr>
<td>Same Width</td>
<td>Makes all selected objects the same width.</td>
</tr>
<tr>
<td>Same Size</td>
<td>Makes all the selected objects the same height and width.</td>
</tr>
<tr>
<td>Bring To Front</td>
<td>Moves the selected object to the front of the document.</td>
</tr>
<tr>
<td>Bring Forward</td>
<td>Moves the selected object forward one layer.</td>
</tr>
<tr>
<td>Send Backward</td>
<td>Moves the selected object backward one layer.</td>
</tr>
<tr>
<td>Send to Back</td>
<td>Moves the selected object to the back of the document.</td>
</tr>
<tr>
<td>Expand to Fill Document</td>
<td>Increases the size of the selected object so that it fills the entire</td>
</tr>
<tr>
<td></td>
<td>document.</td>
</tr>
</tbody>
</table>
4.4.1 Align Commands

Align Left, Align Vertical, and Align Right line up the selected objects along the vertical axis by their left edge, center, or right edge respectively. Align Top, Align Horizontal, and Align Bottom line up the selected objects along the horizontal axis by their top edge, center, or bottom edge respectively. The align commands change all objects relative to the anchor object, which is the first object selected if the objects were selected one at a time. If several objects are selected by rubberbanding, the align commands change all objects relative to the object closest to the back.

4.4.2 Space Commands

If three or more objects are selected, Space Evenly Across moves them so that they are evenly spaced from left to right. The leftmost and rightmost objects do not move; only the objects in between move. Space Evenly Down arranges three or more selected objects so that they are evenly spaced from top to bottom. The top and bottom objects do not move; only the objects in between move.

4.4.3 Same Commands

Same Height makes all selected objects the same height. Same Width makes all the selected objects the same width. Same Size makes all the selected objects the same height and width. The resize commands change all objects relative to the anchor object, which is the first object selected if the objects were selected one at a time. If several objects are selected by rubberbanding, the resize commands change all objects relative to the object closest to the back.

4.4.4 Bring and Send Commands

Bring to Front moves the selected object to the front of the document. Bring Forward moves the selected object forward one layer. Send Backward moves the selected object backward one layer, and Send to Back moves the selected object to the back of the document. If several objects are selected, they maintain their position relative to each other when they move.

4.4.5 Expand to Fill Document

Expand to Fill Document increases the size of the selected object so that it fills the entire document.

4.4.6 Snap to Grid

Snap to Grid turns on or off the Snap Object to Grid setting as described in Section 4.3.

4.5 SCRIPT MENU

The Script menu allows the user to run predefined scripts and procedures for ATMS Explorer from the menu commands found in Table 4.5.
Table 4.5: ATMS Explorer Script Menu Commands

<table>
<thead>
<tr>
<th>MENU COMMAND</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Execute Script</td>
<td>Opens the <strong>Execute Script</strong> window to enable the entry of VB Script code to execute</td>
</tr>
<tr>
<td>Run Procedure</td>
<td>Opens the <strong>Run Procedure</strong> window to enable the selection of a procedure to run</td>
</tr>
</tbody>
</table>

4.5.1 Execute Script

**Execute Script** opens the window shown in Exhibit 4.10.

**Exhibit 4.10: Execute Script Window**

In the **Execute Script** window:

- The user types VB Script code or loads it from a file by clicking **Browse**. When a file is selected, it is loaded into the text window.
- Clicking **Clear All** clears the window.
- **Execute** runs the script. If an error occurs while the script runs, an error window appears.
- Clicking **Cancel** closes the window.

4.5.2 Run Procedure

**Run Procedure** opens the window shown in Exhibit 4.11, where the user can select a procedure to execute:
Exhibit 4.11: Run Procedure Window

To run one of the procedures, the user selects it from the list and clicks **OK**, or double-clicks the procedure name. Only procedures that do not require parameters are shown in the window. If an error occurs while the script is runs, an error window appears. The procedures listed in this window come from the file called *xplscript.txt*, which is the standard script file shared by all users. This script file is loaded automatically when ATMS Explorer is started.

### 4.6 HELP MENU

The **Help** menu commands, shown in Table 4.6, access the ATMS Explorer Help and provide more information about the program.

**Table 4.6: Help Menu Commands**

<table>
<thead>
<tr>
<th>MENU COMMAND</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Help Topics</td>
<td>Opens the online help for the program</td>
</tr>
<tr>
<td>About ATMS Explorer</td>
<td>Opens the version and copyright information window</td>
</tr>
</tbody>
</table>

#### 4.6.1 Help Topics

**Help Topics** opens a standard Windows Help window, in which a list of ATMS Explorer topics is shown.

#### 4.6.2 About ATMS Explorer

**About ATMS Explorer** displays the program name, version number, release date, and copyright information. Clicking **More** displays details about the software source file versions.

### 4.7 ATMS EXPLORER TOOLBARS

ATMS Explorer includes the following three toolbars:

- **Main** toolbar
- **Design** toolbar
- **Insert Controls** toolbar
The toolbars include the most frequently used commands on the Explorer menus. As the mouse pointer moves over the toolbar icons, floating ToolTips provide a one-word description of the command button function. More descriptive tool help appears on the status bar.

4.7.1 Main Toolbar

The **Main** toolbar, shown in Exhibit 4.12, contains file, edit, print, and help commands. These commands are discussed in the order in which they appear, from left to right:

**Exhibit 4.12: Main Toolbar**

- The **New** button duplicates the functionality of the **New** command on the **File** menu, described in Section 4.1.1.
- The **Open** button duplicates the functionality of the **Open** command on the **File** menu, described in Section 4.1.2.
- The **Save** button duplicates the functionality of the **Save** command on the **File** menu, described in Section 4.1.3.
- The **Save As** button duplicates the functionality of the **Save As** command on the **File** menu, described in Section 4.1.4.
- The **Undo** button duplicates the functionality of the **Undo** command on the **Edit** menu, described in Section 4.2.1.
- The **Redo** button duplicates the functionality of the **Redo** command on the **Edit** menu, described in Section 4.2.2.
- The **Cut** button duplicates the functionality of the **Cut** command on the **Edit** menu, described in Section 4.2.3.
- The **Copy** button duplicates the functionality of the **Copy** command on the **Edit** menu, described in Section 4.2.4.
- The **Paste** button duplicates the functionality of the **Paste** command on the **Edit** menu, described in Section 4.2.5.
- The **Print** button duplicates the functionality of the **Print** command on the **File** menu, described in Section 4.1.7.
- The **About** button duplicates the functionality of the **About ATMS Explorer** command on the **Help** menu, described in Section 4.6.2.
### 4.7.2 Design Toolbar

The **Design** toolbar, shown in Exhibit 4.13, contains align, space, resize, move, and mode commands. These commands are discussed in the order in which they appear from left to right:

**Exhibit 4.13: Design Toolbar**

- The **Design Mode** button duplicates the functionality of the **Design Mode** command on the **Edit** menu, described in Section 4.2.4.
- The **Align Left**, **Align Vertical**, **Align Right**, **Align Top**, **Align Horizontal**, and **Align Bottom** buttons duplicate the functionality of the **Align** commands on the **Layout** menu, described in Section 4.4.1.
- The **Space Evenly Across** and **Space Evenly Down** buttons duplicate the functionality of the **Space** commands on the **Layout** menu, described in Section 4.4.2.
- The **Same Height**, **Same Width**, and **Same Size** buttons duplicate the functionality of the **Same** commands on the **Layout** menu, described in Section 4.4.3.
- The **Bring to Front**, **Bring Forward**, **Send Backward**, and **Send to Back** buttons duplicate the functionality of the **Bring** and **Send** commands on the **Layout** menu, described in Section 4.4.4.

### 4.7.3 Insert Control Toolbar

The **Insert Control** toolbar, shown in Exhibit 4.14, allows users to add ATMS controls quickly to the current diagram. These command buttons are listed in the order in which they appear, from left to right:

- **Insert IEN Intersection with Green Indications Control** button (Section 6.5)
- **Insert IEN Intersection Control** button (Section 6.1)
- **Insert IEN Intersection Legend Control** button (Section 6.2)
- **Insert IEN Intersection Status Text Control** button (Section 6.3)
- **Insert IEN Intersection Header Control** button (Section 6.4)
- Insert IEN Green Arrow Control button (Section 6.5)
- Insert IEN Pedestrian Indication Control button (Section 6.7)
- Insert IEN Vehicle Call Control button (Section 6.8)
- Insert IEN Detector Control button (Section 6.9)
- Insert IEN Detector Legend Control button (Section 6.9.1)
- Insert IEN Detector Status Text Control button (Section 6.9.4)
- Insert IEN Section Control button (Section 0)
- Insert IEN Section Legend Control button (Section 6.11)
- Insert IEN Section Status Text Control button (Section 6.12)
- Insert ATMS Hyperlink Control button (Section 6.13)

Exhibit 4.14: Insert Control Toolbar

4.8 ATMS EXPLORER STATUS BAR

The status bar, shown in Exhibit 4.15, is found at the bottom of the ATMS Explorer window. It can be turned on or off on the View Menu. As the mouse pointer is moved over a menu command or a toolbar command button, a short description of the command on the left side of the status bar. The right side shows which keyboard locks are turned on.

Exhibit 4.15: Status Bar
5. ATMS EXPLORER DIAGRAM AREA

The ATMS Explorer diagram area, shown in Exhibit 5.1, is the largest portion of a typical ATMS Explorer window.

Exhibit 5.1: ATMS Explorer Diagram Area

5.1 BACKGROUND COLOR

The background color in the document area can be set in two ways. The initial background color for ATMS Explorer is selected on the General tab of the Options window (Section 4.3). The background color can be set for an individual document by choosing a custom color in the Document Properties window. This window is accessible from the Properties command on the File menu (Section 4.1) or from the Properties command on the shortcut menu that appears when the user right-clicks on the background in the document area.

5.2 GRID

The grid in the document area serves as a tool for aligning objects in the document and can be used as a visual guide. Turning on Snap Objects to Grid allows Explorer to align objects to the grid points automatically. The grid can be turned on or off with the Show Grid command on the View menu (Section 4.3). The Grid tab of the Options window enables configuration of the grid spacing and color (Section 4.3.11.2). The user can turn on Snap to Grid on the Layout menu or Snap Objects to Grid in the Options window. Grid spacing may not be accurate when Stretch Document to Fit Window is turned on.
5.3 OBJECTS

Objects and controls are critical components of ATMS Explorer. They are placed in the document area to represent the background, the roadway network, and the TCS devices to be monitored.

Any OLE object can be manipulated in the document area. In order to do this, the user clicks on an object and its handles will appear; the object can be resized by dragging any of its handles. An object or a group of objects can be moved by dragging the object(s). An object can also be moved one pixel at a time using the arrow keys. Right-clicking an object opens a context-sensitive shortcut menu in which edit, align, and object properties commands are available (Section 5.4). Turning on Show Objects on the View menu makes objects more easily discernible on a dark background and makes it easier to see the full extent of an object. A bounding box is drawn around each object in the current document.

5.4 SHORTCUT MENUS

There are two shortcut menus available when an ATMS Explorer diagram is in Design mode. The ATMS Explorer Design mode shortcut menu (shown in Table 5.1) is opened by right-clicking in an "unoccupied" area of the diagram. In other words, a different menu is displayed when an embedded object is right-clicked. The commands found on this menu are described throughout Section 4.

Table 5.1: Design Mode Shortcut Menu Commands

<table>
<thead>
<tr>
<th>MENU COMMAND</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo</td>
<td>Undoes the most recent editing action (repeatedly choosing Undo will continue to step backward through the user’s actions, undoing one at a time, up to the action taken immediately after a file save).</td>
</tr>
<tr>
<td>Redo</td>
<td>Does the exact opposite of Undo, reapplying the user’s most recent editing actions one at a time.</td>
</tr>
<tr>
<td>Paste</td>
<td>Copies the contents of the clipboard to the current document.</td>
</tr>
<tr>
<td>Paste Special</td>
<td>Opens the standard Paste Special window to allow the user to choose the format for the contents of the clipboard, such as pasting a linked object so that it updates in ATMS Explorer as the original object is updated.</td>
</tr>
<tr>
<td>Select All</td>
<td>Selects all of the selectable items in the document.</td>
</tr>
<tr>
<td>Insert OLE Control</td>
<td>Opens the Insert Control window to allow the user to choose a control to insert.</td>
</tr>
<tr>
<td>Insert Object</td>
<td>Opens the Insert Object window to allow the user to create a new object or insert an existing object.</td>
</tr>
<tr>
<td>Import Background</td>
<td>Invokes the Import Background window to enable the user to choose an existing file to open as the background for the document. The background will be placed behind any objects that are inserted in the drawing.</td>
</tr>
<tr>
<td>Properties</td>
<td>Opens the Document Properties window.</td>
</tr>
</tbody>
</table>
The ATMS Explorer Design Mode control shortcut menu (shown in Table 5.2) is opened by right-clicking an embedded control. The commands found on this menu are described in detail throughout Section 4.

Table 5.2: Design Mode Control Shortcut Menu Commands

<table>
<thead>
<tr>
<th>MENU COMMAND</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cut</td>
<td>Moves the selected item(s) to the clipboard.</td>
</tr>
<tr>
<td>Copy</td>
<td>Copies the selected item(s) to the clipboard.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the selected item(s).</td>
</tr>
<tr>
<td>Bring to Front</td>
<td>Moves the selected object to the front of the document.</td>
</tr>
<tr>
<td>Bring Forward</td>
<td>Moves the selected object forward one layer.</td>
</tr>
<tr>
<td>Send Backward</td>
<td>Moves the selected object backward one layer.</td>
</tr>
<tr>
<td>Send to Back</td>
<td>Moves the selected object to the back of the document.</td>
</tr>
<tr>
<td>Expand to Fill Document</td>
<td>Increases the size of the selected object so that it fills the entire</td>
</tr>
<tr>
<td></td>
<td>document.</td>
</tr>
<tr>
<td>Properties</td>
<td>Opens the <strong>Object Properties</strong> window for the object that the user has</td>
</tr>
<tr>
<td></td>
<td>selected.</td>
</tr>
<tr>
<td>IEN <code>objectname</code> Control Object</td>
<td>Opens an object-specific submenu that contains commands related to</td>
</tr>
<tr>
<td></td>
<td>the selected object (<code>objectname</code>).</td>
</tr>
</tbody>
</table>

5.5 MONITORING WINDOWS

Monitoring windows display detailed intersection and detector information. The windows can be opened by double-clicking an IEN Intersection controls or an IEN Detector controls when ATMS Explorer is in Run mode. Each monitoring window shows real-time information collected from the associated field device. As long as the window remains open, the information will continue to be updated.

5.5.1 Intersection Detail Window

The Intersection Detail window, shown in Exhibit 5.2 enables the monitoring of detailed TCS controller data for a single intersection. The window can be opened from the ATMS Map or ATMS Explorer programs by double-clicking an intersection icon or by clicking **Monitor** on the icon's right-click shortcut menu.
Exhibit 5.2: Intersection Detail Window

5.5.1.1 Menu Bar

The Intersection Detail window contains the following menus:

- **File**
- **Edit**
- **Command**
- **Show**

These menus are described in the following sections.

5.5.1.2 File Menu

The **File** menu contains the following two commands:

- **Print** sends a copy of the information displayed in the Intersection Detail window to the system's default printer.
- **Exit** closes the window.

5.5.1.3 Edit Menu

The **Edit** menu contains a single command, **Entity**, which opens the window shown in Exhibit 5.3. This window can be used to change the intersection that is being monitored:
The appropriate **Corridor**, **Site**, **System**, and entity number (**Entity Num**) values are selected from the lists to identify the desired intersection. Clicking **OK** begins monitoring the new intersection; clicking **Cancel** retains the current monitored intersection.

5.5.1.4 Command Menu

The Command menu includes the following menu items:

- **Change Plan**
- **Flash Off**
- **Change Mode**
- **Flash On**
- **Release IEN Control**

A user is able to send a command to a particular intersection only if that user has been granted the specific privilege to do so. Please note that the IEN does not directly control intersections. The IEN can request that a traffic control system change the plan or mode of one of its intersections, but it is up to the traffic control system to implement that command. IEN commands may not be supported or authorized by every connected traffic control system.

**Change Plan** opens the window shown in Exhibit 5.4 which allows authorized users to request that the operational plan of a TCS intersection controller be changed by its native traffic control system.

The plan currently running at the intersection is identified at the top of the window. To change the plan, the user enters the desired plan number and clicks **OK**. A confirmation dialog is displayed: the user selects **Cancel** to retain the current plan or **YES** to confirm the plan change. Clicking **Cancel** in the Change Plan window closes the window without changing the plan.
Change Mode opens the window shown in Exhibit 5.5, which allows authorized users to request that the operational mode of a TCS intersection controller be changed by its native traffic control system.

Exhibit 5.5: Change Mode Window

The current mode is identified at the top of the window. The current mode and its radio button are disabled among the choices. To change the mode, the user selects the desired mode and clicks OK. A confirmation dialog is displayed: the user selects Cancel to retain the current mode or YES to confirm the mode change. Clicking Cancel in the Change Mode window closes the window without changing the mode.

The Release IEN Control menu item releases an intersection from IEN control. A confirmation dialog is displayed: the user selects Cancel to retain control or YES to release the intersection.

The Flash On command allows authorized users request that an intersection be put into flash operation by its native traffic control system. A confirmation dialog is displayed: the user selects Cancel to drop the command or YES to send the command.

5.5.1.5 Show Menu

The Show menu contains a single command, Zoom to Map, which opens the ATMS Map program, if it is not already open, and centers the map view on the selected intersection.

5.5.1.6 Status Bar

The status bar, shown in Exhibit 5.6, appears at the bottom of the Intersection Detail window.

Exhibit 5.6: Status Bar

The left pane of the status bar displays the program's copyright information. When time-consuming operations are occurring, an indication is shown here instead of the copyright information. The right pane displays the current time and date.

5.5.2 Detector Detail Window

The Detector Detail window, shown in Exhibit 5.7, enables the monitoring of detailed data for a single detector. The window can be opened by double-clicking a detector control or by clicking Monitor on the icon's right-click shortcut menu.
Exhibit 5.7: Detector Detail Window

The window is divided into three areas:

- **Entity Information**: identifies the location of the detector within the IEN.
- **Detector State**: displays the dynamic data being collected from the detector.
- **Detector Configuration**: displays configuration information for the detector.

The information displayed in the **Detector State** area updates to reflect the current values collected from the detector.

Clicking **Detach** disassociates the current **Detector Detail** window from the Explorer document. This enables the simultaneous monitoring of multiple detectors. Clicking **Quit** closes the **Detector Detail** window.

**5.5.3 Section Detail Window**

The Section Detail window, shown in Exhibit 5.8, can be opened by double-clicking an IEN Section control or by right-clicking the control and then clicking **Monitor** on the shortcut menu that appears. The Section Detail window displays both static configuration information as well as dynamic data being reported by the TCS.
Exhibit 5.8: Section Detail Window

The Section Detail window contains the following menus:

- **File**
- **Edit**
- **Command**

5.5.3.1 File Menu

The **File** menu contains the following commands.

- **Print** sends a snapshot of the Section Detail window to the system’s default printer.
- **Exit** closes the window.

5.5.3.2 Edit Menu

The **Edit** menu contains a single command, **Entity**, which launches a window that can be used to change the section that is being monitored.

To monitor a different section, the appropriate **Corridor**, **Site**, **System**, and entity number (**Entity Num**) values are selected from the lists to identify the desired section. Clicking **OK** begins monitoring the new section; clicking **Cancel** retains the current monitored section.

5.5.3.3 Command Menu

The Section Detail window **Command** menu commands are similar to the Intersection Detail window commands described in Section 5.5.1.4.
6. ATMS CONTROLS

ATMS controls show dynamic information in the Explorer document. Section 4.2 explains how to insert the controls from the Edit menu. Each of these controls has unique attributes and properties, which are described in detail throughout this section.

While ATMS Explorer is in Design mode, if the several ATMS controls are selected and then Properties is clicked, all the common property tabs are displayed. This conveniently allows the setting of common properties for multiple controls, such as setting the same device association for a group of green arrows controls and an intersection control, for example.

6.1 IEN INTERSECTION CONTROLS

IEN Intersection controls display the performance status, operating characteristics, timing information, plan selection information, and communication status of their associated intersection controllers. The control can be drawn as either a circle or a rectangle shape, as shown in Exhibit 6.1.

Exhibit 6.1: Intersection Controls

Each intersection icon is associated with a single TCS controller, which allows the user to monitor the operational status, mode, and performance of the associated intersection.

The Object Properties window for an intersection controller, shown in Exhibit 6.2, has three configuration tabs:

- The Entity tab displays the Corridor, Site, and System assignment of the associated intersection controller, along with its Entity number within the IEN. The Name and Description of the selected Entity are also displayed.

- The Icon tab contains commands that allow the user to change the Shape and the Rotation Angle of the control. The Intersection control can be drawn as either a circle or a rectangle. The rotation angle is the direction that the controller icon points, in degrees (0 is up, 90 is right, 180 is down, and 270 is left); this is not applicable to a circular icon. The Detail Level is not used for controls that are embedded in ATMS Explorer diagrams.

- The Object tab contains the Object ID, Object Name, Location (in pixels, from top left corner), and size (in pixels).
6.2 INTERSECTION LEGEND CONTROLS

Intersection Legend controls provide an indication legend for IEN Intersection controls. The legend control selects the type of information that is indicated by the color of intersection controls within the diagram. When status is selected, for example, intersection controls are colored to indicate the current status of their associated devices.

The Intersection Legend Control has the following legend tabs:

- Status
- Mode
- Operations
- Alarms
- Cycle

Each of these tabs is described in more detail in the following sections.

6.2.1 Intersection Legend Status Tab

The Status tab of the Intersection Legend, shown in Exhibit 6.3, lists the status indication colors for intersections.
It also contains the **Configure Colors** and **Show Main Street Direction** options. **Configure Colors** opens the Intersection Color Config screen (see Exhibit 6.4), which can be used to change intersection indication colors. To change an indication color, click the color field and then make a selection from the displayed color pallet. Selecting **IEN Default** on the color pallet resets the color to the IEN default for that indication.

**Exhibit 6.4: Intersection Color Config**

![Intersection Color Config](image)

Indication colors are per-user and per-system configuration settings. This means that each user may customize the colors to suit their preferences. Users that log on to multiple IEN systems would need to customize the colors on each of those systems separately.

**Show Main Street Direction** enables/disables the display of the main street directional indication.

### 6.2.2 Intersection Legend Mode Tab

The Mode tab of the Intersection Legend, shown in Exhibit 6.5, lists the intersection mode indication colors.

**Exhibit 6.5: Intersection Mode Legend**

![Intersection Mode Legend](image)
6.2.3 Intersection Legend Operations Tab

The **Operations** tab of the **Intersection Legend**, shown in Exhibit 6.6, contains three indications:

- **Main Street Green** indicates whether controllers are currently serving their main street green phase(s).
- **Comm Errors** indicates whether controllers currently have communication errors.
- **Not Responding** indicates whether controllers are currently not responding.

Only one of the indications can be active at a time.

![Exhibit 6.6: Intersection Operations Legend](image)

6.2.4 Intersection Legend Alarms Tab

The **Alarms** tab of the Intersection Legend, shown in Exhibit 6.7, contains four indications:

- **Flash** indicates whether controllers are currently reporting a flash alarm.
- **Door Open** indicates whether controllers are currently reporting a door open alarm.
- **Transition** indicates whether controllers are currently reporting a transition alarm.
- **Internal Error** indicates whether controllers are currently reporting an internal error alarm.

Only one of the indications can be active at a time.
6.2.5 Intersection Cycle Legend

The Cycle tab of the Intersection Legend, shown in Exhibit 6.8, lists the intersection cycle length indication colors.

When selected, the legend causes intersection controls to indicate which of the following conditions is true for their associated devices:

- Planned cycle length is less than the low threshold.
- Planned cycle length is between the low and high thresholds.
- Planned cycle length is greater than or equal to the high threshold.
- Planned cycle length data is unavailable (icon is white).

The cycle length thresholds are configurable. To change a threshold, enter a new value (number of seconds) into the threshold field. Threshold changes go into effect immediately.

When ATMS Explorer is in Design mode, the Intersection Legend control appears as a gray box with the words “Intersection Legend” inside. Double-clicking the box makes it active. By clicking a legend tab while the intersection legend control is active in Design mode, that legend configuration will be used each time the document is opened.

6.3 INTERSECTION STATUS TEXT CONTROLS

Intersection Status Text controls display a particular aspect of the information collected from their associated intersection controllers. These aspects include the following:
The **Object Properties** window for an intersection status text control, shown in Exhibit 6.9, has five configuration tabs:

- The **Entity** tab displays the **Corridor**, **Site**, and **System** assignment of the associated intersection controller, along with its **Entity** number within the IEN. The **Name** and **Description** of the selected **Entity** are also displayed.

- The **Icon** tab includes the **Display Text**, which is the information aspect that will be shown, **ToolTip Text**, which is the text displayed when the mouse pointer hovers over the icon, and the **Rotation Angle** for TrueType fonts. The text orientation is in degrees; 360 degrees centers the text. **Detail Level** is not used.

- The **Fonts** and **Colors** tabs enable control of the appearance of text.

- The **Object** tab contains the **Object ID**, **Object Name**, **Location** (in pixels, from top left corner), and size (in pixels).

**Exhibit 6.9: Intersection Status Text Control Object Properties Window**

### 6.4 INTERSECTION HEADER CONTROLS

Intersection Header controls, shown in Exhibit 6.10, display detailed information for their associated intersection controllers.
Exhibit 6.10: Intersection Header Control

The **Object Properties** window for an intersection header control, shown in Exhibit 6.11, has three configuration tabs:

- The **Entity** tab displays the **Corridor**, **Site**, and **System** assignment of the associated intersection controller, along with its **Entity** number within the IEN. The **Name** and **Description** of the selected **Entity** are also displayed.

- The **Fonts** and **Colors** tabs enable control of the appearance of text in the header control.

- The **Object** tab contains the **Object ID**, **Object Name**, **Location** (in pixels, from top left corner), and size (in pixels).

**Exhibit 6.11: Intersection Header Control Properties Window**

<table>
<thead>
<tr>
<th>Timing Plan</th>
<th>Cycle Count</th>
<th>Planned Length/Offset</th>
<th>Last Cycle Length/Offset</th>
<th>Section ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>26</td>
<td>96/15</td>
<td>15/23</td>
<td>11</td>
</tr>
</tbody>
</table>

**6.5 INTERSECTION WITH GREEN INDICATIONS CONTROL**

Intersection with Green Indication controls display the performance status, operating characteristics, timing information, plan selection information, and communication status of their associated intersection controllers; in addition, they simulate the green arrow indications being shown to drivers in particular lanes of an intersection. The control can be drawn in the shape shown in Error! Reference source not found..

**Exhibit 6.12: Intersection with Green Indications Control**
In Run mode, an Intersection with Green Indications control displays the dynamic data collected from its associated TCS device. This data is shown by its indication color and ToolTip. Status, Mode, Operations, and Alarm indications are selected on the IEN Intersection Legend, which can be embedded within the Explorer document or be opened by right-clicking an intersection control and then clicking Show Legend on the shortcut menu that appears.

For more detailed information, an Intersection Detail window (see Section 5.5.1) can be displayed by double-clicking a particular intersection control or by right-clicking the control and then clicking Monitor on the shortcut menu that appears.

In Run mode, an Intersection with Green Indications control will also display colored "arrowheads" pointing inward toward the intersection. The arrowheads will be drawn in one of the following colors depending on how the control has been configured to react to the active phases of a particular TCS Intersection Controller:

- Green: Indicates that drivers at a particular side of an intersection are being shown a "green light."
- Yellow: Indicates that an active phase has just ended and that drivers are no longer being shown a "green light." This simulates a "yellow light" indication.
- Hidden: Indicates that drivers are not being shown a "green light." This simulates a "red light" indication.

The arrow indications dynamically update to reflect the phase cycles of their associated TCS controller.

The Object Properties window for an Intersection with Green Indications control, shown in Exhibit 6.13, can be opened by right-clicking the control and then clicking Properties on the shortcut menu that appears.

Exhibit 6.13: Intersection with Green Indications Control Object Properties Window

The three tabs on the Object Properties window are used to configure the association and behavior of the selected control:
• The **Entity** tab enables the association of a control with a particular TCS intersection controller.

• The **Object** tab shows the position of the control within the document.

• The **Icon** tab contains the left, bottom, right, and top leg configuration parameters, which determine the behavior of the control in Run mode. The active phases at which a leg of the control should indicate a "green" state are selected in the **Greens** column. Any conflicting phases at which a leg of the control needs to indicate a "not-green" state are selected in the **Conflicts** column.

Clicking **OK** closes the window, applying any changes that were made. Clicking **Apply** also applies any changes but does not close the window. Clicking **Cancel** discards any unsaved changes and closes the window.

### 6.6 GREEN INDICATION CONTROLS

Green Indication controls simulate the traffic signals that are shown to a particular leg of the intersection or lane of traffic. The possible shapes of the Green Indication controls are shown in Exhibit 6.14.

#### Exhibit 6.14: Green Indication Control Shapes

![Green Indication Control Shapes](image)

The Green Indication controls display green returns data received from intersection controllers. In Run mode, the color and appearance of the control will change as the device data changes, as described in Table 6.1. In Design mode, the control will appear as a green arrow and red stop bar.

#### Table 6.1: Green Indication States

<table>
<thead>
<tr>
<th>DEVICE DATA STATE</th>
<th>CONTROL APPEARANCE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>Green arrow</td>
</tr>
<tr>
<td>Yellow</td>
<td>Yellow arrow</td>
</tr>
<tr>
<td>Red</td>
<td>Red stop bar (unless show stop bar property is false)</td>
</tr>
</tbody>
</table>
The **Object Properties** window for Green Indication controls, shown in Exhibit 6.15, has three configuration tabs:

- The **Entity and Object** tabs are the same as those of the ATMS controls described previously.
- The **IEN Green Indication** tab contains configuration settings that determine the appearance and set-up of the control:
  - The Arrow Shape list enables the selection of the shape of the control.
  - **Rotation Angle** is the direction that the north green indication points, in degrees. 0 degrees is up, 90 is right, 180 is down, and 270 is left.
  - **Max Yellow** is the maximum length of a time a control should indicate a yellow interval. This information is not returned from the field in real time as other data is.
  - The **Left Turn**, **Straight**, and **Right Turn** areas are available or unavailable, depending on the arrow shape. The green movement numbers (**Greens**) to be displayed for each arrow and conflicting movement numbers (**Conflicts**) are selected for each area. The use of conflicting movement numbers is another method to determine when a control’s yellow interval should end. The control’s yellow interval will end at the **Max Yellow** time or when the conflicting movement turns green, whichever occurs first.

Exhibit 6.15:  Green Indication Control Properties Window

### 6.7 PEDESTRIAN INDICATION CONTROLS

Pedestrian Indication controls, shown in Exhibit 6.16, indicate the pedestrian signal being shown on a particular side of an intersection. In Run mode, the pedestrian indication OLE controls change depending on the current phase data being reported by the linked TCS controller and the
configuration of the control properties (). In Design mode, the control appears as a walking figure.

**Exhibit 6.16: Pedestrian Indication Controls**

![Pedestrian Indication Controls]

<table>
<thead>
<tr>
<th>DEVICE DATA STATE</th>
<th>CONTROL APPEARANCE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Walk</td>
<td>White walking figure</td>
</tr>
<tr>
<td>Flashing Don’t Walk</td>
<td>Flashing red hand symbol</td>
</tr>
<tr>
<td>Don’t Walk</td>
<td>Steady red hand symbol</td>
</tr>
<tr>
<td>Waiting for data</td>
<td>Invisible</td>
</tr>
<tr>
<td>Unknown</td>
<td>Gray hand symbol</td>
</tr>
</tbody>
</table>

**Table 6.2: Pedestrian Indication States**

The **Object Properties** window for Pedestrian Indication controls, shown in Exhibit 6.17, has three tabs:

- The **Entity** and **Object** tabs are the same as those of the ATMS controls described previously.
- The **IEN Pedestrian Indication** tab contains configuration commands that determine the look and set-up of the control:
  - Rotation Angle is the direction that the pedestrian indication points, in degrees. 0 degrees is up, 90 is right, 180 is down, and 270 is left.
  - Max FDW Seconds (Flashing Don’t Walk) is the maximum length of a time a control should indicate a "flashing don’t walk" display. This information is not returned from the field in real time as other data is.
  - In the Ped Mvmts (pedestrian movements) area, the pedestrian movement numbers to be displayed for the control are selected.
  - In the Conf Veh Mvmts (conflicting vehicle movements) area, the conflicting vehicle movement numbers are selected. The use of conflicting movement numbers is another method to determine when a control’s “flashing don’t walk” interval should end. The control’s "flashing don’t walk" interval will end at the Max FDW Seconds time or when the conflicting vehicle movement turns green, whichever occurs first.
6.8 VEHICLE CALL CONTROLS

Vehicle Call controls indicate the vehicle presence-state of their associated sensors. In Run mode, the Vehicle Call OLE controls, shown in Exhibit 6.18 change depending on the status of their associated sensor (Table 6.3). In Design mode, the control appears as a green symbol.

Exhibit 6.18: Vehicle Call Control

Table 6.3: Vehicle Call Control States

<table>
<thead>
<tr>
<th>DEVICE DATA STATE</th>
<th>CONTROL APPEARANCE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vehicle presence detected</td>
<td>Blue with hatch pattern</td>
</tr>
<tr>
<td>No vehicle presence detected</td>
<td>Blue with no hatch pattern</td>
</tr>
<tr>
<td>Failure</td>
<td>Red</td>
</tr>
<tr>
<td>Unknown</td>
<td>White</td>
</tr>
<tr>
<td>Design mode</td>
<td>Green with no hatch pattern</td>
</tr>
</tbody>
</table>

The Object Properties window for a Vehicle Call control, shown in Exhibit 6.19, has three configuration tabs:

- The Entity and Object tabs are the same as those of the ATMS controls described previously.
- The IEN Vehicle Call Control tab contains configuration commands that determine the look and set-up of the control:
  - Rotation Angle is the direction that the Vehicle Call control points, in degrees. 0 degrees is up, 90 is right, 180 is down, and 270 is left.
  - Local Detectors contains the reported values that should cause the control to indicate a "vehicle presence detected" state.
6.9 DETECTOR CONTROLS

Detector controls, shown in Exhibit 6.20, display status, volume, speed, occupancy, or V+kO data from their associated VOS detectors. In Run mode, the display of the Detector OLE controls depends on the status of the detector and the settings in the detector legend (Section 6.9.1).

**Exhibit 6.20: Detector Controls**

The **Object Properties** window for a Detector control shown in Exhibit 6.21: Detector Control Properties Window

has three configuration tabs:

- The **Entity** and **Object** tabs are the same as those of the ATMS controls described previously.
- The **Icon** tab contains configuration commands that determine the look and set-up of the control:
  - The Detector control can be drawn as a "square" or an "octagon" Shape.
  - Rotation Angle is the direction that the Detector control points, in degrees. 0 degrees is up, 90 is right, 180 is down, and 270 is left. This is not applicable to octagonal controls.

**Exhibit 6.21: Detector Control Properties Window**
6.9.1 Detector Legend Controls

Detector Legend controls provide an indication legend for the IEN Detector controls. The indication colors are shown in Table 6.4.

The control enables the selection an indication for the Detector controls that are displayed in the diagram. The Detector controls are dynamic and change colors to reflect changes in the data being collected from their associated TCS devices.

The Detector Legend control has five legend tabs:

- **Status Legend** indicates the status of the associated detector(s).
- **Volume Legend** indicates the "volume-per-hour" threshold of the associated detector(s).
- **Speed Legend** indicates the "miles-per-hour" threshold of the associated detector(s).
- **Occupancy** legend indicates the "percent occupancy" of the associated detector(s).
- **V+kO** legend indicates the "V+kO" threshold of the associated detector(s).

When a tab is brought to the front to the front of the legend (by clicking on its tab), the detector controls change color to correspond to the criteria for the legend that is selected. Each of these legend tabs is described in more detail in the following sections.

### Table 6.4: Detector Legend Indications

<table>
<thead>
<tr>
<th>LEGEND TAB - INDICATION</th>
<th>STATE</th>
<th>COLOR</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>Online</td>
<td>Green</td>
</tr>
<tr>
<td></td>
<td>Offline</td>
<td>Blue</td>
</tr>
<tr>
<td></td>
<td>Failed Comm</td>
<td>Flashing Red</td>
</tr>
<tr>
<td></td>
<td>Failed</td>
<td>Red</td>
</tr>
<tr>
<td></td>
<td>Unknown</td>
<td>White</td>
</tr>
<tr>
<td>Volume</td>
<td>&gt;= threshold 1</td>
<td>Red</td>
</tr>
<tr>
<td></td>
<td>&gt;= threshold 2</td>
<td>Yellow</td>
</tr>
<tr>
<td></td>
<td>&gt;= threshold 3</td>
<td>Blue</td>
</tr>
<tr>
<td></td>
<td>&lt; threshold 4</td>
<td>Green</td>
</tr>
<tr>
<td>Speed</td>
<td>&lt;= threshold 1</td>
<td>Red</td>
</tr>
<tr>
<td></td>
<td>&lt;= threshold 2</td>
<td>Yellow</td>
</tr>
<tr>
<td></td>
<td>&lt;= threshold 3</td>
<td>Blue</td>
</tr>
<tr>
<td></td>
<td>&gt; threshold 4</td>
<td>Green</td>
</tr>
<tr>
<td>Occupancy</td>
<td>&gt;= threshold 1</td>
<td>Red</td>
</tr>
<tr>
<td></td>
<td>&gt;= threshold 2</td>
<td>Yellow</td>
</tr>
<tr>
<td></td>
<td>&gt;= threshold 3</td>
<td>Blue</td>
</tr>
<tr>
<td></td>
<td>&lt; threshold 4</td>
<td>Green</td>
</tr>
<tr>
<td>V+kO</td>
<td>&gt;= threshold 1</td>
<td>Red</td>
</tr>
<tr>
<td></td>
<td>&gt;= threshold 2</td>
<td>Yellow</td>
</tr>
<tr>
<td></td>
<td>&gt;= threshold 3</td>
<td>Blue</td>
</tr>
<tr>
<td></td>
<td>&lt; threshold 4</td>
<td>Green</td>
</tr>
</tbody>
</table>
6.9.2 Detector Legend Status Tab

The Status tab of the Detector Legend, shown in Exhibit 6.22, indicates the current operational status of the associated VOS detector(s).

Exhibit 6.22: Detector Status Legend

6.9.3 Detector Legend Volume, Speed, Occupancy, and V+kO Tabs

The Volume tab of the Detector Legend, shown in Exhibit 6.23, shows the threshold values that are used for detector indications based on volume.

Exhibit 6.23: Detector Volume Legend

The Volume, Speed, Occupancy, and V+kO tabs of the legend provide input fields in which the indication threshold values can be typed.

When Explorer is in Design mode, the Detector Legend control appears as a gray box with the words “Detector Legend” inside. Double-clicking the box makes it active. By clicking a legend tab while the Detector Legend control is active in Design mode, that legend configuration will be used each time the document is opened.

The Speed, Occupancy, and V+kO tabs are similar to the Volume tab.
6.9.4 Detector Status Text Controls

Detector Status Text controls display a particular aspect of the information collected from their associated VOS detectors. These aspects include the following:

- Status
- Volume (Average)
- Volume (Current)
- Speed (Average)
- Speed (Current)
- Occupancy (Average)
- Occupancy (Current)
- V+KO (Average)
- V+KO (Current)
- Device ID
- System Assignment
- K Constant
- Detector Class
- Detector Type
- Direction
- Averaging Period
- Lane Number
- Roadway Name

The Object Properties window for a Detector Text OLE control, shown in Exhibit 6.23 has five configuration tabs:

- The Entity and Object tabs are the same as those of the ATMS controls described previously.
- The Icon tab includes the Display Text, which is the information aspect that will be shown, ToolTip Text, which is the text displayed when the mouse pointer hovers over the icon, and the Rotation Angle for TrueType fonts. The text orientation is in degrees; 360 degrees centers the text.

The Fonts and Colors tabs enable control of the appearance of text.

Exhibit 6.24: Detector Text Control Properties Window

6.10 SECTION CONTROLS

IEN Section controls display the operational mode of their associated TCS Sections. The control can be drawn as either an ellipse or a rectangle shape, as shown in Exhibit 6.25.

Exhibit 6.25: IEN Section Controls
In Run mode, a Section control displays the dynamic data collected from its associated TCS Section. This data is shown by its indication color and ToolTip. The IEN Section Legend, which lists the mode indication colors, can be embedded within the Explorer document or be opened by right-clicking a Section control and then clicking Show Legend on the shortcut menu that appears.

More detailed information is available through the Section Detail window, which can be opened by double-clicking a particular section control or right-clicking the control and then clicking Monitor from the shortcut menu that appears.

6.11 SECTION LEGEND CONTROLS

Section Legend controls provide a mode indication legend for the IEN Section controls. The indication colors are shown in Exhibit 6.26.

Exhibit 6.26: IEN Section Legend

<table>
<thead>
<tr>
<th>Mode</th>
<th>SECTION SIGNAL CONTROL MODE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Free</td>
<td>Critical Int Ctrl</td>
</tr>
<tr>
<td>Fixed Time</td>
<td>Traffic Resp</td>
</tr>
<tr>
<td>Time Base</td>
<td>Adaptive</td>
</tr>
<tr>
<td>Actuated</td>
<td>Transition</td>
</tr>
<tr>
<td>Semi Actuated</td>
<td>Unknown</td>
</tr>
<tr>
<td>External</td>
<td></td>
</tr>
</tbody>
</table>

6.12 SECTION STATUS TEXT CONTROLS

Section Status Text controls display a particular aspect of the information collected from their associated TCS sections. These aspects include the following:

- Section ID
- Control Mode
- Timing Plan ID Number
- Device ID
- System Assignment

6.13 ATMS HYPERLINK CONTROLS

The hyperlink OLE control is a link to another Explorer document or a document from any other application. Hyperlinks can be used on an intersection drawing to link to documents for adjacent intersections. In this way, it is possible to travel a continuous section of roadway intersection by intersection.

The Object Properties window for a hyperlink control is shown in Exhibit 6.27.
Exhibit 6.27: Hyperlink Control Object Properties Window

On the General tab:

- The ToolTip text is typed in the Caption field. This text is displayed when the mouse pointer is over the hyperlink control.
- The Target field identifies the document or program to open when the hyperlink control is clicked (in Run mode).
- Clicking Browse enables a search for the target.
- The icon shape is selected in the Image area.
- In the Open Target In area, the user can specify whether the hyperlink document should open in the hyperlink's container (Containing Application), the current ATMS Explorer window (ATMS Explorer), or from the operating system shell (Windows Shell).

The Object tab is the same as that of the ATMS controls described previously.

For the Windows Shell, an additional command line argument can be specified in the Target field. For example, if the command line argument “is12345.xpl /size 400 300 /pos 0 0” is entered in the Target field, the control will open the document at the given size and screen position.
7. FOR THE ADVANCED EXPLORER USER

Some of Explorer’s overall functionality can be controlled by means other than the user interface or other methods. These functions and capabilities, although not obvious or essential, are useful to the experienced Explorer user.

7.1 DIFFERENT WAYS TO START EXPLORER

It is not required to start Explorer from a shortcut or the Windows Start → Run window. As with other applications, Explorer can be launched by double-clicking on the icon in “My Computer” or “Windows Explorer.” If the user double-clicks on the Xpl.exe icon, Explorer will start with no command line options. If the user double-clicks on an Explorer document icon, Explorer will start with the filename command line option, using the document the user clicked on as the filename.

7.2 COMMAND LINE OPTIONS FOR EXPLORER

Several command line options can be specified when Explorer is started. If Explorer is launched through the Windows Start → Run window or by a user-created Explorer shortcut, any of the options may be added to the command line. Some options can be combined; those that cannot are noted below. In general, except as noted, an option must be placed outside the quotation marks in the Windows Start → Run window or the “Target” field of the shortcut.

7.2.1 No Options

If Explorer is started with no options, Explorer will open in the Run mode. If a filename is not specified, Explorer will open the default document (see below).

7.2.2 Filename

If a document’s filename is added to the command line, Explorer will start with that document open. A complete filename is required, including the path, if it is different from Explorer’s. The filename must be placed outside the quotation marks in the Windows Start → Run window or the “Target” field of the shortcut. Explorer will search for the document using the PATH environment variable if a full pathname is not provided. Only one filename may be specified; any additional filenames will be ignored. Explorer will open the document in Run mode unless the Design mode is specified, as described below.

7.2.3 Design

The /design or /d option will force Explorer to open in the Design mode. If a filename is not specified, Explorer will create a new document.

7.2.4 Print Filename

The /print filename or /p filename option will cause the specified file to be printed to the default printer without starting Explorer. If the full path of the filename is different from Explorer’s, it must be specified.
7.2.5 **Fit to Window**

The `/fittowindow` option directs Explorer to start in the Stretch Document to Fit Window mode (Section 4.3). The `/fittowindow` and `/nofittowindow` options should not be specified together.

7.2.6 **Nofit to Window**

The `/nofittowindow` option directs Explorer to start without Stretch Document to Fit Window turned on (Section 4.3). The `/fittowindow` and `/nofittowindow` options should not be specified together.

7.2.7 **Fit to Document**

The `/fittodocument` option directs Explorer to start in the Match Window Size to Document Size mode (Section 4.3). The `/fittowindow` and `/nofittowindow` options should not be specified together.

7.2.8 **Nofit to Document**

The `/nofittodocument` option directs Explorer to start without the Match Window Size to Document Size mode turned on (Section 4.3). The `/fittodocument` and `/nofittodocument` options should not be specified together.

7.2.9 **Size**

The initial size of an Explorer window can be specified by the `/size` option. The desired width and height of the window (in pixels) is specified by placing the numeric values for the width and height after `/size`. For example, the option `/size 400 300` will open Explorer with a window 400 pixels wide and 300 pixels high.

7.3 **COMMAND LINE OPTIONS FOR MONITORING WINDOWS**

The monitoring windows for an intersection, detector, or section can be opened from an Explorer document, a desktop shortcut, or from a command line. In addition, these windows can be opened by double clicking on the icon in “My Computer” or “Windows Explorer.” If the user double-clicks on the IENIntMntr, DetectorMonitor, or IENSectiOnMntr icons, a monitoring window will open with no specified entity to monitor. An entity can then be selected by using the Entity option on the Edit menu. If the monitoring window is started from a command line, at least one of the options discussed below should be specified.

7.3.1 **Universal Identifier**

The addition of the `-uXXXXX` option to the command line, where `XXXXX` is theUid for the entity to be monitored, causes the monitoring window to open for that entity.

7.3.2 **Area Computer and Logical Number**

A monitoring window will open for an entity defined by the addition of the `-aX` and `-lYYY` command line options, where `X` is the area computer number and `YYY` is the logical number for the entity. An entity is defined by the combination of the area computer number and the logical number; therefore, both options must be specified.
7.4 GENERATION OF BASELINE INTERSECTION DIAGRAMS

Baseline ATMS Explorer intersection diagrams can be bulk-created using an automation script and a specially formatted properties file. The script named GenerateIENXpl.vbs uses TransSuite ATMS Explorer's automation interface to create new diagrams based on the parameters specified in an input file. The script can position controls on north, south, east, or west approaches to the intersection. Other directions are not supported. Explorer can import a static background image into a diagram; however, users will need to manually reposition controls over the background image.

GenerateIENXpl relies on the following:

- IENXplLib.vbs: A supporting script that contains a library of VBScript functions for working with ActiveX control objects.
- Input file: Specifies the configuration of each diagram to be created.
- A connection to the IEN Corridor Server Database

7.4.1 GenerateIENXpl.vbs Usage

GenerateIENXpl.vbs can be launched from the command line. The command syntax is as follows:

```
Cscript GenerateIENXpl.vbs [OUTPUT_PATH] [INPUT_FILE] [DSN] [DB_USER] [DB_PW]
```

<table>
<thead>
<tr>
<th>ARGUMENT</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>[OUTPUT_PATH]</td>
<td>Output location for the created diagrams.</td>
</tr>
<tr>
<td>[DSN]</td>
<td>ODBC Data Source Name of a connection to the IEN Corridor Database.</td>
</tr>
<tr>
<td>[DB_USER]</td>
<td>IEN Corridor Database user login name.</td>
</tr>
<tr>
<td>[DB_PW]</td>
<td>The password associated with the user login name.</td>
</tr>
</tbody>
</table>

Example:

```
CScript GenerateIENXpl.vbs "C:\Program Files\TransCore\GeneratedXplDocuments" input.txt IEN_DB dbguest dbguest
```

7.4.2 Input File Format:

The Input File specifies the configuration of the diagrams to be created. Each line contains the parameters of a diagram definition.

The diagram definition syntax is as follows:

```
[CorNum], [SiteNum], [SysNum], [IntNum], [PedInd(Dir|PedMvmt|ConfVehMvmt)],
[GreenArrow(Dir|LfGrn|LfConf|StrgtGrn|StrgtConf|RgtGrn|RgtConf)],
[VehCall(Dir|CallPhz)], [DetCtrl(Dir|DetNum)], [SecNum], [background]
```

Diagram definition parameters are described below:
### Table 7.2: Diagrams Definition Parameters

<table>
<thead>
<tr>
<th>PARAMETER</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>[CorNum]</td>
<td>ID number of the IEN Corridor in which the intersection is located.</td>
</tr>
<tr>
<td>[SiteNum]</td>
<td>ID number of the Site in which the intersection is located.</td>
</tr>
<tr>
<td>[SysNum]</td>
<td>ID number of the System in which the intersection is located.</td>
</tr>
<tr>
<td>[IntNum]</td>
<td>Intersection ID number.</td>
</tr>
</tbody>
</table>
| [PedInd(Dir|PedMvmt|ConfVehMvmt)]       | A series of Pedestrian Control definitions. Each Pedestrian Control definition consists of the following parameters:  
1. [Dir]: 0-3. Direction to the intersection from the approach on which the control is to be located (0=E, 1=W, 2=S, 3=N).  
2. [PedMvmt]: The walk phase(s) for the Pedestrian Control.  
3. [ConfVehMvmt]: The conflicting vehicle phase(s) for the Pedestrian Control.  
Example: 0|1|2|6;1|2|6;2|4|8;3|2|4|8  
Delimiter Rules:  
4. Definition parameters are separated by the "|" delimiter.  
5. Multiple phases are separated by the "_" delimiter.  
6. Control definitions are separated by the ";" delimiter. |
| [GreenArrow(dir|LfGrn|LfConf|StrgtGrn|StrgtConf|RgtGrn|RgtConf)] | A series of Green Arrow Control definitions. Each Green Arrow Control definition consists of the following parameters:  
7. [Dir]: 0-3. Direction to the intersection from the approach on which the control is to be located (0=E, 1=W, 2=S, 3=N).  
8. [LfGrn]: The green phase(s) for the left-turn movement.  
9. [LfConf]: The conflicting phase(s) for the left-turn movement.  
10. [StrgtGrn]: The green phase(s) for the straight movement.  
11. [StrgtConf]: Conflicting phase(s) for straight movement.  
12. [RgtGrn]: The green phase(s) for the right-turn movement.  
13. [RgtConf]: The conflicting phase(s) for the right-turn movement.  
Example: 0|5|6|2|1|7|2|0|1|0|0|2|4|0|0|2|0|0|2|4|0|0|0|3|0|0|2|4|0|0|0  
Delimiter Rules:  
14. Definition parameters are separated by the "|" delimiter.  
15. Multiple phases are separated by the "_" delimiter.  
16. Control definitions are separated by the ";" delimiter. |
<table>
<thead>
<tr>
<th>PARAMETER</th>
<th>DESCRIPTION</th>
</tr>
</thead>
</table>
| [VehCall(Dir|CallPhz)]     | A series of Vehicle Call Control definitions. Each Vehicle Call Control definition consists of the following parameters:  
17. [Dir]: 0-3. Direction to the intersection from the approach on which the control is to be located (0=E,1=W,2=S,3=N).  
18. [CallPhz]: The call phase(s) for which the control will indicate "presence detected".  
Example: 0|5;1|1;2|7;3|3  
Delimiter Rules:  
19. Definition parameters are separated by the "|" delimiter.  
20. Multiple phases are separated by the "_" delimiter.  
21. Control definitions are separated by the ";" delimiter.                                                                 |
| [DetCtrl(Dir|DetNum)]     | A series of System Detector Control definitions. Each System Detector Control definition consists of the following parameters:  
22. [Dir]: 0-3. Direction to the intersection from the approach on which the control is to be located (0=E,1=W,2=S,3=N).  
23. [DetNum]: Detector ID number.  
Example: 0|5;1|1;2|7;3|3  
Delimiter Rules:  
24. Definition parameters are separated by the "|" delimiter.  
25. Control definitions are separated by the ";" delimiter.                                                                 |
| [SecNum]                  | ID number of the Section in which the intersection is located.                                                                                                                                               |
| [Background]              | The name of the graphics file to be used as the diagram’s static background. ATMS Explorer supports the Bitmap, Device-Independent Bitmap, Extended Metafile, and Windows Metafile formats. This field may be left empty if no graphics file is available. Several generic 4-way and 3-way intersection backgrounds are included with the IEN Workstation software. |
APPENDIX A - INDEX

Align objects, 4-15
Aligning objects, 4-20, 5-3
Application properties, 4-12, 5-2
applications, 4-1, 4-18
Aspect ratio, 3-1
ATMS Explorer, 4-18, 5-3
Background
  color, 4-2, 4-12, 5-2
  importing, 4-2
Change Mode, 5-7
Change Plan, 5-7
Configure Colors, 6-13
Controls
  converting, 4-8
  green indication OLE, 6-19
  inserting, 3-3, 4-6
  intersection OLE, 6-11
  intersection text OLE, 6-15, 6-27
  moving, 4-7
  pedestrian indication OLE, 6-21
  properties, 4-8
  rotating, 4-8
  section text OLE, 6-29
  sensor OLE, 6-23, 6-24
  sizing, 4-7
Converting a control, 4-8
Converting an object, 4-8
Copy, 4-5, 4-20
Creating a document, 3-1
  drawing tablet, 3-2
  freehand, 3-2
  region of interest, 3-1
  templates, 3-2
Cut, 4-5, 4-20
Delete, 4-5
Design mode, 4-8, 7-1
dialog boxes, 4-1, 4-16, 4-18, 5-3
Document
  properties, 4-12, 5-2
Double-buffered display, 4-12
Dynamic components
  inserting, 3-3
Edit menu, 4-4
Editing an object, 4-8
Exiting ATMS Explorer, 4-4
File Menu, 4-1
Fit to window, 7-2
Flash On, 5-8
Fonts, 4-2, 4-12
Foreground
  color, 4-2, 4-12
Formatted text, 1-1
GenerateIENXpl.vbs, 7-3
  CommandSyntax, 7-3
  Dependencies, 7-3
  Input File, 7-3
Generating baseline Intersection diagrams, 7-3
Green indication OLE control, 6-19
Grid, 4-9, 4-10, 4-12, 4-13, 4-16, 5-2
Help Menu, 4-18
Import background, 4-2
incidents, 1-1
Intersection Cycle Legend, 6-15
Intersection Details Window, 5-5
Intersection OLE control, 6-11
Intersection text OLE control, 6-15, 6-27
Layers, 3-2
Layout Menu, 4-14
Links, 4-8
Match window size to document, 4-9
Match Window Size to Document Size, 4-12
Menu bar, 4-1
Menus
  file pulldown, 4-1
Message window, 4-10
Monitoring window, 5-5
Moving objects, 4-15, 4-21
Object properties, 4-5, 5-3, 6-11
Objects
  aligning, 4-15, 4-20, 5-3
  converting, 4-8
  copying, 4-5, 4-20
  creating, 4-7
  editing, 4-8
  inserting, 4-7
  linking, 4-8
  moving, 4-15, 4-21
  sizing, 4-15, 4-20, 5-3
Open a file, 4-2
Paste, 4-5, 4-20
Paste special, 4-5
Pedestrian indication OLE control, 6-21
Print
  file, 4-3, 4-20, 7-1
  preview, 4-3
  setup, 4-3
Print document properties, 4-3
Print message window, 4-10
Procedures, 4-18
Properties
  application, 4-12, 5-2
  document, 4-12, 5-2
  object, 4-5, 5-3, 6-11
  print document, 4-3
Redo, 4-5, 4-19
Refresh, 4-11
Release IEN Control, 5-8
Run mode, 4-9, 7-1
Save a file, 4-2
Script Menu, 4-16
Scrolling, 2-2
section text OLE control, 6-29
Select All, 4-5
Sensor OLE control, 6-23, 6-24
Show Main Street Direction, 6-13
Show MSG, 6-13
Show object outlines, 4-10, 4-12
Sizing objects, 4-15, 4-20, 5-3
Space evenly across, 4-15, 4-20
Space evenly down, 4-15, 4-20
Starting Monitoring Windows, 7-2
Static components
  templates, 3-2

Status bar, 4-11, 4-21
Stretch document to fit window, 4-9, 5-2
Stretch Document to Fit Window, 4-12
Template, 3-2, 4-2
Toolbar
  design, 4-11, 4-20, 4-21
  main, 4-11
  standard, 4-19
Undo, 4-5, 4-19
View Menu, 4-9
# TABLE OF CONTENTS

<table>
<thead>
<tr>
<th>Section</th>
<th>Page #</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. INTRODUCTION</td>
<td>1-1</td>
</tr>
<tr>
<td>1.1 Purpose</td>
<td>1-1</td>
</tr>
<tr>
<td>1.2 Audience</td>
<td>1-1</td>
</tr>
<tr>
<td>1.3 Background</td>
<td>1-1</td>
</tr>
<tr>
<td>1.4 Privileges</td>
<td>1-1</td>
</tr>
<tr>
<td>1.5 Document Conventions</td>
<td>1-1</td>
</tr>
<tr>
<td>2. OVERVIEW</td>
<td>2-1</td>
</tr>
<tr>
<td>2.1 Starting IMS</td>
<td>2-1</td>
</tr>
<tr>
<td>2.2 Screen Areas</td>
<td>2-1</td>
</tr>
<tr>
<td>2.3 IMS Characteristics</td>
<td>2-1</td>
</tr>
<tr>
<td>2.4 Exiting IMS</td>
<td>2-2</td>
</tr>
<tr>
<td>3. MENU BAR</td>
<td>3-1</td>
</tr>
<tr>
<td>3.1 System Menu</td>
<td>3-1</td>
</tr>
<tr>
<td>3.2 Incident Menu</td>
<td>3-1</td>
</tr>
<tr>
<td>3.2.1 New</td>
<td>3-2</td>
</tr>
<tr>
<td>3.2.2 Acknowledge</td>
<td>3-4</td>
</tr>
<tr>
<td>3.2.3 Confirm</td>
<td>3-4</td>
</tr>
<tr>
<td>3.2.4 Clear</td>
<td>3-4</td>
</tr>
<tr>
<td>3.2.5 ReOpen</td>
<td>3-5</td>
</tr>
<tr>
<td>3.2.6 Update Incident</td>
<td>3-5</td>
</tr>
<tr>
<td>3.2.7 Cancel Update</td>
<td>3-5</td>
</tr>
<tr>
<td>3.2.8 New Notification</td>
<td>3-5</td>
</tr>
<tr>
<td>3.2.9 New Note</td>
<td>3-7</td>
</tr>
<tr>
<td>3.2.10 New Response</td>
<td>3-8</td>
</tr>
<tr>
<td>3.2.11 New Device Association</td>
<td>3-9</td>
</tr>
<tr>
<td>3.2.12 Edit</td>
<td>3-10</td>
</tr>
<tr>
<td>3.2.13 Broadcast</td>
<td>3-10</td>
</tr>
<tr>
<td>3.2.14 Take Control</td>
<td>3-11</td>
</tr>
<tr>
<td>3.2.15 Print</td>
<td>3-11</td>
</tr>
<tr>
<td>3.3 Planned Event Menu</td>
<td>3-11</td>
</tr>
<tr>
<td>3.3.1 New</td>
<td>3-11</td>
</tr>
<tr>
<td>3.3.2 Update</td>
<td>3-13</td>
</tr>
<tr>
<td>3.3.3 New Notification</td>
<td>3-13</td>
</tr>
<tr>
<td>3.3.4 New Note</td>
<td>3-15</td>
</tr>
<tr>
<td>3.3.5 New Response</td>
<td>3-16</td>
</tr>
<tr>
<td>3.3.6 New Device Association</td>
<td>3-17</td>
</tr>
<tr>
<td>3.3.7 Edit</td>
<td>3-18</td>
</tr>
<tr>
<td>3.3.8 Broadcast</td>
<td>3-19</td>
</tr>
<tr>
<td>3.3.9 Print</td>
<td>3-19</td>
</tr>
<tr>
<td>3.4 View Menu</td>
<td>3-19</td>
</tr>
<tr>
<td>3.5 Tools Menu</td>
<td>3-21</td>
</tr>
<tr>
<td>3.6 Help Menu</td>
<td>3-21</td>
</tr>
</tbody>
</table>
4. TOOLBAR.................................................................................................................................................4-1
5. SHORTCUT MENUS.....................................................................................................................................5-1
6. INCIDENT AND PLANNED EVENT LISTS ..............................................................................................6-1
   6.1 Incident Information .................................................................................................................................6-1
   6.2 Sorting Incidents .......................................................................................................................................6-1
   6.3 Acknowledging an Incident .......................................................................................................................6-1
   6.4 Clearing an Incident .................................................................................................................................6-1
7. DETAILS PANE ..............................................................................................................................................7-1
   7.1 Details Tab .................................................................................................................................................7-1
   7.2 Actions Tab ..............................................................................................................................................7-2
   7.3 Update Log Tab .......................................................................................................................................7-3
   7.4 Clearing an Incident .................................................................................................................................7-3
8. MANAGING SCENARIO ASSOCIATIONS .................................................................................................8-1
   8.1 Associating an incident or planned event with a scenario .................................................................8-1
   8.2 Releasing an associated scenario .............................................................................................................8-2
   8.3 Viewing detailed scenario information .....................................................................................................8-2
APPENDIX A - INDEX......................................................................................................................................A-1
LIST OF EXHIBITS

Exhibit 2.1: IMS User Interface ................................................................. 2-2
Exhibit 3.1: System Menu Commands ....................................................... 3-1
Exhibit 3.2: Incident Menu Commands ...................................................... 3-1
Exhibit 3.3: Add Incident Window .......................................................... 3-2
Exhibit 3.4: NOTE Command Buttons ....................................................... 3-2
Exhibit 3.5: Lanes Affected Window ......................................................... 3-3
Exhibit 3.6: On Site Window .................................................................... 3-3
Exhibit 3.7: Clear Incident Window ........................................................ 3-5
Exhibit 3.8: Add Incident Notification Window ......................................... 3-6
Exhibit 3.9: Add Incident Note Window .................................................. 3-7
Exhibit 3.10: Add Incident Response Window ......................................... 3-8
Exhibit 3.11: Manage Entity Associations Window ................................. 3-9
Exhibit 3.12: Edit Association Window .................................................... 3-10
Exhibit 3.13: Planned Event Menu Commands ....................................... 3-11
Exhibit 3.14: Add Planned Event .............................................................. 3-11
Exhibit 3.15: Add Planned Event Notification Window ........................... 3-13
Exhibit 3.16: Add Planned Event Note Window ........................................ 3-15
Exhibit 3.17: Add Planned Event Response Window ............................... 3-16
Exhibit 3.18: Manage Entity Associations Window ................................. 3-18
Exhibit 3.19: Edit Device Association Window ........................................ 3-18
Exhibit 3.20: View Menu Commands ...................................................... 3-20
Exhibit 3.21: Filter List Window ............................................................... 3-20
Exhibit 4.1: IMS Toolbar ........................................................................ 4-1
Exhibit 6.1: IMS Incident or Planned Event List ..................................... 6-1
Exhibit 6.2: Clear Incident Window ........................................................ 6-2
Exhibit 7.1: Incident Details Tab of the Details Pane ............................... 7-1
Exhibit 7.2: Planned Event Details Tab of the Details Pane .................. 7-2
Exhibit 7.3: Actions Tab of the Details Pane .......................................... 7-2
Exhibit 7.4: Update Log Tab ................................................................. 7-3
Exhibit 8.1: Manage Entity Associations Window ................................ 8-1
Exhibit 8.2: Edit Association Window .................................................... 8-2
## DOCUMENT REVISION HISTORY

<table>
<thead>
<tr>
<th>VERSION</th>
<th>DATE</th>
<th>DESCRIPTION</th>
<th>REVIEWED BY</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>6/1/04</td>
<td>Initial Release of Document after conversion from MICE manual</td>
<td>Michael Bayer</td>
</tr>
<tr>
<td>2.0</td>
<td>3/30/06</td>
<td>COTS Migration updates</td>
<td>Jack Schneider</td>
</tr>
<tr>
<td>Final</td>
<td>4/2/07</td>
<td>Updated for IEN Software Version 1.09</td>
<td>Kevin Leamon</td>
</tr>
<tr>
<td>Final, Revision 1</td>
<td>9/20/11</td>
<td>Updated for IEN Multiple Corridor Server Project (IEN Software Version 2.02)</td>
<td>Chuck Dankocsik</td>
</tr>
<tr>
<td>Version 2.4.1</td>
<td>4/20/12</td>
<td>Updated for Freeway interface &amp; Outbound interface projects (IEN Software Version 2.4.1)</td>
<td>Chuck Dankocsik</td>
</tr>
</tbody>
</table>
1. INTRODUCTION

1.1 PURPOSE
The TransSuite Incident Management System (IMS) User’s Guide describes how to create, view, acknowledge, update, and clear incidents and planned events.

1.2 AUDIENCE
This document is intended for operators who manage incidents and planned events and supervisors who approve operator actions.

1.3 BACKGROUND
IMS is an incident tracking system that employs an off-the-shelf map database for the map interface and a commercial database for generating reports. IMS makes it possible to track incidents and planned events from start to finish by collecting the following information:

- Who reported the incident
- When the incident was reported
- Where the incident is located
- What the incident type is
- Who should be notified
- Who has been notified
- What units responded to the incident
- When the responding units arrived
- What actions have been taken
- What devices are associated with an incident or planned event
- When the incident was closed

1.4 PRIVILEGES
Users must hold specific privileges in order to perform certain operations within IMS such as clearing or acknowledging incidents. These privileges are configured using the TransSuite Privilege Configuration Utility. See the IEN Administrators Guide for more information.

1.5 DOCUMENT CONVENTIONS
There are locations in this document where formatted text is used, as illustrated below.

<table>
<thead>
<tr>
<th>C:&gt; edit readme.txt</th>
<th>A monospace font is used to show displayed prompts and typed commands. The bold text is text that should be typed.</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;TAB&gt;</td>
<td>Text enclosed in brackets indicates keystrokes.</td>
</tr>
<tr>
<td>&lt;SHIFT&gt;+&lt;F1&gt;</td>
<td>A plus sign indicates that two keys are to be pressed simultaneously; the first key is held down while the second key is pressed.</td>
</tr>
<tr>
<td>File</td>
<td>Bold formatting represents a button or menu such as the File menu or the OK button.</td>
</tr>
</tbody>
</table>
2. OVERVIEW

2.1 STARTING IMS

The TransSuite Incident Management System is started by double-clicking the TransSuite IMS icon on the desktop or by selecting the shortcut from the Windows Start menu (START > ALL PROGRAMS > LOS ANGELES COUNTY IEN > INCIDENT MANAGEMENT SYSTEM).

2.2 SCREEN AREAS

The IMS user interface main window, shown in Exhibit 2.1, includes five main areas:

- Status bar (Section 2.3)
- Menu bar (Section 3)
- Toolbar (Section 4)
- Incident and planned event list area (Section 6)
- Incident and planned event details area (Section 7)

The main window is divided into two panes. The top pane, referred to as the list pane, shows several tabs, each containing a list. The bottom pane is referred to as the details pane. Its layout and contents change depending on which tab is selected in the list pane.

The list and details panes can be sized vertically by clicking and dragging the bar separating the two panes; the size of the other areas cannot be modified.

The Details Pane command on the View menu can be used to expand or contract the main window to display both the details pane and the list pane or the list pane by itself.

The IMS user interface main window provides the following:

- A list of active and cleared incidents
- A list of planned events configured in the ATMS system
- Menu and toolbar access to IMS commands
- Visual feedback on the known state of the active incidents

2.3 IMS CHARACTERISTICS

The IMS list and details panes look like notebooks. Each notebook has tabs along the top; single-clicking a tab displays the contents of that tabbed page of the notebook.

The Details tab for an incident or planned event shows all of the current information about that incident or event. Text is shown in red if it has been changed recently and has not yet been reviewed or acknowledged. All changes and acknowledgements to incidents are logged on the Update Log tab. The log entries identify the operator who made the change, the date and time of the change, and what was updated. The Actions tab includes all responses, notifications, notes, and device associations entered for an incident or planned event.

When information is presented in a list, the list can be opened by clicking the arrow next to the box and then typing or selecting the desired list item. New entries cannot be added to the list.
The buttons on the toolbars (Section 4) have floating help. As the mouse pointer is moved over the toolbar buttons, floating help provides a one or two word description of the button function; more descriptive tool help text appears on the status bar. Menu command descriptions also appear on the status bar. The status bar includes the following information:

- Copyright information or current activity, such as refreshing data
- Time of last update
- Number of items in the list
- Any filters applied
- Acknowledgement indication: an incident icon if an incident awaits acknowledgement
- Automatic refresh indicator: green if refreshing, yellow if not

### 2.4 EXITING IMS

Clicking **Exit** on the System menu or typing `<ALT>十+F4>` exits the IMS user interface.
3. MENU BAR

The menu bar contains five menus:

- **System** menu
- **Incident** or **Planned Event** menu
- **View** menu
- **Tools** menu
- **Help** menu

The name of the menu to the right of the **System** menu changes to match the type of list below it. Many menu commands are duplicated on the toolbar.

### 3.1 SYSTEM MENU

The **System** menu contains one command, as shown in Exhibit 3.1. Clicking **Exit** closes the IMS window.

<table>
<thead>
<tr>
<th>MENU COMMAND</th>
<th>SHORTCUT</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exit</td>
<td></td>
<td>Exits the program</td>
</tr>
</tbody>
</table>

### 3.2 INCIDENT MENU

The **Incident** menu, shown in Exhibit 3.2, contains commands to create a new incident record or to take action on an existing incident. These commands are also available on the toolbar (Section 4).

The **Acknowledge**, **Confirm**, **Clear**, and **ReOpen** menu commands are available only if an applicable incident is selected in the incident list. **Acknowledge** is available only for incidents awaiting acknowledgement. **Confirm** is available only for incidents not already confirmed. **Clear** is available only for open incidents. **Reopen** is available only for cleared incidents.

<table>
<thead>
<tr>
<th>MENU COMMAND</th>
<th>SHORTCUT</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>&lt;F4&gt;</td>
<td>Opens the Add Incident window</td>
</tr>
<tr>
<td>Acknowledge</td>
<td></td>
<td>Removes updated field highlighting and cleared incidents from the active display.</td>
</tr>
<tr>
<td>Confirm</td>
<td></td>
<td>Opens the Confirm Incident window</td>
</tr>
<tr>
<td>Clear</td>
<td></td>
<td>Opens the Clear Incident window</td>
</tr>
<tr>
<td>ReOpen</td>
<td></td>
<td>Reactivates a cleared incident</td>
</tr>
<tr>
<td>Update</td>
<td>&lt;ENTER&gt;</td>
<td>Saves incident updates to the database</td>
</tr>
<tr>
<td>Cancel Update</td>
<td>&lt;ESCAPE&gt;</td>
<td>Discards incident updates and restores the incident information from the database</td>
</tr>
<tr>
<td>MENU COMMAND</td>
<td>SHORTCUT</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>----------------------</td>
<td>----------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>New Notification</td>
<td>&lt;F6&gt;</td>
<td>Opens the Add Incident Notification window</td>
</tr>
<tr>
<td>New Note</td>
<td>&lt;F7&gt;</td>
<td>Opens the Add Incident Note window</td>
</tr>
<tr>
<td>New Response</td>
<td>&lt;F8&gt;</td>
<td>Opens the Add Incident Response window</td>
</tr>
<tr>
<td>New Device Association</td>
<td>&lt;F9&gt;</td>
<td>Opens the Manage Entity Associations window</td>
</tr>
<tr>
<td>Edit</td>
<td>&lt;F10&gt;</td>
<td>Opens the corresponding action window (Notification, Note, Response) with the selected action</td>
</tr>
<tr>
<td>Broadcast</td>
<td></td>
<td>Marks the incident for transmittal to external systems</td>
</tr>
<tr>
<td>Take Control</td>
<td></td>
<td>Places an externally generated incident under the control of IMS</td>
</tr>
<tr>
<td>Print</td>
<td></td>
<td>Prints the selected incident</td>
</tr>
</tbody>
</table>

### 3.2.1 New

New opens the Add Incident window, shown in Exhibit 3.3.

**Exhibit 3.3: Add Incident Window**

- In the NOTE area, the user can click the corresponding command button to indicate injuries, hazardous materials, fire, or a fatality (Exhibit 3.4).

**Exhibit 3.4: NOTE Command Buttons**
- Under **Incident Started**, the beginning date and time of the incident can be typed or selected. The initial values are the current date and time. The arrow to the right of the **Date** value can be clicked to open a calendar from which the date can be selected. The small arrows next to the **Time** value can be clicked to change the value. For both **Date** and **Time**, the arrow keys can be used to change the values.

- Under **Reported By**, the reporting Source can be selected from the list. Optionally, a person’s name can be typed in the **Contact** field.

- Under **Injuries Involved**, the specific number of injuries, the number of pedestrians involved, and the number of fatalities can be selected.

- A type of incident can be selected from a list in the **Description** area. The **Severity**, **Impact**, and **Duration** of the incident are selected from lists.

- The **Vehicles Involved** area enables the selection of the specific number of different types of vehicles that are involved in the incident.

- The **Location** area is used to define where the incident occurred. This information determines where the incident icon is displayed on the map. Values must be selected for **Cnty** (county), **Dir** (direction), **Main** street, and **Type**. The intersection of the **Main** street and the **Cross** street is verified. If specified, the address (**Addr**) determines the incident location on the ATMS map; otherwise, the intersection is used to determine the incident location. An address that cannot be located on the map may be supplied; however, a message appears stating that the location cannot be geocoded, and that incident will not appear be displayed on the ATMS map. In addition, in the incident list, the incident’s icon will have a red slash through it. A second cross-street value can be specified when the incident is between two streets. Additional incident information can be typed in the **More** field.

- In the **Lanes Affected** area, clicking the button opens the window shown in Exhibit 3.5, enabling the selection of the affected lanes. Clicking the **OK** button saves the selections; clicking the **Cancel button** closes the window and discards any changes.

  **Exhibit 3.5: Lanes Affected Window**

- In the **On Site** area, clicking the button opens the window shown in Exhibit 3.6. Clicking the checkbox next to the agency and responder names designates them as being at the incident site. Clicking the **OK** button saves the selections; clicking the **Cancel** button closes the window and discards any changes.

  **Exhibit 3.6: On Site Window**

- Under **Remarks**, additional incident information can be typed.
Clicking **Add** establishes the new incident; clicking **Cancel** closes the window adding the new incident.

### 3.2.2 Acknowledge

**Acknowledge** opens a window that contains the ID of the incident. Clicking **Yes** acknowledges the incident; clicking **No** closes the window without acknowledging the incident.

### 3.2.3 Confirm

**Confirm** opens a window that contains the ID of the incident. Clicking **Yes** confirms the incident; clicking **No** closes the window without confirming the incident.

### 3.2.4 Clear

**Clear** opens the **Clear Incident** window, shown in Exhibit 3.7:

- In the **Cleared By** area, the name of the person who cleared the incident (**Contact**) can be typed but is not required.
- The corresponding department/agency (**Source**) of the **Contact** can be selected from a list.
- The incident clearing status can be selected from the **Clearing Status** list:
  - “Cleared”: the incident is cleared and is no longer affecting traffic
  - “Duplicate”: the incident record is a duplicate
  - “Invalid”: the recorded incident is not actually an incident.
- Under **Date/Time Cleared**, the date and time values indicate when the incident was cleared; the initial values are the current date and time. The date and time can be changed using the techniques described in Section 3.2.1.
- The top portion of the window, under **Associated Devices**, lists the devices that are still associated with the incident. An incident can be cleared even though device associations remain, but it is recommended that the device associations be removed prior to clearing the incident.

Clicking **OK** marks the incident as cleared; clicking **Cancel** closes the window without clearing the incident.
3.2.5 ReOpen

When the incident list displays Cleared Incidents (Section 2.3), a cleared incident can be reopened by selecting the incident in the list and then clicking ReOpen on the Incident menu. A window is displayed with the ID of the incident, requesting confirmation that the incident should be reopened. Clicking Yes reopens the incident; clicking No closes the message window without reopening the incident. Reopening an incident removes the incident from the Cleared Incidents list and adds it to the Active Incidents list.

3.2.6 Update Incident

The Update command is unavailable unless a modification has been made to the incident details. Clicking Update saves any changes that have been made to the incident.

3.2.7 Cancel Update

If Cancel Update is clicked before changes are saved, any changes to the incident are discarded, restoring the incident to its original state.

3.2.8 New Notification

New Notification opens the Add Incident Notification window, shown in Exhibit 3.8:

- Information under the Identification area is generated automatically. Incident is the ID of the incident with which the notification is associated. Operator is the username of the user currently logged in. Date and Time display the current date and time.

- Under Person Notified, the person who has been notified can be selected from the list. Alternatively, the person’s number may be typed. The contact’s phone number or email address is automatically entered in the Number field. In the Given To field, the name of the person to whom the message was given in the absence of the primary contact can be typed or selected.
- In the **Responded** area, the **Date** and **Time** that the person responded can be selected. The current date and time is used if **Now** is clicked. The date and time can be changed using the methods described in Section 3.2.1. The time will probably be updated after the notification is created because the person notified may not respond immediately.

- The **Instructions** area is used to type instructions received from the notified person. Under **Internal Remarks**, additional information concerning the notification can be typed.

Incident notifications are added to the **Actions** tab of the incident details pane.

Clicking Add saves the new notification information; clicking Cancel closes the window, without adding the new notification information.

**Exhibit 3.8: Add Incident Notification Window**
3.2.9 New Note

New Note opens the Add Incident Note window, shown in Exhibit 3.9:

- Information under the Identification area is generated automatically. Incident is the ID of the incident with which the action is associated. Operator is the username of the user currently logged in. Date and Time display the current date and time but can be changed using the methods described in Section 3.2.1.
- Additional information about the incident can be typed in the Note and Internal Remarks areas.

Incident notes are added to the Actions tab of the incident details pane.

Clicking Add saves the new incident note information; clicking Cancel closes the window, discarding any new incident note information.

Exhibit 3.9: Add Incident Note Window
3.2.10 New Response

New Response opens the Add Incident Response window shown in Exhibit 3.10.

Exhibit 3.10: Add Incident Response Window

- Information under the Identification area is generated automatically. Incident is the ID of the incident with which the response is associated. Operator is the username of the user currently logged in. Date and Time display the current date and time but can be changed using the methods described in Section 3.2.1.

- Under Description, the responding unit can be selected from the Unit list. Optionally, a description of the unit can be typed in the Description field.

- Instructions given to the responding unit can be typed under Instructions.

- Under ETA, the estimated date and time of the arrival of the responding unit is entered. The initial values are the current date and time.

- The actual date and time of arrival is entered under ATA. This is usually done when the incident response record is being updated rather than when the record is first being established. Clicking Now sets the date and time values to the current date and time.

- Under ETC, the estimated date and time of completion of the response is entered. The initial values are the current date and time.

- The actual date and time of completion is entered under ATC. This is usually done when the incident response record is being updated rather than when the record is first being established. Clicking Now sets the date and time values to the current date and time.
The dates and times under the ETA, ATA, ETC, and ATC areas can be changed using the methods described in Section 3.2.12.

Incident responses are added to the Actions tab of the incident details pane. Clicking Add saves the new response information; clicking Cancel closes the window without saving any of the information.

3.2.11 New Device Association

New Device Association opens the Manage Entity Associations window shown in Exhibit 3.11. The identification of the selected incident is shown in the title bar of the window. Entity associations are added to the Actions tab of the incident details pane. Although multiple associations can be created, each appears as an individual entry on the Actions tab.

Incidents can be associated with different types of entities including message signs, scenario response plans, and other incidents.

Exhibit 3.11: Manage Entity Associations Window

- An entity type is selected from the list at the top of the window. One or more instances of the resulting list of incidents or planned events are selected. The association is completed by clicking the down arrow button below the incident list.
- In the Current/Pending Associations list, the associations already in effect are shown. This list includes any associations that have just been added. Associations can be removed or canceled by selecting one or more instances in the list and then clicking the MINUS SIGN (-) button.
- The New Association Information area records information when an association is created. The Timestamp indicates when the entity was associated with the incident or planned event. Additional information about the association can be typed in the Notes field. This information is shown in the Action Taken field on the Action Tab (See Section 7.2).
Clicking **OK** adds the entity associations to the database; clicking **Cancel** discards any changes and closes the window.

### 3.2.12 Edit

**Edit** is available when a note, notification, response, or device association has been selected. These items are on the **Actions** tab of the incident details pane. Clicking **Edit** opens an update window for the notification, note, or response. These windows look and behave as documented earlier for adding new records. Clicking **Update** saves any changes made; clicking **Cancel** discards any changes and closes the window.

When a device association is selected and **Edit** is clicked, the **Edit Association** window shown in Exhibit 3.12 is opened:

**Exhibit 3.12: Edit Association Window**

- Identification information is generated automatically. The **by** value is the username of the operator editing the device association. The **at** value is the date and time when the devices were associated with the incident.
- Additional information about the device or incident can be typed in the **Notes** field.
- The **Released** date and time fields become available after the **Active** check box is cleared, enabling the fields to be updated to reflect the time the devices were no longer in use for the incident.

After the **OK** button is clicked, the device becomes unassociated. Clicking **Cancel** discards any changes and closes the window.

### 3.2.13 Broadcast

**Broadcast** turns on or off the marking of the selected incident record in the database as being available for transmittal to an external system. IMS does not broadcast or export the incident
itself, but an external system that is checking for incidents in the database can retrieve the incident from the database after the incident is marked for broadcast. An incident can also be marked for broadcast by selecting the **Broadcast** check box on the **Details** tab.

### 3.2.14 Take Control

**Take Control** is available when the selected incident has been generated by the ATMS. Clicking **Take Control** opens a window that contains a brief description of the incident and displays the message:

> “After you take control of the incident, ATMS will no longer update the incident”

Clicking **Yes** takes control of the incident; Clicking **No** closes the window, leaving the incident under ATMS control.

### 3.2.15 Print

Clicking **Print** opens a **MICE Incident Detail Report** window, which has options for printing and exporting the report.

### 3.3 PLANNED EVENT MENU

The **Planned Event** menu, shown in Exhibit 3.13, is available only when the **Planned Events** in the list pane is selected. The menu contains commands to create a new planned event and to update an existing planned event. These commands are also available from the toolbar (see Section 4).

#### Exhibit 3.13: Planned Event Menu Commands

<table>
<thead>
<tr>
<th>MENU COMMAND</th>
<th>SHORTCUT</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td></td>
<td>Opens the <strong>Add Planned Event</strong> window</td>
</tr>
<tr>
<td>Update</td>
<td></td>
<td>Saves planned event updates to the database</td>
</tr>
<tr>
<td>Cancel Update</td>
<td></td>
<td>Discards planned event updates and restores the planned event information from the database</td>
</tr>
<tr>
<td>New Notification</td>
<td>&lt;F6&gt;</td>
<td>Opens the <strong>New Notification</strong> window</td>
</tr>
<tr>
<td>New Note</td>
<td>&lt;F7&gt;</td>
<td>Opens the <strong>New Notes</strong> window</td>
</tr>
<tr>
<td>New Response</td>
<td>&lt;F8&gt;</td>
<td>Opens the <strong>New Response</strong> window</td>
</tr>
<tr>
<td>New Device Association</td>
<td>&lt;F9&gt;</td>
<td>Opens the <strong>Manage Entity Associations</strong> window</td>
</tr>
<tr>
<td>Edit</td>
<td></td>
<td>Opens the corresponding action window (<strong>Notification, Note, Response</strong>) with the selected action</td>
</tr>
<tr>
<td>Broadcast</td>
<td></td>
<td>Marks the planned event for transmittal to external systems</td>
</tr>
<tr>
<td>Print</td>
<td></td>
<td>Prints the selected planned event</td>
</tr>
</tbody>
</table>

### 3.3.1 New
New opens the **Add Planned Event** window shown in Exhibit 3.14.

**Exhibit 3.14: Add Planned Event**

- Under **Effective Date/Times**, the **Start** and **End** times of the planned event can be specified. The initial values are the current date and time. The date and time can be changed using the methods described in Section 3.2.1. A planned event may occur repeatedly at a certain time for several days, or it may occur continuously for hours or days. For example, an event’s effective times may be from 2:00 P.M. until 3:00 P.M. daily from August 23 through August 28. In this case, **Daily** is the desired option. Another event’s effective times may be from 6:00 A.M. on August 23 through 7:00 A.M. on August 28. In this case, **Continuous** is the desired option.

- Under **Reported By**, the agency that reported the planned event (**Source**) can be selected from the list. Optionally, the name of the contact person from the reporting agency can be typed in the **Contact** field.
In the **Description** area, the planned event description, **Severity**, **Impact**, and **Location Type** can be selected to provide more details of the planned event.

The **Starting Location** and **Ending Location** areas are used to define where the planned event will occur. This information determines where the planned event icon is displayed on the map. Under **Starting Location**, values must be selected for **Cnty** (county), **Dir** (direction), and **Main**. Selection is not required for the remaining fields; however, values should be selected if the information is available. The intersection of the **Main** street and the **Cross** street is verified. If specified, the address (**Addr**) determines the planned event location on the ATMS map; otherwise, the intersection is used to determine the planned event location. An address that cannot be located on the map may be supplied; however, a message appears stating that the location cannot be geo-coded, and that planned event will not appear be displayed on the ATMS map. In addition, in the planned event list, the event’s icon will have a red slash through it. Additional planned event information can be typed in the **More** field. Under **Ending Location**, all fields are optional, but a county must be selected before a main street or a cross street can be specified.

In the **Lanes Affected** area, clicking the button opens the window shown in Exhibit 3.5, enabling the selection of the affected lanes. Clicking **OK** saves the selections; clicking **Cancel** closes the window and discards any changes.

Under **Remarks**, additional planned event information can be typed.

Clicking **Add** establishes the new planned event; clicking **Cancel** closes the window adding the new planned event.

### 3.3.2 Update

**Update** is unavailable unless a modification has been made to the planned event details. Clicking **Update** saves any changes that have been made to the planned event. If **Cancel Update** is clicked before changes are saved, any changes to the planned event are discarded, restoring the planned event to its original state.

### 3.3.3 New Notification

**New Notification** opens the **Add Planned Event Notification** window, shown in Exhibit 3.15.
Exhibit 3.15: Add Planned Event Notification Window

- Information under the **Identification** area is generated automatically. The **Planned Event** number is the ID of the planned event with which the notification is associated. **Operator** is the username of the user currently logged in. **Date** and **Time** display the current date and time.

- Under **Person Notified**, the person who has been notified can be selected from the list. Alternatively, the person’s number may be typed. The contact’s phone number is automatically entered in the **Number** field. In the **Given To** field, the name of the person to whom the message was given in the absence of the primary contact can be typed.
In the **Responded** area, the **Date** and **Time** that the person responded can be typed or selected. The current date and time is used if **Now** is clicked. The date and time can be changed using the methods described in Section 3.2.1. The time will probably be updated after the notification is created because the person notified may not respond immediately.

- The **Instructions** area is used to type instructions received from the notified person.
- Under **Internal Remarks**, additional information about the notification can be typed.

Planned event notifications are added to the **Actions** tab of the planned event details pane.

Clicking **Add** saves the new notification information; clicking **Cancel** closes the window, without adding the new notification information.

### 3.3.4 New Note

**New Note** opens the **Add Planned Event Note** window shown in Exhibit 3.16.

**Exhibit 3.16: Add Planned Event Note Window**

- Information under the **Identification** area is generated automatically. The **Planned Event** number is the ID of the planned event with which the action is associated. **Operator** is the username of the user currently logged in. **Date** and **Time** display the current date and time but can be changed using the methods described in Section 3.2.1.
- Additional information about the planned event can be typed in the **Note** and **Internal Remarks** areas.

Planned event notes are added to the **Actions** tab of the planned event details pane.
Clicking **Add** saves the new planned event note information; clicking **Cancel** closes the window, discarding any new planned event note information.

### 3.3.5 New Response

**New Response** opens the **Add Planned Event Response** window shown in Exhibit 3.17.

**Exhibit 3.17: Add Planned Event Response Window**

- Information under the **Identification** area is generated automatically. The **Planned Event** number is the ID of the planned event with which the response is associated. **Operator** is the username of the user currently logged in. **Date** and **Time** display the current date and time but can be changed using the methods described in Section 3.2.1.
- Under **Description**, the responding unit may be selected from the **Unit** list. Optionally, a description of the unit can be typed in the **Description** field.
- Instructions given to the responding unit can be typed in the **Instructions** field.
- Under **ETA**, the estimated date and time of the arrival of the responding unit is entered. The initial values are the current date and time.
• The actual date and time of arrival is entered under ATA. This is usually done when the planned event response record is being updated rather than when the record is first being established. Clicking Now sets the date and time values to the current data and time.

• Under ETC, the estimated date and time of completion of the response is entered. The initial values are the current date and time.

• The actual date and time of completion is entered under ATC. This is usually done when the planned event record is being updated rather than when the record is first being established. Clicking Now sets the date and time values to the current data and time.

The dates and times under the ETA, ATA, ETC, and ATC areas can be changed using the methods described in Section 3.2.1.

Planned event responses are added to the Actions tab of the planned event details pane.

Clicking Add saves the new response information; clicking Cancel closes the window without saving any of the information.

3.3.6 New Device Association

Clicking New Device Association opens the Manage Entity Associations window. The identification of the selected planned event is shown in the title bar of the window. Entity associations are added to the Actions tab of the planned event details pane. Although multiple associations can be created, each appears as an individual entry on the Actions tab.

Planned events can be associated with different types of entities including message signs, scenario response plans, and other planned events.

The Manage Entity Associations window is shown in Exhibit 3.18:

• An entity type is selected from the list at the top of the window. One or more instances of the resulting list of incidents or planned events are selected. The association is completed by clicking the down arrow button below the incident and planned event list.

• In the Current/Pending Associations list, the associations already in effect are shown. This list includes any associations that have just been added. Associations can be removed or canceled by selecting one or more instances in the list and then clicking the MINUS SIGN (-) button.

• The New Association Information area provides information about the association selected from the Current/Pending Associations list. The Timestamp indicates when the entity was associated with the incident or planned event. Additional information about the device or incident can be typed in the Notes field.

Clicking OK adds the entity associations to the database; clicking Cancel discards any changes and closes the window.
3.3.7 Edit

Edit is available when a note, notification, response, or device association has been selected. These items are on the Actions tab of the planned event details pane. Clicking Edit opens an update window for the notification, note, or response. These windows look and behave as documented earlier for adding new records. Clicking Update saves any changes made; clicking Cancel discards any changes and closes the window.

When a device association is selected and Edit is clicked, the Edit Device Association window shown in Exhibit 3.19 is opened:

Exhibit 3.19: Edit Device Association Window
- Identification information is generated automatically. The **by** value is the username of the operator editing the device association. The **at** value is the date and time when the devices were associated with the incident.

- Additional information about the device or incident can be typed in the **Notes** field.

- The **Released** date and time fields become available after the **Active** check box is cleared, enabling the fields to be updated to reflect the time the devices were no longer in use for the planned event. After the **Update** button is clicked, the device becomes unassociated.

After the **OK** button is clicked, the device becomes unassociated. Clicking **Cancel** discards any changes and closes the window.

### 3.3.8 Broadcast

Clicking **Broadcast** marks the planned event record in the database as available for transmittal to an external system such as the web-based Driver Information System. IMS does not broadcast or export the planned event itself, but an external system that is checking for planned events in the database can retrieve the planned event from the database after the planned event is marked for broadcast. A planned event can also be marked for broadcast by selecting **Broadcast** check box on the **Details** tab.

### 3.3.9 Print

Clicking **Print** prints a planned event report for the selected planned event in the list. The report is sent to the workstation’s default printer. The generation of the report may take several seconds before printing begins.

### 3.4 VIEW MENU

The **View** menu, shown in Exhibit 3.20, contains commands to control the IMS view:

- The display of the toolbar, details pane, status bar, and message window can be turned on or off by clicking the **Toolbar**, **Status Bar**, **Details Pane**, and **Message Window** commands. A menu command is checked if the display it controls is currently turned on.

- **Refresh** automatically refreshes the data in the IMS window, updating the window with any changes from the database.

- **Keyboard Focus** enables the use of the `<TAB>` key and the arrow keys on the keyboard to move from field to field in the window.

- Selecting one of the next three menu commands (**Active Incidents**, **Cleared Incidents**, or **Planned Events**) specifies which types of events will appear in the list. **Active Incidents** is the initial selection.

- Clicking on **Details**, **Actions**, or **Update Log** opens that tabbed section in the details pane for the selected incident or planned event in the list. **Update Log** is available only for incidents.
### Exhibit 3.20: View Menu Commands

<table>
<thead>
<tr>
<th>MENU COMMAND</th>
<th>SHORTCUT</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Toolbar</td>
<td></td>
<td>Shows or hides the toolbar</td>
</tr>
<tr>
<td>Status Bar</td>
<td></td>
<td>Shows or hides the status bar</td>
</tr>
<tr>
<td>Details Pane</td>
<td></td>
<td>Shows or hides the details pane</td>
</tr>
<tr>
<td>Message Window</td>
<td></td>
<td>Shows or hides the message window</td>
</tr>
<tr>
<td>Refresh</td>
<td>&lt;F5&gt;</td>
<td>Displays an updated view of the current list</td>
</tr>
<tr>
<td>Keyboard Focus</td>
<td>&lt;F2&gt;</td>
<td>Switches the keyboard focus between the detail and list panes</td>
</tr>
<tr>
<td>Active Incidents</td>
<td></td>
<td>Selects the <strong>Active Incidents</strong> list in the list pane</td>
</tr>
<tr>
<td>Cleared Incidents</td>
<td></td>
<td>Selects the <strong>Cleared Incidents</strong> list in the list pane</td>
</tr>
<tr>
<td>Planned Events</td>
<td></td>
<td>Selects the <strong>Planned Events</strong> list in the list pane</td>
</tr>
<tr>
<td>Details</td>
<td></td>
<td>Selects the <strong>Details</strong> display in the detail pane</td>
</tr>
<tr>
<td>Actions</td>
<td></td>
<td>Selects the <strong>Actions</strong> display in the detail pane</td>
</tr>
<tr>
<td>Update Log</td>
<td></td>
<td>Selects the <strong>Update Log</strong> display in the detail pane (for</td>
</tr>
<tr>
<td>Apply Filter</td>
<td></td>
<td>Opens the <strong>Apply Filter</strong> window</td>
</tr>
<tr>
<td>Remove Filter</td>
<td></td>
<td>Removes the filter from the current list</td>
</tr>
</tbody>
</table>

- **Apply Filter** opens the filter list window shown in Exhibit 3.21. The display of the list entries can be filtered by **Date/Time Ranges**, **Severity**, **Type**, **County**, or **Source** of information. **Severity** is not applicable to a planned event and is not shown on the **Planned Events** tab. Only one filtering option can be chosen in the **Fields** area, but **Date/Time Ranges** filtering can be combined with **Fields** filtering.

- **Remove Filter** removes any filters that have been applied to the list display, showing the full list.

### Exhibit 3.21: Filter List Window

![Filter List Window](image)
3.5 TOOLS MENU

The Tools menu contains two commands. Open ATMS Map starts the ATMS Map program. Zoom to ATMS Map starts ATMS Map and zooms in to the location of the selected incident or planned event. If the map window is open already, it is then displayed in front of any other opened windows.

3.6 HELP MENU

The Help menu includes online documentation Help Topics, and About, which provides version and copyright information for TransSuite IMS.
4. TOOLBAR

The IMS toolbar, shown in Exhibit 4.1, contains buttons that duplicate functionality available from the menu bar (Sections 3.2, 3.3, and 3.4). As the mouse pointer is moved over the toolbar buttons, floating tool help displays one word description of the button function; more descriptive tool help appears on the status bar.

The toolbar is shown unless the display is turned off by a command on the View menu (Section 3.4). A tool is unavailable (appears dimmed), if it is not applicable for the current view or for the currently selected item.

The toolbar can be moved from its initial location at the top of the window by clicking on any area of the bar not occupied by a button and then dragging it. Dragging the toolbar away from the toolbar area causes it to become a floating toolbar. A floating toolbar can be placed in a fixed position (“docked”) by dragging the toolbar to one of the edges of the IMS window and then releasing the mouse button when the shaded outline of the bar changes shape.

Exhibit 4.1: IMS Toolbar

The IMS toolbar incident and view buttons are discussed in the order in which they appear, from left to right:

- The New Incident button opens the Add Incident window (Section 3.2.1).
- The New Planned Event button opens the Add Planned Event window (Section 3.3.1).
- The Save Updates button, which is available if changes have been made in the incident or planned event details, saves any changes made.
- If the Cancel Update button is clicked before changes have been saved, the incident or planned event information is restored to its original state.
- The Acknowledge button is available if an incident awaiting acknowledgement has been selected from the list. It opens a window requesting confirmation that the selected incident be acknowledged. Clicking Yes approves the incident; clicking No closes the window without approving the incident.
- The Clear button opens the Clear Incident window, shown in Exhibit 3.7. These commands are discussed in detail in Section 3.2.
- The New Notification button opens the Add Incident Notification window for incidents (Section 3.2.8) or the Add Planned Event Notification window for planned events (Section 3.3.3).
- The New Note button opens the Add Incident Note window for incidents (Section 3.2.9) or the Add Planned Event Note window for planned events (Section 3.3.4).
- The New Response button opens the Add Incident Response window for incidents (Section 3.2.10) or the Add Planned Event Response window for planned events (Section 3.3.5).
The **New Device Association** button opens the **Manage Entity Associations** window for incidents (Section 3.2.11) or planned events (Section 3.3.6).

The **Edit** button, which is available a note, notification, or response item has been selected, opens the corresponding update window. (Sections 3.2.12 and 3.3.7).

The **Details Pane** button turns on or off the display of the detail pane. The **Print** button prints a report for the selected incident (Section 3.2.15) or planned event (Section 3.3.9).

The **Zoom** button starts the ATMS Map program and zooms in to the location of the selected incident or planned event.

The **Apply Filter** button opens the **Filter List** window, which is discussed in more detail in Section 3.4.

The **Remove Filter** button removes any filters that have been applied, showing the full list.

The **ATMS Navigator** button starts the ATMS Map program in its initial view. If ATMS Map has already been started, the window is displayed in front of other opened windows.

The **About** button shows copyright and version information for *TransSuite IMS*. 
5. SHORTCUT MENUS

Shortcut menus are menus that appear when an incident or planned event in the list is right-clicked.

The incident and planned event shortcut menus duplicate the Incident and Planned Event menus on the menu bar.
6. INCIDENT AND PLANNED EVENT LISTS

The IMS incident and planned event list, shown in Exhibit 6.1, is a list of all incidents or planned events in the category selected on the View menu or from the selected tab (Active Incidents, Cleared Incidents, or Planned Events). The list displayed initially is Active Incidents.

Exhibit 6.1: IMS Incident or Planned Event List

<table>
<thead>
<tr>
<th>Id</th>
<th>Time</th>
<th>Sev</th>
<th>Type</th>
<th>Cty</th>
<th>Location</th>
<th>Reported</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>081-02-27/01/1999</td>
<td>07:50</td>
<td>2</td>
<td>ACC</td>
<td>KE</td>
<td>EB1 145TH N</td>
<td>POV</td>
<td></td>
</tr>
<tr>
<td>081-02-27/01/1999</td>
<td>07:16</td>
<td>4</td>
<td>TDM</td>
<td>KE</td>
<td>EB1 145TH N</td>
<td>DOT</td>
<td></td>
</tr>
<tr>
<td>081-02-27/01/1999</td>
<td>07:52</td>
<td>3</td>
<td>DDBJ</td>
<td>JE</td>
<td>S/S INDIAN HILL RD</td>
<td>C/TEN</td>
<td></td>
</tr>
</tbody>
</table>

6.1 INCIDENT INFORMATION

For each incident in the list, the following information is shown:

- Incident number
- Time the incident was entered
- Severity of the incident
- Incident type
- County
- Location (direction, address, main street, cross street)
- Agency that reported the incident
- Remarks

To the left of the incident number, an incident icon with a pencil over it indicates that the incident or changes to it have not yet been acknowledged. An icon with a red slash indicates that the incident could not be geo-coded and does not appear on the ATMS Map (Section 3.2.1).

6.2 SORTING INCIDENTS

The incidents in the list can be sorted by any of the column headings. Clicking once on a column heading sorts the list in ascending order by that heading.

6.3 ACKNOWLEDGING AN INCIDENT

An incident can be acknowledged from the list by selecting the incident and then clicking the Acknowledge button on the toolbar (Section 4). A request to confirm the acknowledgment is displayed. Clicking Yes acknowledges the incident; clicking No closes the window without acknowledging the incident.

6.4 CLEARING AN INCIDENT

An incident can be cleared from the list by selecting the incident and then clicking the Clear button on the toolbar (Section 4). The Clear Incident window opens (Exhibit 6.2), enabling specification of details about clearing the incident (Section 3.2.2). The cleared incident must be acknowledged before it will be moved from the Active Incidents list to the Cleared Incidents list.
Exhibit 6.2: Clear Incident Window
7. DETAILS PANE

The details pane of the IMS user interface includes all of the information available about an incident or planned event. These details are organized in a notebook fashion, with tabs at the top. Identification information cannot be edited, but all other data can be updated.

7.1 DETAILS TAB

The Details tab for an incident or planned event includes all of the information that was entered when the record was created or most recently updated. Sections 3.2 and 3.3 describe the data fields and the methods for modifying them. The Details tab for an incident is shown in Exhibit 7.1.

Exhibit 7.1: Incident Details Tab of the Details Pane

After modifying the desired information, it is necessary to click the Update button on the toolbar or on the Details tab to save the updated incident record. The display of an icon with the pencil indicates that the update has not been acknowledged. The changes appear as red text on the Details tab. After the update has been acknowledged, the red text will change to black.

The incident Details tab also includes Acknowledge, Control, Confirm, and Clear buttons at the bottom of the tabbed page.

The planned event Details tab is shown in Exhibit 7.2.

The Details tab also includes the External Systems field, which shows information if the incident was generated by the ATMS; otherwise the field is empty and cannot be modified. Selecting the Broadcast check box marks the incident record in the database as being available for transmittal to an external system.
7.2 ACTIONS TAB

The Actions tab of an incident or planned event record is shown in Exhibit 7.3. The list contains all of the notifications, notes, and responses related to that incident or planned event:

- Operator who entered the information
- Workstation to which the operator was logged on
- Date and time the action was taken
- Action taken
- Details of the action taken

An existing action can be modified by double-clicking the action on the Actions tab or by selecting the action and clicking Edit on the Planned Event or Incident menu or toolbar. An Update window opens, containing all the information entered when the action was created.
All of these fields except for those in the Identification area can be modified. Clicking Update saves any changes made; clicking Cancel closes the window, discarding any changes.

### 7.3 UPDATE LOG TAB

The Update Log tab of an incident record is shown in Exhibit 7.4. Each update made to an incident is recorded in the log. This information includes the operator who made the update, the workstation from which the update was made, the date and time, and the element updated.

Exhibit 7.4: Update Log Tab

<table>
<thead>
<tr>
<th>Oper.</th>
<th>WorkStation</th>
<th>Date</th>
<th>Updated</th>
</tr>
</thead>
<tbody>
<tr>
<td>build</td>
<td>Mike-Build</td>
<td>06/12/1999</td>
<td>Created Incident 3</td>
</tr>
<tr>
<td>build</td>
<td>Mike-Build</td>
<td>06/12/1999</td>
<td>Updated MainStreet G3Coordinates for Incident 3</td>
</tr>
<tr>
<td>build</td>
<td>Mike-Build</td>
<td>06/12/1999</td>
<td>Updated LaneClose for Incident 3</td>
</tr>
<tr>
<td>dch</td>
<td>DEH</td>
<td>06/12/1999</td>
<td>Updated Type for Incident 3</td>
</tr>
<tr>
<td>dch</td>
<td>DEH</td>
<td>06/12/1999</td>
<td>Updated Source Severity NOTE for Incident 3</td>
</tr>
<tr>
<td>dch</td>
<td>DEH</td>
<td>06/12/1999</td>
<td>Updated AgenciesOnSite for Incident 3</td>
</tr>
<tr>
<td>dch</td>
<td>DEH</td>
<td>06/12/1999</td>
<td>Created Response for Incident 3</td>
</tr>
<tr>
<td>dch</td>
<td>DEH</td>
<td>06/12/1999</td>
<td>Created Note for Incident 3</td>
</tr>
<tr>
<td>dch</td>
<td>DEH</td>
<td>06/12/1999</td>
<td>Created Notification for Incident 3</td>
</tr>
</tbody>
</table>

### 7.4 CLEARING AN INCIDENT

An incident that is displayed in the Details tab can be cleared by clicking the Clear button on the toolbar (Section 4). The Clear Incident window opens, (Exhibit 3.7) and the details about clearing the incident record can be specified (Section 3.2.2).
8. MANAGING SCENARIO ASSOCIATIONS

An IMS incident or planned event can be associated with one or more scenario plans that have been activated in response to that incident or event. A scenario plan is a collection of actions that are designed to affect traffic flow through a specific area of the roadway system.

Scenario plans can handle different types of events including:
- Congestion at accident-prone intersections
- Planned and reoccurring events that affect traffic
- Cross-jurisdictional incident response coordination

Please see the TransSuite IEN Scenario Manager User’s Guide and online help screens for more information on scenario plans.

8.1 ASSOCIATING AN INCIDENT OR PLANNED EVENT WITH A SCENARIO

To associate an incident or planned event with a scenario plan, follow these steps:

1. Select the incident or planned event in the list.
2. Click the New Device Association button on the toolbar to open the Manage Entity Associations window (See Exhibit 8.1).
3. Select Scenario Management from the list at the top of the window to see a list of scenario plans.

Exhibit 8.1: Manage Entity Associations Window

The following information is shown for each scenario:
### 4. Select the desired scenario from the list and then click the down arrow button. The scenario is now shown on the **Current/Pending Associations** list.

5. Click **OK** to save the association.

### 8.2 RELEASING AN ASSOCIATED SCENARIO

To release an associated scenario, follow these steps:

1. Double-click the corresponding device association on the Actions tab for the incident or planned event to open the Edit Association window (See Exhibit 8.2).
2. Clear the **Active** check box and modify the **Released** timestamp as needed.
3. Click **OK** to release the association.

Released associations are listed on the **Actions** tab with a red circle and slash over the icon.

**Exhibit 8.2: Edit Association Window**

### 8.3 VIEWING DETAILED SCENARIO INFORMATION

To view detailed information for an associated scenario, follow these steps:

1. Double-click the device association on the **Actions** tab of the details pane for the incident or planned event to open the Edit Association window.
2. Click the **Scenario Manager** button, which has horizontal red and green lines. **TransSuite** IEN Scenario Manager opens to show information for the scenario.
APPENDIX A – INDEX

Action
  edit, 4-2
Action details, 7-2
Actions, 2-2
ATMS incident, 3-12, 7-1
ATMS Map, 4-2
Broadcast, 3-11, 3-20, 7-1
Details, 2-1, 3-21, 4-2, 7-1
  action, 7-2
Details pane, 3-21, 4-2
Device Association
  add new, 3-10, 3-18, 4-2
Device Associations
  Scenario Management, 8-1
Edit, 3-10, 3-19
Filter
  apply, 3-22, 4-2
  remove, 3-22, 4-2
Formatted text, 1-2
Help
  floating, 2-2
  menu, 3-22
Incident
  acknowledge, 3-4, 4-1, 6-1, 7-1
  add new, 3-3, 4-1
  broadcast, 3-11, 3-20, 7-1
  clearing, 3-4, 6-2, 7-1, 7-3
  clearing status, 3-4
  take control, 3-12
  update, 3-5, 4-1, 7-1
Incident menu, 3-1
Incident shortcut menu, 5-1
Keyboard focus, 3-21
List
  IMS incident or planned event, 6-1
  incidents, 6-1
  sorting, 6-1
Menu
  incident, 3-1
  incident shortcut, 5-1
  planned event, 3-12, 5-1
  shortcut, 5-1
  view, 3-21
Message window, 3-21
Note
  add new, 3-7, 3-16, 4-1
  edit, 3-10, 3-19, 7-3
Notification
  add new, 3-6, 3-15, 4-1
  edit, 3-10, 3-19, 4-2, 7-3
Open ATMS Map, 3-22
Planned event
  add new, 3-13, 4-1
  update, 4-1, 7-1
Planned event menu, 3-12
Planned event shortcut menu, 5-1
Print, 3-12, 3-21, 4-2
Red slash, 3-3, 3-14
Refresh, 3-21
Response
  add new, 3-9, 3-11, 3-18, 3-20, 4-2
  edit, 3-10, 3-19, 4-2, 7-3
Scenario plan, 8-1
Shortcut menu, 5-1
Status bar, 2-2, 3-21
Take control, 3-12
Toolbar, 3-21, 4-1
  moving, 4-1
Update log, 2-1
View menu, 3-21
Zoom to ATMS Map, 3-22
Zoom to map, 4-2
LOS ANGELES COUNTY
INFORMATION EXCHANGE NETWORK

IEN SCENARIO MANAGER USER MANUAL
VERSION 2.4.1

Prepared for:

Los Angeles County
Department of Public Works

Prepared by:

TransCore
626 Wilshire Blvd
Suite 818
Los Angeles, California 90017

April 20th, 2012
# TABLE OF CONTENTS

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>1. INTRODUCTION</strong></td>
<td>1-1</td>
</tr>
<tr>
<td>1.1 Scenario Management Plan Definitions</td>
<td>1-1</td>
</tr>
<tr>
<td>1.2 Regions</td>
<td>1-1</td>
</tr>
<tr>
<td><strong>2. SYSTEM ADMINISTRATING PROCEDURES</strong></td>
<td>2-1</td>
</tr>
<tr>
<td>2.1 Creating, Editing and Deleting Contacts in IMS</td>
<td>2-1</td>
</tr>
<tr>
<td>2.1.1 Adding Contact Information</td>
<td>2-1</td>
</tr>
<tr>
<td>2.1.2 Editing Contact Information</td>
<td>2-7</td>
</tr>
<tr>
<td>2.1.3 Deleting Contact Information</td>
<td>2-8</td>
</tr>
<tr>
<td>2.2 Regions Configuration User Interface</td>
<td>2-9</td>
</tr>
<tr>
<td>2.2.1 Main User Interface Screen Area</td>
<td>2-9</td>
</tr>
<tr>
<td>2.2.2 Menus and Tool Bars</td>
<td>2-10</td>
</tr>
<tr>
<td>2.2.3 Status Bar</td>
<td>2-11</td>
</tr>
<tr>
<td>2.3 Creating, Editing, and Deleting Regions</td>
<td>2-11</td>
</tr>
<tr>
<td>2.3.1 Creating a Region</td>
<td>2-11</td>
</tr>
<tr>
<td>2.3.2 Editing a Region</td>
<td>2-14</td>
</tr>
<tr>
<td>2.3.3 Deleting a Region</td>
<td>2-14</td>
</tr>
<tr>
<td>2.4 Creating and Deleting Region Contacts in Region Configuration UI</td>
<td>2-14</td>
</tr>
<tr>
<td>2.4.1 Adding a Region Contact</td>
<td>2-14</td>
</tr>
<tr>
<td>2.4.2 Deleting a Region Contact</td>
<td>2-15</td>
</tr>
<tr>
<td><strong>3. STANDARD OPERATING PROCEDURES</strong></td>
<td>3-1</td>
</tr>
<tr>
<td>3.1 ATMS MAP Functionality</td>
<td>3-1</td>
</tr>
<tr>
<td>3.1.1 Activating Edit Mode</td>
<td>3-1</td>
</tr>
<tr>
<td>3.1.2 Creating, Editing, and Deleting regions on Map</td>
<td>3-3</td>
</tr>
<tr>
<td>3.2 Scenario Management Plan User Interface</td>
<td>3-10</td>
</tr>
<tr>
<td>3.2.1 Scenario Management Plan Definitions</td>
<td>3-10</td>
</tr>
<tr>
<td>3.2.2 Regions</td>
<td>3-10</td>
</tr>
<tr>
<td>3.2.3 Main User Interface Screen Area</td>
<td>3-10</td>
</tr>
<tr>
<td>3.2.4 Menus and Tool Bars</td>
<td>3-11</td>
</tr>
<tr>
<td>3.3 Creating, Editing and Deleting Plan Definitions</td>
<td>3-14</td>
</tr>
<tr>
<td>3.3.1 Plan Window</td>
<td>3-14</td>
</tr>
<tr>
<td>3.3.2 General Tab</td>
<td>3-14</td>
</tr>
<tr>
<td>3.3.3 Actions and Instructions Tab</td>
<td>3-14</td>
</tr>
<tr>
<td>3.3.4 Contacts Tab</td>
<td>3-15</td>
</tr>
<tr>
<td>3.3.5 Match Criteria Tab</td>
<td>3-15</td>
</tr>
<tr>
<td>3.3.6 Creating a Plan Definition</td>
<td>3-15</td>
</tr>
<tr>
<td>3.3.7 Editing a Plan Definition</td>
<td>3-24</td>
</tr>
<tr>
<td>3.3.8 Deleting a Plan</td>
<td>3-26</td>
</tr>
<tr>
<td>3.4 Starting a Plan</td>
<td>3-27</td>
</tr>
<tr>
<td>3.5 Monitoring an Active Plan</td>
<td>3-29</td>
</tr>
<tr>
<td>3.5.1 Procedure to Monitor an Active Plan</td>
<td>3-29</td>
</tr>
<tr>
<td>3.5.2 Managing Actions</td>
<td>3-30</td>
</tr>
<tr>
<td>3.5.3 Managing Instructions</td>
<td>3-30</td>
</tr>
<tr>
<td>3.6 Releasing an Active Plan</td>
<td>3-31</td>
</tr>
</tbody>
</table>
3.6.1 Releasing a Whole Plan ........................................................................................................... 3-31
3.6.2 Releasing Part of an Active Plan ................................................................................................3-32

3.7 Comparing Incident Report With Match Criteria in Scenario Manager .................................. 3-33
3.7.1 Adding an Incident to IMS ...................................................................................................... 3-33
3.7.2 Running an Incident Match Criteria vs. a Scenario Plan ......................................................... 3-35
3.7.3 Starting a Single Plan............................................................................................................... 3-36
3.7.4 Starting Multiple Plans .......................................................................................................... 3-37
<table>
<thead>
<tr>
<th>TABLE OF EXHIBITS</th>
<th>PAGE #</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exhibit 2.1: Incident Management System</td>
<td>2-1</td>
</tr>
<tr>
<td>Exhibit 2.2: Edit Contacts Window</td>
<td>2-2</td>
</tr>
<tr>
<td>Exhibit 2.3: New Contact Entry Added</td>
<td>2-2</td>
</tr>
<tr>
<td>Exhibit 2.4: Confirm Changes</td>
<td>2-2</td>
</tr>
<tr>
<td>Exhibit 2.5: New Contact Entry Added to System</td>
<td>2-3</td>
</tr>
<tr>
<td>Exhibit 2.6: New Mailing Address Entry Grid</td>
<td>2-3</td>
</tr>
<tr>
<td>Exhibit 2.7: New Mailing Address Entry Added to System</td>
<td>2-4</td>
</tr>
<tr>
<td>Exhibit 2.8: New Phone Number Entry Grid</td>
<td>2-4</td>
</tr>
<tr>
<td>Exhibit 2.9: New Phone Number Entry Added to System</td>
<td>2-5</td>
</tr>
<tr>
<td>Exhibit 2.10: New Email Address Entry Grid</td>
<td>2-5</td>
</tr>
<tr>
<td>Exhibit 2.11: New Email Address Added to System</td>
<td>2-6</td>
</tr>
<tr>
<td>Exhibit 2.12: New Unit Entry Grid</td>
<td>2-6</td>
</tr>
<tr>
<td>Exhibit 2.13: <em>TransSuite®</em> Regions Configuration UI</td>
<td>2-9</td>
</tr>
<tr>
<td>Exhibit 2.14: Select Organization</td>
<td>2-11</td>
</tr>
<tr>
<td>Exhibit 2.15: New Region Entry</td>
<td>2-12</td>
</tr>
<tr>
<td>Exhibit 2.16: Waiting for Completions</td>
<td>2-12</td>
</tr>
<tr>
<td>Exhibit 2.17: Successful Operation</td>
<td>2-13</td>
</tr>
<tr>
<td>Exhibit 2.18: Unsuccessful Operation</td>
<td>2-13</td>
</tr>
<tr>
<td>Exhibit 2.19: New Region</td>
<td>2-13</td>
</tr>
<tr>
<td>Exhibit 2.20: Confirm Delete UI</td>
<td>2-14</td>
</tr>
<tr>
<td>Exhibit 2.21: Select Contacts</td>
<td>2-15</td>
</tr>
<tr>
<td>Exhibit 2.22: Region Contact</td>
<td>2-15</td>
</tr>
<tr>
<td>Exhibit 2.23: Confirm Delete -Region Contact</td>
<td>2-16</td>
</tr>
<tr>
<td>Exhibit 3.1: ATMS Map Window</td>
<td>3-1</td>
</tr>
<tr>
<td>Exhibit 3.2: ATMS Map Activating Edit Mode</td>
<td>3-2</td>
</tr>
<tr>
<td>Exhibit 3.3: ATMS Map Edit Mode</td>
<td>3-2</td>
</tr>
<tr>
<td>Exhibit 3.4: ATMS Map New Region</td>
<td>3-3</td>
</tr>
<tr>
<td>Exhibit 3.5: Region Polyline</td>
<td>3-4</td>
</tr>
<tr>
<td>Exhibit 3.6: Stop Editing Polyline</td>
<td>3-4</td>
</tr>
<tr>
<td>Exhibit 3.7: Region Properties</td>
<td>3-5</td>
</tr>
<tr>
<td>Exhibit 3.8: Region Properties Complete</td>
<td>3-5</td>
</tr>
<tr>
<td>Exhibit 3.9 : Confirm Adding of Region</td>
<td>3-5</td>
</tr>
<tr>
<td>Exhibit 3.10: Regions Added to Map</td>
<td>3-6</td>
</tr>
<tr>
<td>Exhibit 3.11: Edit Region Size</td>
<td>3-7</td>
</tr>
<tr>
<td>Exhibit 3.12: Edit Region Properties</td>
<td>3-8</td>
</tr>
<tr>
<td>Exhibit 3.13: Region Properties Window</td>
<td>3-8</td>
</tr>
<tr>
<td>Exhibit 3.14: Delete Region</td>
<td>3-9</td>
</tr>
<tr>
<td>Exhibit 3.15: Confirm Delete</td>
<td>3-9</td>
</tr>
<tr>
<td>Exhibit 3.16: Scenario Management Plans Window</td>
<td>3-11</td>
</tr>
<tr>
<td>Exhibit 3.17: Plan Definition List</td>
<td>3-16</td>
</tr>
<tr>
<td>Exhibit 3.18: Select Organization</td>
<td>3-16</td>
</tr>
<tr>
<td>Exhibit 3.19: Adding Plan</td>
<td>3-17</td>
</tr>
<tr>
<td>Exhibit</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>3.20</td>
<td>General Plan Information</td>
</tr>
<tr>
<td>3.21</td>
<td>File Browse Window</td>
</tr>
<tr>
<td>3.22</td>
<td>Completed General Plan Information</td>
</tr>
<tr>
<td>3.23</td>
<td>Plan Match Criteria Window</td>
</tr>
<tr>
<td>3.24</td>
<td>Select Entity</td>
</tr>
<tr>
<td>3.25</td>
<td>Completed Match Criteria</td>
</tr>
<tr>
<td>3.26</td>
<td>Plan Contacts</td>
</tr>
<tr>
<td>3.27</td>
<td>Select Contacts</td>
</tr>
<tr>
<td>3.28</td>
<td>Contact Information</td>
</tr>
<tr>
<td>3.29</td>
<td>Plan Actions and Instructions Window</td>
</tr>
<tr>
<td>3.30</td>
<td>Configured Device Action</td>
</tr>
<tr>
<td>3.31</td>
<td>New Instruction Entry</td>
</tr>
<tr>
<td>3.32</td>
<td>Complete Actions and Instructions</td>
</tr>
<tr>
<td>3.33</td>
<td>Edit Plan Window</td>
</tr>
<tr>
<td>3.34</td>
<td>Initialization Window</td>
</tr>
<tr>
<td>3.35</td>
<td>Selected Plan</td>
</tr>
<tr>
<td>3.36</td>
<td>Plan Removed From List</td>
</tr>
<tr>
<td>3.37</td>
<td>Initialization Window</td>
</tr>
<tr>
<td>3.38</td>
<td>Plan Expiration Window</td>
</tr>
<tr>
<td>3.39</td>
<td>Plan Monitor User Interface</td>
</tr>
<tr>
<td>3.40</td>
<td>Active Plan</td>
</tr>
<tr>
<td>3.41</td>
<td>Tool tip for Monitor Icon</td>
</tr>
<tr>
<td>3.42</td>
<td>Tool tip for Release Icon</td>
</tr>
<tr>
<td>3.43</td>
<td>Non Active Plans</td>
</tr>
<tr>
<td>3.44</td>
<td>Active Plan</td>
</tr>
<tr>
<td>3.45</td>
<td>Released Device</td>
</tr>
<tr>
<td>3.46</td>
<td>Add Incident Window</td>
</tr>
<tr>
<td>3.47</td>
<td>New Incident Report</td>
</tr>
<tr>
<td>3.48</td>
<td>Location Matches</td>
</tr>
<tr>
<td>3.49</td>
<td>Active Incidents</td>
</tr>
<tr>
<td>3.50</td>
<td>Acknowledge Incident</td>
</tr>
<tr>
<td>3.51</td>
<td>Match Plan</td>
</tr>
<tr>
<td>3.52</td>
<td>Selected Plan Match</td>
</tr>
<tr>
<td>3.53</td>
<td>Start Plan Window</td>
</tr>
<tr>
<td>3.54</td>
<td>Multiple Plans Selected</td>
</tr>
<tr>
<td>3.55</td>
<td>Pick Primary Plan /Region</td>
</tr>
<tr>
<td>3.56</td>
<td>Merged Plans</td>
</tr>
</tbody>
</table>
## DOCUMENT REVISION HISTORY

<table>
<thead>
<tr>
<th>VERSION #</th>
<th>DATE</th>
<th>PURPOSE</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>12/13/02</td>
<td>Initial Draft</td>
</tr>
<tr>
<td>2.0</td>
<td>3/30/07</td>
<td>COTS Migration updates</td>
</tr>
<tr>
<td>Final</td>
<td>4/2/07</td>
<td>Updated for IEN Software Version 1.09</td>
</tr>
<tr>
<td>FINAL, Revision 1</td>
<td>9/20/11</td>
<td>Updated for IEN Multiple Corridor Server Project (IEN Software Version 2.02)</td>
</tr>
<tr>
<td>Version 2.4.1</td>
<td>4/20/12</td>
<td>Updated for Freeway interface &amp; Outbound interface projects (IEN Software Version 2.4.1)</td>
</tr>
</tbody>
</table>
1. INTRODUCTION

The TransSuite® Scenario Management system allows users to create, implement and track scenario management plans. Scenario Management builds on existing TransSuite applications such as the ATMS Map, Video Control System, Central Communication System, Traveler Information System, Incident Management System, and Freeway Management System to extend their functionality to include the capabilities described in this document.

The Scenario Management System is made up of plan definitions and regions.

1.1 SCENARIO MANAGEMENT PLAN DEFINITIONS

Each plan definition:

- Is associated with a single region.
- Defines the incident management criteria to which it is best suited.
- Lists suggested device/action pairs the operator can execute.
- Lists textual instructions the operator can follow.
- Provides links to attachments to which the operator can refer.
- Lists contact information to which the operator can refer.

Throughout the Scenario Management system, the terms plan and plan definition are used interchangeably.

Keep in mind:

- Plan definitions are used to start plans.
- Only plan definitions can be edited or started.
- Once a plan definition is started it spawns an active plan.
- Only active plans are monitored, so monitor plan always refers to an active plan.

Starting a plan has no effect on the plan definition itself – the started plan becomes a separate entity in the system. Therefore, plan definitions can be changed and even deleted without impacting any current or previously activated instances of itself.

1.2 REGIONS

Regions are roadways, portions of roadways, polygonal areas or a combination of the preceding. They are not specific to the Scenario Management system and can be used in other subsystems. They are, however, central to the definition of scenario management plans.

A region is defined by one of the following:

- A closed-polygonal area as drawn in ATMS Map.
- A roadway within a county.
- A roadway within a county between two operator-described points.
- A combination of 1 and 2.
2. SYSTEM ADMINISTERING PROCEDURES

This section details the information necessary to allow the system administrator to make all configurations for successfully adding, editing and deleting contacts through the Incident Management System and adding, editing and deleting regions and region contacts through the Regions Configuration tool.

The following three sections illustrate how an administrator with the appropriate privileges can perform the above mentioned tasks in the system.

The order of processing is to create the names of region contacts in the Incident Management Tool (IMS), next to create regions using the names of highways and counties and the name of contacts created in (IMS).

2.1 CREATING, EDITING AND DELETING CONTACTS IN IMS

This section details how system administrators should perform the tasks of creating, editing and deleting contacts to the Incident Management System (IMS). This is necessary as it will later be used for configuring regions with contact information for different users in the Region Configuration User Interface.

2.1.1 Adding Contact Information

This section details the process in order to add a new contact to the Incident Management System (IMS) to be used in configuring regions in the system. A user added to the system can be configured with different pieces of contact information. Namely: general, mailing address, phone number, email address and unit information. Each of these pieces of information requires a separate task to perform to add the information for the contact user to the system.

2.1.1.1 Adding General Contact Information

This section details the process in order to allow a system administrator to add a new contact to the system with general user contact information.

1. Open the Incident Management System (IMS) tool and a window similar to the one shown in Exhibit 2.1 will be displayed.

Exhibit 2.1: Incident Management System
Select the Tools menu and select Edit Contacts and a similar dialog as shown in Exhibit 2.2 will be opened.

Exhibit 2.2: Edit Contacts Window

1. Select the File menu and select New (Ctrl + N) option. An entry for the new entity will be added to the grid and highlighted with the current date of creation as shown in Exhibit 2.3.

Exhibit 2.3: New Contact Entry Added

2. Select an organization from the Organization ID drop down list.
3. Select the grid cell for Last Name and enter a last name for the contact.
4. Select the grid cell for First Name and enter a first name for the contact.
5. Select the grid cell for Title and enter a job title position for the contact.
6. Enter any desired notes for the contact in the Notes grid cell.
7. Select Save from the file menu to save the new contact information to the system.
   a. Confirming Changes
      If the user attempts to close the Edit Contacts window and there were unsaved changes to contact information, a dialog such as the one shown in Exhibit 2.4 will be displayed.

Exhibit 2.4: Confirm Changes

Click Yes pushbutton to save changes, No pushbutton to proceed with operation without saving or the Cancel pushbutton to cancel the operation and leave the Edit Contacts window open.

The completed entry should look similar to the dialog in Exhibit 2.5.
2.1.1.2 Adding New Mailing Address for a Contact

This section details the process in order to allow a system administrator to add new mailing address for the contact to the system. Note that if a contact already has a mailing address and this task is performed, another entry for a mailing address for the user will be added to the system.

1. **Confirming Changes** (#a, on page 2-2) opens the Incident Management System (IMS) tool and the window similar to the one shown in Exhibit 2.1 will be displayed.
2. Select the *Tools* menu and select *Edit Contacts* and a similar dialog shown in Exhibit 2.2 will be opened.
3. Select a contact from the list for which you want to add a new mailing address.
4. Select the *File* menu and select *Add* and scroll across and select *New Mailing Address* and a new entry grid is displayed to add new mailing address for the contact as shown in Exhibit 2.6.

**Exhibit 2.6: New Mailing Address Entry Grid**

1. Select an address **Location** from the drop down list.
2. Select the grid cells **Address Line 1** and **Address Line 2** and enter Address1 and address 2 for the contact.
3. Enter the **City**, **State** and **Zip** code of the address for the contact.
4. Enter any desired notes for the mailing address for the contact in the **Notes** field.
5. Select the checkbox whether to make the address for the contact **active** or **inactive**.
6. Select **Save** from the *File* menu to save the new contact mailing address information to the system. See #a, **Confirming Changes**, on page 2-2 for more information that will be displayed if changes are unsaved in the system before exiting the Edit Contacts window.

The completed entry should look similar to the dialog in Exhibit 2.7.
2.1.1.3 Adding new Phone Number for a Contact

This section details the process in order to allow a system administrator to add new phone number information for the contact to the system. Note that if a contact already has phone number information and this task is performed, another entry for phone number will be added to the system for the user.

1. Open the Incident Management System (IMS) tool and the window similar to the one shown in Exhibit 2.1 will be displayed.
2. Select the Tools menu and select Edit Contacts and the dialog shown in Exhibit 2.2 will be opened.
3. Select a contact from the list for which you want to add new phone number information.
4. Select the File menu and select Add and scroll across and select New Phone Number and a new entry grid is displayed to add new mailing address for the contact as shown in Exhibit 2.8.

5. Select a Location for the phone number from the drop down list.
6. Select a Type from the drop down list.
7. Enter a Phone Number for the contact
8. Enter an Extension number for the contact.
9. Enter any desired notes for the mailing address for the contact in the Notes field.
10. Select the checkbox whether to make the phone number for the contact active or inactive.
11. Select Save from the File menu to save the new phone number information for the contact to the system. See #a, Confirming Changes, on page 2-2 for more information that will be displayed if changes are unsaved in the system before exiting the Edit Contacts window.
12. The completed entry should look similar to the dialog in Exhibit 2.9.
2.1.1.4 Adding New Email Address for a Contact

This section details the process in order to allow a system administrator to add new email address information for the contact to the system. Note that if a contact already has an email address and this task is performed, another entry for email address information will be added to the system for the user.

1. Open the Incident Management System (IMS) tool and the window similar to the one shown in Exhibit 2.1 will be displayed.
2. Select the Tools menu and select Edit Contacts and the dialog shown in Exhibit 2.2 will be opened.
3. Select a contact from the list for which you want to add a new email address.
4. Select the File menu and select Add and scroll across and select New Email Address and a new entry grid is displayed to add new mailing address for the contact as shown in Exhibit 2.10.

Exhibit 2.10: New Email Address Entry Grid

5. Select a Location from the email address from drop down list.
6. Select the Email Address grid cell and enter the email address for the contact.
7. Enter any desired notes for the mailing address for the contact in the Notes field.
8. Select the checkbox whether to make the email address for the contact active or inactive.
9. Select Save from the file menu to save the new contact mailing address information to the system. See #a, Confirming Changes, on page 2-2 for more information that will be displayed if changes are unsaved in the system before exiting the Edit Contacts window.
10. The completed entry should look similar to the dialog in Exhibit 2.11.
2.1.1.5 Adding New Unit for a Contact

This section details the process in order to allow a system administrator to add new unit information for the contact to the system. Note that if a contact already has unit information and this task is performed, another entry for unit information will be added to the system for the user.

1. Open the Incident Management System (IMS) tool and the window similar to the one shown in Exhibit 2.1 will be displayed.
2. Select the Tools menu and select Edit Contacts and the dialog shown in Exhibit 2.2 will be opened.
3. Select a contact from the list for which you want to add new unit information.
4. Select the File menu and select Add and scroll across and select New Unit and a new entry grid is displayed to add new mailing address for the contact as shown in Exhibit 2.12.

5. Select a Location from the unit from drop down list.
6. Select the UnitNumber grid cell and enter a number for the unit for the contact.
7. Enter any desired notes for the mailing address for the contact in the Notes field.
8. Select the checkbox whether to make the unit for the contact active or inactive.
9. Select Save from the file menu to save the new contact mailing address information to the system. See #a, Confirming Changes, on page 2-2 for more information that will be displayed if changes are unsaved in the system before exiting the Edit Contacts window.
2.1.2 Editing Contact Information

This section details the proper procedure for editing information for an existing contact in the Incident Management System. Different pieces of the contact person information can be edited in the system. Namely: general, mailing address, phone number, email address and unit information.

2.1.2.1 Editing General Contact Information

This section details the process in order to allow a system administrator to edit the general information for a contact person to the system.

1. Open the Incident Management System (IMS) tool and the window similar to the one shown in Exhibit 2.1 will be displayed.
2. Select a contact from the list for which you want to edit the general information.
3. You can select the grid cells and edit any of the fields except the Last Updated and Date Created fields.
4. Select Save from the file menu to save the new contact information to the system. See #a, Confirming Changes, on page 2-2 for more information that will be displayed if changes are unsaved in the system before exiting the Edit Contacts window.

2.1.2.2 Editing Mailing Address for a Contact

This section details the process in order to allow a system administrator to edit the mailing address information for a contact person to the system.

1. Open the Incident Management System (IMS) tool and the window similar to the one shown in Exhibit 2.1 will be displayed.
2. Select a contact from the list for which you want to edit the new mailing address information.
3. Expand the parent node holding the general information for the contact.
4. You can select the grid cells and edit any of the fields except the Last Updated and Date Created fields.
5. Select Save from the file menu to save the changes to the system for the contact. See #a, Confirming Changes, on page 2-2 for more information that will be displayed if changes are unsaved in the system before exiting the Edit Contacts window.

2.1.2.3 Editing Phone Number for a Contact

This section details the process in order to allow a system administrator to edit the phone number information for a contact person to the system.

1. Open the Incident Management System (IMS) tool and the window similar to the one shown in Exhibit 2.1 will be displayed.
2. Select a contact from the list for which you want to edit the phone number information.
3. Expand the parent node holding the general information for the contact.
4. You can select the grid cells and edit any of the fields except the Last Updated and Date Created fields.
5. Select Save from the file menu to save the changes to the system for the contact. See #a, Confirming Changes, on page 2-2 for more information that will be displayed if changes are unsaved in the system before exiting the Edit Contacts window.
2.1.2.4 Editing Email Address for a Contact

This section details the process in order to allow a system administrator to edit the email address information for a contact person to the system.

1. Open the Incident Management System (IMS) tool and the window similar to the one shown in Exhibit 2.1 will be displayed.
2. Select a contact from the list for which you want to edit the email address information.
3. Expand the parent node holding the general information for the contact.
4. You can select the grid cells and edit any of the fields except the Last Updated and Date Created fields.
5. Select **Save** from the file menu to save the changes to the system for the contact. See #a, **Confirming Changes**, on page 2-2 for more information that will be displayed if changes are unsaved in the system before exiting the Edit Contacts window.

2.1.2.5 Editing Unit for a Contact

This section details the process in order to allow a system administrator to edit the unit information for a contact person to the system.

1. Open the Incident Management System (IMS) tool and the window similar to the one shown in Exhibit 2.1 will be displayed.
2. Select a contact from the list for which you want to edit the unit information.
3. Expand the parent node holding the general information for the contact.
4. You can select the grid cells and edit any of the fields except the Last Updated and Date Created fields.
5. Select **Save** from the file menu to save the changes to the system for the contact. See #a, **Confirming Changes**, on page 2-2 for more information that will be displayed if changes are unsaved in the system before exiting the Edit Contacts window.

2.1.3 Deleting Contact Information

This section details the proper procedure for a system administrator to perform the task of deleting a contact or any piece of the contact’s information from the system. Note that once contact information has been deleted it cannot be recovered and will require that the information be added to the system again.

2.1.3.1 Deleting a Contact

This section details the proper procedure for a system administrator to perform the task of deleting a contact from the Incident Management System (IMS). Note that if a user attempts to delete a contact holding additional pieces of information from the system, then all its contact information will be deleted as well. This information cannot be recovered and will require that it be added to the system again.

1. Open the Incident Management System (IMS) tool and the window similar to the one shown in Exhibit 2.1 will be displayed.
2. Select a contact from the list for which you want to delete.
3. Select the **Edit** menu and select **Delete** (Ctrl + X) menu option.
4. Select **Save** from the file menu to fully remove the selected contact from the system. See #a, **Confirming Changes**, on page 2-2 for more information that will be displayed if changes are unsaved in the system before exiting the Edit Contacts window.
2.1.3.2 Deleting a Contact Information

This section details the proper procedure for a system administrator to perform the task of deleting any piece of the contact person information from the system but not the person’s general information. Therefore, if any piece of the contact person’s information is deleted, only that deleted information will be removed from the system. That instance of the user will still exist in the system.

1. Open the Incident Management System (IMS) tool and the window similar to the one shown in Exhibit 2.1 will be displayed.
2. Select a contact from the list for which you want to delete part of its contact information.
3. Expand the parent node holding the general information for the contact.
4. Select the row for the contact information that you want to delete from the system.
5. Select the **Edit** menu and select **Delete** (Ctrl + X) menu option.
6. Select **Save** from the file menu to fully remove the selected contact information from the system. See #a, **Confirming Changes**, on page 2-2 for more information that will be displayed if changes are unsaved in the system before exiting the Edit Contacts window.

2.2 REGIONS CONFIGURATION USER INTERFACE

The following section details how system administrators should perform the tasks of creating, editing, and deleting regions and region contacts in the system.

2.2.1 Main User Interface Screen Area

The Regions Configuration User Interface, shown in Exhibit 2.13 is divided into five basic screen areas: the menu bar, the toolbars, the regions list display area, regions contact list display area and the status bar.

**Exhibit 2.13: TransSuite Regions Configuration UI**
2.2.2 Menus and Tool Bars

The menu bar and toolbars give you access to all of the user interface commands. The toolbars almost completely duplicate the commands available in the menu bar. The most commonly used commands can be found on the toolbars. You can also carry out many of the commonly used commands using the accelerator keys (function keys or a combination of CTRL+letter) shown in the menus. Each accelerator key is displayed alongside the menu item when accessed via the toolbar.

2.2.2.1 Toolbar

The toolbar includes from left to right: Refresh, Save, Cancel, New, Delete and Help.

2.2.2.2 Menu Bar

The Regions Configuration UI menu bar includes these three different pull down menu items.

2.2.2.2.1 Regions Menu

The Regions menu includes three items.

Refresh retrieves the latest list of regions in the system. Accelerator key F5 may also be used to perform this task.

Save item updates the database with all changes made on any region or region contact information. These changes will include adding, modifying or deleting a region and adding and deleting a region contact from the system. The save function is only enabled after a change has occurred on a region or region contact created in the system.

Cancel cancels changes made in the system without saving the changes.

2.2.2.2.2 Edit Menu

The Edit menu includes two items.

New adds a new region or region contact to the system. Accelerator key (Ctrl + N) may also be used to perform this task.
**Delete** deletes an existing region or region contact from the system. Accelerator key (Ctrl + X) may also be used to perform this task.

2.2.2.2.3  **Help Menu**

The **Help** menu includes two items.

- **Help Topic** opens the online Help file. Accelerator key F1 may also be used to perform this task.
- **About** opens a message window with version, release and copyright information about the user interface. Accelerator key F2 may also be used to perform this task.

2.2.3  **Status Bar**

The status bar is a standard windows status bar which displays from (left to right) copyright information, icon to access the server side reports by double-clicking and an icon to access the privilege server.

2.3  **CREATING, EDITING, AND DELETING REGIONS**

This section details how system administrators should perform the tasks of creating, editing, and deleting regions from the Region Configuration User Interface.

2.3.1  **Creating a Region**

This section details the process in order to allow a system administrator to perform the task of creating a new region in the system. Note that regions can also be added to the system by creating them on ATMS Map and then edited them in the Region Configuration User Interface.

1. Open the *TransSuite* Region Configuration and the window similar to the one shown in Exhibit 2.13 will be displayed.
2. Click the **new** icon from the edit toolbar or menu bar and, the dialog shown in Exhibit 2.14 will be opened.

**Exhibit 2.14: Select Organization**

3. Select the **Organization** from the list displayed and click the **OK** pushbutton. Otherwise, select the **Cancel** pushbutton to close the dialog.
4. An entry for the new region will be added to the list of regions as shown in Exhibit 2.15. Any field(s) shown with a red symbol next to it must be completed before the entry can be saved to the system.

Exhibit 2.15: New Region Entry

5. Click in the Name field and enter an alphanumeric name for the region.
6. Select a County Id for the region from the drop down list.
7. Select a Street name for the region from the drop down list.
8. Enter Point1 and Point 2 values for the region in the point1 and point 2 fields.
9. Click the Save option on the regions menu bar or toolbar to save the region to the database.

a. Saving an Entity

When saving an entity to the database, the window similar to the one shown in Exhibit 2.16 will be displayed.

During processing the Cancel Waiting pushbutton can be clicked to cancel waiting for completion of the operation and close the dialog.

Exhibit 2.16: Waiting for Completions
When the processing is successful the window as shown in Exhibit 2.17 will be displayed. Click the **OK** pushbutton to close the dialog. The **Copy to Clipboard** function will place a plain-text version of the contents of the dialog that can then be pasted into a document or email.

**Exhibit 2.17: Successful Operation**

If processing is unsuccessful, then a similar window as shown in Exhibit 2.18 will be displayed. Click the **OK** pushbutton to close the dialog.

**Exhibit 2.18: Unsuccessful Operation**

An unsuccessful operation such as the one indicated above may happen if the portal is not running or if the portal cannot be contacted. If such problem occurs, contact the System Administrator to verify that all configurations are correct or to verify that the portal is running.

10. The completed entry added to the system will look similar to the window shown in Exhibit 2.19.

**Exhibit 2.19: New Region**
2.3.2 Editing a Region

This section details the process in order to allow a system administrator to perform the task of editing an existing region in the system.

1. Open the TransSuite Region Configuration and the window shown in Exhibit 2.13 will be displayed.
2. Select the region to edit from the grid list.
3. Edit the desired fields on the grid for the region. The date created and last updated fields cannot be updated.
4. Click the Save option on the regions menu bar or toolbar to save the changes for the region to the database. See #9.a, Saving an Entity, on page 2-12 for more information on saving an entity to the database.

2.3.3 Deleting a Region

This section details the process in order to allow a system administrator to perform the task of deleting a region from the TransSuite Region Configuration User Interface. Note that once a region has been deleted it cannot be recovered and will require that the region be added to the system again.

1. Open the TransSuite Region Configuration and the window similar to the one shown in Exhibit 2.13 will be displayed.
2. Select the region to delete from the system.
3. Click the Delete icon from the edit toolbar or menu bar and, the dialog shown in Exhibit 2.20 will be opened.

Exhibit 2.20: Confirm Delete UI

Click Yes pushbutton to save changes or the No pushbutton to proceed with operation without saving.
4. Click the Save option on the regions menu bar or toolbar to fully delete the region from the database. See #9.a, Saving an Entity, on page 2-12 for more information on saving an entity to the database.

2.4 Creating and Deleting Region Contacts in Region Configuration UI

This section details how system administrators should perform the tasks of creating and deleting region contacts from the Region Configuration User Interface. Note that only contacts created in the Incident Management System (IMS) will be displayed as a list of contacts from which the user can choose to associate with a region. See Section 2.1 for more information on adding, editing and deleting contacts in IMS.

2.4.1 Adding a Region Contact

This section details the process in order to allow a system administrator to perform the task of adding a new region contact to the region configuration.
1. Open the *TransSuite* Region Configuration and the window similar to the one shown in Exhibit 2.13 will be displayed.

2. Click the *new* icon from the Region Contact section of the window and a similar dialog as shown in Exhibit 2.21 will be opened.

**Exhibit 2.21: Select Contacts**

![Select Contacts Window]

3. Select a contact from the list and click the **OK** pushbutton. Otherwise, select the **Cancel** pushbutton to close the dialog.

4. The dialog shown in Exhibit 2.22 should show a similar illustration when the contacts are added.

**Exhibit 2.22: Region Contact**

![Region Contact Window]

5. Click the **Save** option on the regions menu bar or toolbar to save the contact for the region to the database. See #9.a, **Saving an Entity**, on page 2-12 for more information on saving an entity to the database.

### 2.4.2 Deleting a Region Contact

This section details the process in order to allow a system administrator to perform the task of deleting a region contact from *TransSuite* Region Configuration User Interface. Note that deleting a region contact from the Region Configuration User Interface does not delete it from
the Incident Management System (IMS). Once it is deleted from the Region Configuration User Interface, it cannot be recovered in this system and will require that it be added again.

1. Open the TransSuite Region Configuration and the window similar to the one shown in Exhibit 2.13 will be displayed.
2. Select the region contact to delete from the system.
3. Click the Delete icon from the edit toolbar or menu bar and, the dialog shown in Exhibit 2.23 will be opened.

Exhibit 2.23: Confirm Delete -Region Contact

Click Yes pushbutton to save changes or the No pushbutton to proceed with operation without saving.
4. Click the Save option on the regions menu bar or toolbar to delete the region contact from the TransSuite Region Configuration user interface. See #9.a, Saving an Entity, on page 2-12 for more information on saving an entity to the database.
3. STANDARD OPERATING PROCEDURES

This section details the necessary instructions important to guide operators in performing their daily tasks in creating, editing and deleting regions from AMTS Map. Users are also able to create, edit and delete plans and be able to create incident in the Incident Management System (IMS) and then run a scenario management plan to determine the percentage of the any plan that match the criteria of a reported incident. Once a plan closely fits the match criteria the user can start this plan, monitor this plans and even release an active plan from user control.

The following sections illustrate how an operator with the appropriate privileges can perform the above mentioned tasks in the system.

3.1 ATMS MAP FUNCTIONALITY

This section details the information necessary to allow the operator to successfully configure regions as roadways or portions of roadways on the map. This section will detail the necessary configuration parameters required in order for the scenario manager to read data from the other subsystems such as the Traveler Information System, Video Control System and the Central Communication Server. The Privilege Service and Utility Portal should be running in order to successfully perform tasks in the system.

The following two sections illustrate how a user with the appropriate privileges can activate edit mode on the map to make configuration changes and also be able to create, edit and delete regions from the map.

3.1.1 Activating Edit Mode

This section details the process in order to activate edit mode on the region layer. Once edit mode is activated the operator is able to make configuration changes such as create new regions, edit the properties of existing regions or delete existing regions from the map. Only users with the appropriate privileges will be able to activate edit mode in the system.

1. Open ATMS Map from the desktop shortcut icon or the Start Menu and a window as shown in Exhibit 3.1 will be opened.

Exhibit 3.1: ATMS Map Window
2. Select menu item: View -> Layers Toolbar to display the layers toolbar. Skip this step if the layers toolbar is already displayed on the map.

3. Click the “R” icon for the Region Layer from the ATMS Map toolbar.

4. Right click anywhere on the map and select Region Layer and then click Edit Mode as shown in Exhibit 3.2.

Exhibit 3.2: ATMS Map Activating Edit Mode

5. When the map is placed in edit mode, a textual description is placed in the top middle of the map background showing “Editing Region Layer“ as shown in Exhibit 3.3

Exhibit 3.3: ATMS Map Edit Mode
3.1.2 Creating, Editing, and Deleting regions on Map

This section details how an operator should perform the tasks of creating, editing and deleting regions on ATMS Map. This whole process of creating, editing and deleting regions on the map can also be done through the Regions Configuration User Interface. When the regions are drawn on the map the operator can physically see the entire area on the map covered by these regions.

The following sections illustrate how an operator with the appropriate privileges can perform the above mentioned tasks in the system.

3.1.2.1 Creating a Region on Map

This section details the process in order to allow an operator to perform the task of creating a new region on the map. Creating regions on the map is important to later help in creating plans if the user wants to configure match criteria for a plan using a region. Once a region is added to the map it is automatically added to the Regions Configuration User Interface as well. Note that the map layer must be in edit mode in order for the operator to create a new region on the map.

1. Right click anywhere on the map and select Region Layer and click New Region as shown in Exhibit 3.4. The mouse pointer will turn to a “Cross T”.

   Exhibit 3.4: ATMS Map New Region

2. Draw the desired closed region by pointing and selecting a starting vertex for the region on the map. A white square-like image will be displayed.

3. Drag the mouse pointer from the starting vertex to different points on the map and back to the starting vertex to cover the entire region. The same square-like image will be displayed at the end of each edge for the region as shown in Exhibit 3.5.
1. Right click on the map again and click **Stop Editing Polyline** as shown in Exhibit 3.6.

**Exhibit 3.5: Region Polyline**

2. A window as shown in Exhibit 3.7 will be displayed after stopping plotline editing.

**Exhibit 3.6: Stop Editing Polyline**

**Exhibit 3.7**
3. Enter a unique integer identifier for the region in the Region ID field.
4. Select the organization for the region from the Organization drop down list box.
5. Enter an alphanumeric value for the description of the region in the Description field (optional).
6. Change the Detail Level (optional).
7. The completed properties window should look similar to the window shown in Exhibit 3.8.

Exhibit 3.8: Region Properties Complete

8. Click the OK pushbutton to close the region properties window. Click the Cancel pushbutton to close the region properties window without saving changes. Click the Apply pushbutton to save changes without closing the region properties window.
9. When the OK pushbutton is clicked, the window as shown in Exhibit 3.9 will be displayed.

Exhibit 3.9 : Confirm Adding of Region
Click the **Yes** pushbutton to save changes or the **No** pushbutton to proceed with operation without saving.

10. The system automatically saves the region to the system. See #9.a, **Saving an Entity**, on page 2-12 for more information on saving an entity to the database.

11. The window shown in Exhibit 3.10 show regions that are successfully added on the map.

**Exhibit 3.10: Regions Added to Map**

3.1.2.2  Editing a Region on map

This section details the proper procedure for editing an existing region on the map. An operator is able to edit the physical size of a region to cover a new area on the map or edit the properties of an existing region such as its name, Id or description. Note that editing a region’s properties can also be through the Regions Configuration User Interface. Editing a region’s size (Physical dimensions) can only be done on the map.

The following sections illustrate how an operator with the appropriate privileges can perform the tasks of editing the size and properties of an existing region on the map.

3.1.2.2.1  Editing Region Size

This section details the proper procedure for an operator to perform the task of editing the size of an existing region on the map to cover a new area.

1. Open ATMS Map from the desktop shortcut icon or the Start Menu and a window as shown in Exhibit 3.1 will be opened.
2. Activate the Region Layers and place the layer in edit mode. See Section 3.1.1, Activating Edit Mode, for more information.
3. Right click onto the selected region to edit and select **Edit Region** as shown in Exhibit 3.11.
Exhibit 3.11: Edit Region Size

4. Square-like images will be placed at each vertex of the region. Click any vertex and drag to a new location on the map to form a new region.

5. Click onto the edited region on the map and the window shown in Exhibit 3.8 will be displayed.

6. Click the Ok pushbutton to save the changes to the database. See #9.a, Saving an Entity, on page 2-12 for more information on saving an entity to the database.

3.1.2.2.2 Editing Region Properties

This section details the proper procedure for an operator to perform the task of editing the properties of an existing region on the map. Note that modifying the properties of an existing region on the system can also be done through the Regions Configuration User Interface.

1. Open ATMS Map from the desktop shortcut icon or the Start Menu and a window as shown in Exhibit 3.1 will be opened.

2. Activate the Region Layers and place the layer in edit mode. See Section 3.1.1, Activating Edit Mode, for more information.

3. Select the region to edit, right click onto the selected region and select Properties as shown in Exhibit 3.12.
4. The window as shown in Exhibit 3.13 will be displayed.

**Exhibit 3.13: Region Properties Window**

5. You can edit any of the fields in this dialog.
6. Click the OK pushbutton on the Region Properties window to store the changes to the edited region and close the dialog. Click the Cancel pushbutton to close the region properties window without saving changes. Click the Apply pushbutton to save changes without closing the region properties window.
7. See #9.a, **Saving an Entity**, on page 2-12 for more information on saving an entity to the database.
### 3.1.2.3 Deleting a Region from map

This section details the proper for an operator to perform the task of deleting a region from the map. Note that once a region has been deleted it cannot be recovered and will require that the region be added to the system again. Once a region is deleted from the map, it is automatically deleted from the Regions Configuration User Interface as well.

1. Open ATMS Map from the desktop shortcut icon or the Start Menu and a window as shown in Exhibit 3.1 will be opened.
2. Activate the Region Layers and place the layer in edit mode. See Section 3.1.1, Activating Edit Mode, for more information.
3. Select the region to delete from the map, right click onto the selected region and select **Delete Region** as shown in Exhibit 3.14.

#### Exhibit 3.14: Delete Region

4. The window as shown in Exhibit 3.15 will be displayed.

#### Exhibit 3.15: Confirm Delete

5. Select pushbutton **Yes** to complete the action or pushbutton **No** to cancel the action. See #9.a, **Saving an Entity**, on page 2-12 for more information on saving an entity to the database.
3.2 SCENARIO MANAGEMENT PLAN USER INTERFACE

Scenario Management is a tool used for the creating, implementing, and tracking scenario management plans. Scenario Management builds on existing applications such as the ATMS Map, Traveler Information System, Incident Management System and Freeway Management System to extend their functionality to include the capabilities described in this document.

The Scenario Management System is made up of plan definitions and regions.

3.2.1 Scenario Management Plan Definitions

Each plan definition:

- Is associated to a single region.
- Defines the incident management criteria to which it is best suited.
- Lists suggested device/action pairs the operator can execute.
- Lists textual instructions the operator can follow.
- Provides links to attachments to which the operator can refer.
- Lists contact information to which the operator can refer.

Throughout the Scenario Management system, the terms plan and plan definition are used interchangeably.

Keep in mind:

- Plan definitions are used to start plans.
- Only plan definitions can be edited or started.
- Once a plan definition is started it spawns an active plan.
- Only active plans are monitored, so monitor plan always refers to an active plan.

Starting a plan has no effect on the plan definition itself – the started plan becomes a separate entity in the system. Therefore, plan definitions can be changed and even deleted without impacting any current or previously activated instances of itself.

3.2.2 Regions

Regions are roadways, portions of roadways, polygonal areas or a combination of the preceding. They are not specific to the Scenario Management system and can be used in other subsystems. They are, however, central to the definition of scenario management plans.

A region is defined by one of the following:

1. A closed-polygonal area as drawn in ATMS Map.
2. A roadway within a county.
3. A roadway within a county between two operator-described points.
4. A combination of 1 and 2.

3.2.3 Main User Interface Screen Area

The Scenario Management Plan user interface shown in Exhibit 3.16 is divided into five basic screen areas: the menu bar, the toolbar, the plan type list display area, plan list display area and the status bar.
### 3.2.4 Menus and Tool Bars

The menu bar and toolbars give you access to all of the user interface commands. The toolbar duplicates the commands available in the menu bar. The most commonly used commands can be found on the toolbars. You can also carry out many of the commonly used commands using the accelerator keys (function keys or a combination of CTRL+ letter) shown in the menus. Each accelerator key is displayed alongside the menu item when accessed via the toolbar.

#### 3.2.4.1 Toolbar

The toolbar can be broken into two sections. There is a toolbar displayed when the active plans tab is selected and a different one displayed when the plan definitions tab is selected.

##### 3.2.4.1.1 Active Plans Toolbar

The toolbar includes from left to right: **Monitor, Release, Refresh** and **Help**.

##### 3.2.4.1.2 Plan Definitions Toolbar

The toolbar includes from left to right: **Add, Open, Delete, Save, Start Plan, Refresh** and **Help**.

#### 3.2.4.2 Menu Bar

##### 3.2.4.2.1 Active Plan View

The Scenario Management Plan UI menu bar includes these three different pull down menu items, **Active Plan**, **View** and **Help**. The Scenario Management Plan user interface defaults to the active plan list when the tool is opened.

##### 3.2.4.2.1.1 Active Plan Menu
The **Active Plan** menu includes two items.

**Monitor used to place a plan in monitor mode.** Accelerator key (Ctrl + M) may also be used to perform this task.

**Release** releases the selected plan from being active.

### 3.2.4.2.1 View Menu

![View Menu](image)

The **View** menu includes two items.

**Plan Definitions** opens the plan definition list to show all the plans created in the system. Accelerator key (Ctrl + D) may also be used to perform this task.

**Refresh** retrieves the latest list of regions in the system. Accelerator key **F5** may also be used to perform this task.

### 3.2.4.2.1.3 Help Menu

![Help Menu](image)

The **Help** menu includes two items.

**Help Topic** opens the online Help file. Accelerator key F1 may also be used to perform this task.

**About** opens a message window with version, release and copyright information about the user interface.

### 3.2.4.2.2 Plan Definition View

The Scenario Management Plan UI will show these three different pull down menu items when the plan definition tab is selected from the main user interface screen.

### 3.2.4.2.2.1 Plan Definition Menu

![Plan Definition Menu](image)

The **Plan Definition** menu includes five items.
1. **New Plan Definition** opens a new window to add a new plan definition to the system. Accelerator key (Ctrl + N) may also be used to perform this task.

2. **Open Plan Definition** opens the definition of an existing plan created in the system in the edit mode. Accelerator key (Ctrl + O) may also be used to perform this task.

3. **Delete Plan Definition** allows a user to delete an existing plan from the system. The deleted plan will temporary disappear from the display list but not from the database unless changes are saved.

4. **Save** item updates the database with all changes made on any region or region contact information. These which will include adding, modifying or deleting a plan in this user interface. The save function is only enabled after a change has occurred on a plan created in the system. Accelerator key (Ctrl + S) may also be used to perform this task.

5. **Start Plan** starts a plan that is created in the system. Accelerator key (Ctrl + T) may also be used to perform this task.

### View Menu

The **View** menu includes two items.

- **Active Plans** opens a window to show a list of all the active plans running in the system. Accelerator key (Ctrl + A) may also be used to perform this task.

- **Refresh** retrieves the latest list of regions in the system. Accelerator key **F5** may also be used to perform this task.

### Help Menu

The **Help** menu includes two items.

- **Help Topic** opens the online Help file. Accelerator key F1 may also be used to perform this task.

- **About** opens a message window with version, release and copyright information about the user interface.
3.3 CREATING, EDITING AND DELETING PLAN DEFINITIONS

This section details how an operator should perform the tasks of creating, editing, and deleting plans from the system. The plan window is used for the creating, editing and deleting plans in the system.

3.3.1 Plan Window

This window is used to both add/edit plan definitions and monitor active plans. See Section 3.3.7, Editing a Plan Definition, and Section 3.5, Monitoring an Active Plan, for details on working with actions and instructions.

The plan window is divided into the following tabs:

- **General** - Plan identification, default duration and attachments.
- **Actions and Instructions** - Device actions and text-based operator instructions
- **Contacts** - ATMS-based contacts.
- **Match Criteria** - Parameters used for incident/plan matching.

3.3.2 General Tab

When configuring a plan the following values are required: **Organization, Id** and **Name**.

If specified, **Anticipated Duration** is used to calculate an expiration time to be used on device actions when starting the plan. Note that this value isn't automatically sent - you'll still have a chance to adjust it when starting the plan.

**Attachments** are merely links to files to which an operator might refer while using the plan. The files should be referred to and kept on a common network share in order to be accessible from multiple workstations.

**Attachments** can be opened while editing or monitoring plans.

3.3.3 Actions and Instructions Tab

This tab shows the list of device actions and textual instructions to be used while managing/monitoring an active plan. See Section 3.3.7, Editing a Plan Definition and Section 3.5, Monitoring an Active Plan, for details on working with actions and instructions.

**Actions** are device-related. Only a subset of the action/device combinations available in the overall ATMS are accessible here. An actions consists of a target device, the action (and any parameters applicable to that action) and the current status of the target device.

Each action is displayed in 3 general columns:

1. Command buttons, Action, Target Device and Release timestamp
2. Action parameters
3. Target Device's current status

The release button, timestamp and action re-execute button are only accessible while monitoring an active plan.

All other data is available while both editing plan definitions and monitoring active plans. This includes the command button to access the default window for the target device.
Note that operator privileges are ultimately verified for each action when performed in the context of the plan. That is, any actions that the operator couldn't perform in the native subsystem can't be performed through starting the plan. These privileges aren't all-inclusive: starting the plan will result in the actions for which the user does not have privilege failing while the others (those for which the operator is privileged) succeed.

Instructions are purely textual and are not tied to any specific entity or subsystem in the ATMS. An instruction consists of the text describing actions the operator can/should take and - when monitoring an active plan - notes and a timestamp pertaining to the operator's response to the instructions.

Each instruction is displayed in 3 columns:

1. Completed button and timestamp
2. Instructions
3. Operators notes

The completed button, timestamp and notes are only accessible while monitoring an active plan.

Instructions are editable while editing a plan definition but read-only while monitoring an active plan.

3.3.4 Contacts Tab

This tab shows the list of potential contacts to be used while managing/monitoring an active plan.

3.3.5 Match Criteria Tab

This tab shows the incident-related conditions to which the plan is geared. With the exception of Region, the values on this page are only relevant for selecting plans from the Incident Management System through the dialog as shown in Exhibit 3.51: Match Plan (page 3-35). Region - in addition to being used for matching plans to an incident - is used to sort and highlight the available devices when adding device actions to the plan definition.

When plans are added from ATMS Navigator, the Region information will be pre-filled based on the user’s selection in the map.

3.3.6 Creating a Plan Definition

This section details how an operator should perform the tasks of creating plan definitions within the system.

1. Open the Scenario Management Plans user interface and a dialog as illustrated in Exhibit 3.16 will be opened.
2. Click onto the Plan Definitions tab and the dialog as shown in Exhibit 3.17 will be displayed.
3. Click on the green plus sign “Add” icon from the toolbar or select **New Plan Definition** from the plan definition menu and the dialog as shown in Exhibit 3.18 will be opened.

   **Exhibit 3.18: Select Organization**

4. Select the organization and click the **OK** pushbutton to close the dialog. Choose the **Cancel** pushbutton to cancel the operation.

5. The dialog as shown in Exhibit 3.19 will be opened.
6. **Adding General Information to a Plan**

This section details how an operator can add all the required general information for a plan to the system.

1. Click the **General** tab on the Adding Plan window and the dialog as shown in Exhibit 3.20 will be opened. Any field(s) shown with a red symbol next to it must be completed before the **OK** pushbutton can be enabled.

   **Exhibit 3.20: General Plan Information**

2. Select the Organization from the drop down list.
3. Enter a numeric value for the ID in the ID field.
4. Enter an alphanumeric value for the name of the plan in the Name field.
5. Enter a description for the plan in the Description field.
6. Check the Anticipated Duration box if desired to calculate an expiration time to be used on device actions when starting the plan. Note that this value isn't automatically sent - you'll still have a chance to adjust it when starting the plan.
7. Add necessary attachments if the need be clicking the green plus sign and a dialog similar to the one shown in Exhibit 3.21 will be opened.

Exhibit 3.21: File Browse Window

1. Browse to the location where all the attachment is located
2. Click Open on the browser window to load the attachment file into the adding plan window.
3. The completed form for the general information for the plan should look similar like to the dialog shown in Exhibit 3.22.

Exhibit 3.22: Completed General Plan Information

7. **Adding a Match Criteria to a Plan**
   This section details how an operator can add match criteria information to a newly created plan in the system.
1. Click the Match Criteria tab on the Adding Plan window and the dialog as shown in Exhibit 3.23 will be opened.

**Exhibit 3.23: Plan Match Criteria Window**

2. Select the Click to select link below the region label to select the region to associate the plan. The dialog displayed in Exhibit 3.24 will be opened.

**Exhibit 3.24: Select Entity**

3. Select the region entity from the list and click the **OK** pushbutton to close the dialog and load the selected region into the adding plan window. Choose the **Cancel** pushbutton to cancel the operation.

4. Check Involves, Types, Severities, Lanes, and Impact checkboxes (where necessary).

5. **NOTE:** These selected options will be used by the Incident Management System (IMS) to compare the selected incident with the available plans (scenarios) and user will be given a report of what percent of each scenario matches with the selected incident.
6. The window illustrated in Exhibit 3.25 displays an example of a match criteria for a plan.

**Exhibit 3.25: Completed Match Criteria**

8. **Adding Contacts to a Plan**
   This section details how an operator can add contact information to a newly created plan in the system.
   1. Click the **Contacts** tab on the Adding Plan window and the dialog as shown in Exhibit 3.26 will be opened.

**Exhibit 3.26: Plan Contacts**

2. Click the green plus sign “New” icon and the dialog shown in Exhibit 3.27 will be displayed.
3. Select the contact from the list and click the **OK** pushbutton to close the dialog and load the selected region into the adding plan window. Choose the **Cancel** pushbutton to cancel the operation.

4. When the contact information is loaded it should look similar to Exhibit 3.28.

**Exhibit 3.28: Contact Information**

---

9. **Adding Actions and Instructions to a Plan**
   This section details how an operator can perform the task of adding actions and instructions to a plan definition in the system.

   **A. Adding Actions to a Plan Definition**
   This section details how an operator can add actions to a newly created plan definition in the system. Prior to adding any actions to the plan, you should assign a region to the plan (if applicable).
   
   The Scenario Manager supports various types of actions such as posting messages on signs, controlling camera views, and commanding intersection controllers. The set of actions available in the Adding Plan window is determined by which *TransSuite* modules are included with the deployed system.
   
   1. Click the Actions and Instructions tab on the Adding Plan window and a dialog similar to the one shown in Exhibit 3.29 will be opened.
Exhibit 3.29: Plan Actions and Instructions Window

2. Click on the Action button and select the desired device type and action.
3. Additional screens will open requesting other information required for the selected device type and action.
4. When all device action information is entered, the action will be added to the plan as shown in Exhibit 3.30.

Exhibit 3.30: Configured Device Action

B. Adding Instructions to a plan definition

This section details how an operator can add instructions between device actions for a newly created plan definition in the system. Instructions are purely textual and are not tied to any specific entity or subsystem in the ATMS. An instruction consists of the text describing actions the operator can/should take and - when monitoring an active plan - notes and a timestamp pertaining to the operator's response to the instructions.

1. Click the Actions and Instructions tab on the Adding Plan window and the dialog as shown in Exhibit 3.29 will be opened.
2. Click on the **Instruction** button and an entry to add the instructions will be added to the bottom of the list as shown in Exhibit 3.31.

**Exhibit 3.31: New Instruction Entry**

![New Instruction Entry](image)

3. Select a suitable instruction type from the drop down list.
4. Enter the instructions that the operation should take
5. Click in the notes cell to add information to use while monitoring the plan.
6. Click the **OK** pushbutton from notes monitoring section of the adding plan window. Choose the **Cancel** pushbutton to cancel the operation at any time.

10. Click the **Save** option on the plan menu bar or toolbar to save the plan to the database. See #9.a, **Saving an Entity**, on page 2-12 for more information on saving changes to the database.

11. A complete form of actions and instructions will look similar to the dialog shown in Exhibit 3.32.

**Exhibit 3.32: Complete Actions and Instructions**

![Complete Actions and Instructions](image)
3.3.7 Editing a Plan Definition

This section details how an operator can modify an existing plan that is created in the system. It also details information about the menu items and toolbar items available from this view. Note that changes to a plan do not have to be saved before the plan is started. A typical operational scenario could be to create and store plan definitions that contain larger selections of actions and instructions than will probably be required in every instance of activating the plan. Then, before the user presses the Start button, they would review the actions and instructions and delete any that didn't apply to the situation at hand. Likewise, the user could augment the plan definition with additional actions or instructions before starting the plan.

An operator with sufficient privileges could save the modified plan before starting it if they so choose - perhaps they realize that they add or remove the same steps every time they activate the plan and it's time to revise the plan to reflect this. Granting other operators only the privilege to start plans means they can still tweak a plan to start it but cannot affect the pool of plan definitions by permanently saving those tweaks.

3.3.7.1 Main User Interface Screen Area

The Edit Plan user interface shown in Exhibit 3.33 (for a sample plan) is divided into five basic screen areas: the menu bar, the toolbar, page tab areas, the action list display area and the status bar.

Exhibit 3.33: Edit Plan Window

3.3.7.2 Toolbar

The edit plan user interface has a toolbar includes from left to right: Save, Start, Refresh and Help.
3.3.7.3 Menu Bar

The edit plan user interface menu bar includes two different pull down menu items.

3.3.7.3.1 Plan Menu

The Plan menu includes eight items.

**New Plan Definition** opens a new window to add a new plan definition to the system. Accelerator key (Ctrl + N) may also be used to perform this task.

**Open Plan Definition** opens the definition of an existing plan created in the system in the edit mode. Accelerator key (Ctrl + O) may also be used to perform this task.

**Monitor Active Plan** allows users to monitor a plan that is actively running in the system.

**Save** item updates the database with all changes made on any region or region contact information. These which will include adding, modifying or deleting a plan in this user interface. The save function is only enabled after a change has occurred on a plan created in the system. Accelerator key (Ctrl + S) may also be used to perform this task.

**Copy**

**Delete Plan Definition** allows a user to delete an existing plan from the system. The deleted plan will temporary disappear from the display list but not from the database unless changes are saved.

**Start** starts a plan that is created in the system. Accelerator key (Ctrl + T) may also be used to perform this task.

**Refresh** retrieves the latest list of regions in the system. Accelerator key **F5** may also be used to perform this task.

3.3.7.3.2 Help Menu
The **Help** menu includes two items.

**Help Topic** opens the online Help file. Accelerator key F1 may also be used to perform this task.

**About** opens a message window with version, release and copyright information about the user interface.

### 3.3.7.4 Procedure to Edit a Plan Definition

This section details the actual instructions needed to guide the operator in performing the task of editing a plan definition in the system.

1. Open the Scenario Management Plans user interface and a dialog as illustrated in Exhibit 3.16 will be opened.
2. Click onto the **Plan Definitions** tab and the dialog as shown in Exhibit 3.17 will be displayed.
3. Select a plan to edit in the system.
4. Select **Open Plan Definition** from the plan menu or the toolbar and an initialization dialog similar to the one shown in Exhibit 3.34 will be displayed as it loads the data for the selected plan. The information in the initialization dialog will change as the information for the plan is successfully loaded into the user interface.

#### Exhibit 3.34: Initialization Window

![Initialization Window](image)

5. When all the information is initialized for the selected plan, a dialog similar to the one shown in Exhibit 3.33 will be opened.
6. You can edit information in any of the sections in this window. Namely: **General**, **Actions and Instructions**, **Contacts**, and **Match Criteria information**.
7. Click the **Save** option on the plan menu bar or toolbar to save the changes for the selected plan to the database. See #9.a, **Saving an Entity**, on page 2-12 for more information on saving changes to the database.

### 3.3.8 Deleting a Plan

This section details how an operator can perform the task of deleting an existing plan from the system. Note that once a plan has been deleted it cannot be recovered and will require that the plan be added to the system again.

1. Open the Scenario Management Plans user interface and a dialog as illustrated in Exhibit 3.16 will be opened.
2. Click onto the **Plan Definitions** tab and the dialog as shown in Exhibit 3.17 will be displayed.
3. Select a plan to delete from the system as shown in Exhibit 3.35.
4. Select the red minus sign “Delete” button from the plan menu or the toolbar and the selected plan will be removed from the display list as shown in Exhibit 3.36.

Exhibit 3.36: Plan Removed From List

5. Click the Save option on the plan menu bar or toolbar to fully delete the selected plan from the database. See #9.a, Saving an Entity, on page 2-12 for more information on saving an entity to the database.

3.4 STARTING A PLAN

This section details how an operator can perform the task of starting a plan that is created in the system.

1. Open the Scenario Management Plans user interface and a dialog as illustrated in Exhibit 3.16 will be opened.
2. Click onto the Plan Definitions tab and the dialog as shown in Exhibit 3.16 will be displayed. A plan to activate in the system.
3. Select Open Plan Definition from the plan menu or the toolbar and an initialization dialog similar to the one shown in Exhibit 3.37 will be displayed as it loads the data for the selected plan. The information in the initialization dialog will change as the information for the plan is successfully loaded into the user interface.
4. When all the information is initialized for the selected plan, a dialog similar to the one shown in Exhibit 3.33 will be opened.

5. Select the **Start** button from the plan menu or the toolbar and the dialog as shown in Exhibit 3.38 will be opened.

**Exhibit 3.38: Plan Expiration Window**

6. Set the termination time for the plan to expire. Termination time can be set using the arrows, the calendar or the use of the **Set** pushbutton that has predefined time settings for **+10 Minutes**, **+1 Hour**, **Next Hour** and **Next Half Hour**.

7. Click the **OK** pushbutton from the dialog and the Edit Plan UI becomes the Monitor UI as shown in Exhibit 3.39. The Monitor UI is only used to monitor Active scenarios or plans in the system. Choose the **Cancel** pushbutton to cancel the operation at any time.

**Exhibit 3.39: Plan Monitor User Interface**
3.5 MONITORING AN ACTIVE PLAN

This section details how an operator can perform the task of monitoring an active plan in the system. Monitoring actions is just verifying that the devices are behaving as expected and reviewing any plan attachments or contacting personnel via ATMS Contacts. Note that when monitoring an active plan, all edit-related functions and controls are disabled.

Note that anytime an active plan is 'managed', the activity is immediately recorded by the system: There is no explicit 'save' function for active plans. These activities are:

- Releasing a device - the device is marked as released for the active plan.
- Re-executing an action - if the device had previously been released through the active plan, it will be reset to un-released.
- Completing the instruction - the instruction is marked as complete for the active plan.
- Noting an instruction - the note is updated for the active plan.

When all actions and instructions have been marked as released/completed, the plan is considered completed. Not all subsystem/devices that participate in scenario management implement a native release command (i.e. VCS). In those cases, release serves only to document the fact that the device is no longer needed for the active plan. For others - such as TIS - the release results in both the action being record as finished for use by the active plan and being returned to the corresponding subsystem for default usage (such as scheduling).

3.5.1 Procedure to Monitor an Active Plan

This section details the actual instructions to guide the operator in performing the task of monitoring an active plan in the system.

1. Open the Scenario Management Plans user interface and a dialog as illustrated in Exhibit 3.40 will be opened. When the window is opened it defaults to the active plans display list in the system.

Exhibit 3.40: Active Plan

2. Select any plan to be monitored in the system from the active plans list.
3. Click SP icon from the active plan menu or tool bar. The dialog in Exhibit 3.41 shows what is displayed when the user hovers over the SP icon. A tool tip is displayed.
4. When the SP icon is clicked, the Plan Monitor UI will be displayed for the selected active plan as shown in Exhibit 3.39.

### 3.5.2 Managing Actions

This section details a few activities involved in managing an active plan. Within the Monitor user interface buttons are available alongside each device action row.

- This button is available within all device action rows for the selected active plan. If the user hovers over this button a tool tip will be displayed “**Perform the action (again)**”. If a device is not currently performing the requested action because of errors or operator input, the action can be performed again by clicking this button. The dialog as shown Exhibit 3.38 will be displayed asking the user to enter a new expiration time to perform the same configured action again on the selected device. This new expiration time that is set will only affect the selected device.

- This button is available within all device action rows for the selected active plan in the system. If the user hovers over this button a tool tip will be displayed “**Release the Device**”. When a device is no longer needed, it should be released using this button and a timestamp showing the date and time when the device was released will be displayed next to this release device button. Subsequent clicks will send another release command to the device and update the timestamp to the current time.

Each row will also have an “**Access the Device**” button with an icon that represents the selected type of device. If the user clicks the button it will to open the default window for the target device.

### 3.5.3 Managing Instructions

This section details the common device command that can be used to manage instructions within the monitoring user interface. An operator can add notes to an instruction at any time - including after it has been marked as completed.

- This button is available for all instructions created in the system. Clicking the button marks the step as complete. Subsequent clicks will update the timestamp to the current time.
### 3.6 RELEASING AN ACTIVE PLAN

This section details how an operator performs the task of releasing an active plan or part of an active plan in the system. When a device or plan is no longer needed, it should be released and a timestamp will be displayed showing when the device or plan was released.

#### 3.6.1 Releasing a Whole Plan

This section details how an operator performs the task of releasing an active plan in the system.

1. Open the Scenario Management Plans user interface and a dialog as illustrated in Exhibit 3.40 will be opened. When the window is opened it defaults to the active plans display list in the system.
2. Select any plan to be released in the system from the active plans list.
3. Click yellow inverted triangle "Release" icon from the active plan menu or tool bar. The dialog in Exhibit 3.42 shows what is displayed when the user hovers over the release icon. A tool tip is displayed.

**Exhibit 3.42: Tool tip for Release Icon**

4. When the Release icon is clicked, the active plan is removed from the active plan display list and the release and monitor icons are grayed out on the toolbar as shown in Exhibit 3.43.

**Exhibit 3.43: Non Active Plans**
3.6.2 Releasing Part of an Active Plan

This section details how an operator performs the task of releasing a part of an active plan in the system. Note that other sections of the plan that were not released will continue to run in the plan. The released action in the plan will be displayed with a timestamp showing a date and time when the action was performed.

1. Open the Scenario Management Plans user interface and a dialog as illustrated in Exhibit 3.44 will be opened. When the window is opened it defaults to the active plans display list in the system.

   Exhibit 3.44: Active Plan

2. Select any plan to be monitored in the system from the active plans list.
3. Click SP icon from the active plan menu or tool bar.
4. The Plan Monitor UI will be displayed for the selected active plan as shown in Exhibit 3.39.
5. Select an action row in the plan and select the Release the Device icon. A timestamp will be displayed next to the icon as shown in Exhibit 3.45 telling when the device was released.

   Exhibit 3.45: Released Device
3.7 COMPARING INCIDENT REPORT WITH MATCH CRITERIA IN SCENARIO MANAGER

This section details how an operator can add new incident reports to the Incident Management System and then comparing the incident report data with the Scenario Manager to see how many plans match the criteria of any plan.

3.7.1 Adding an Incident to IMS

This section details how an operator can perform the task of adding a new incident to the Incident Management System.

1. Open the Incident Management System (IMS) tool and the window shown in Exhibit 2.1 will be displayed.
2. Select **New Incident** from the incident menu or click the icon on the toolbar and the dialog shown in Exhibit 3.46 will be opened.

Exhibit 3.46: Add Incident Window

![Add Incident Window](image)

3. A sample incident report may look similar to the form in Exhibit 3.47

Exhibit 3.47: New Incident Report

![New Incident Report](image)
4. Click the **Add** pushbutton at the bottom of the form and the dialog shown in Exhibit 3.48 will be displayed if multiple street matches have been found for the incident report. Otherwise, select the **Cancel** pushbutton to close the dialog.

**Exhibit 3.48: Location Matches**

5. Select the correct location from the list.
6. Click the **Ok** pushbutton at the bottom of the form. Otherwise, select the **Cancel** pushbutton to close the dialog.
7. The added incident will be added to the active incident list as shown in Exhibit 3.49.

**Exhibit 3.49: Active Incidents**

8. Select the new incident in the active incident list and select **Acknowledge** from the incident menu or the toolbar. The dialog shown in Exhibit 3.50 will be displayed.

**Exhibit 3.50: Acknowledge Incident**
9. Click the **Ok** pushbutton to proceed with the operation. Otherwise, select the **Cancel** pushbutton to close the dialog.

### 3.7.2 Running an Incident Match Criteria vs. a Scenario Plan

This section details how an operator can perform the task in determining what percentage of match criteria of a scenario plan is met by an incident reported in the Incident Management System.

1. Open the Incident Management System (IMS) tool and the window shown in Exhibit 2.1 will be displayed.
2. Select an incident in the active incident list for which you to determine its match criteria with any existing plan in the scenario manager.
3. Select **New Scenario Mgt. Plan** from the incident menu the dialog shown in Exhibit 3.51 will be opened. The dialog will show what percentage of incident report fits the match criteria of all the existing plans created in the Scenario Manager.

**Exhibit 3.51: Match Plan**

The **Match Plan** window takes the match criteria (location, incident type, severity, etc.) of the current incident and presents the list of available plan definitions sorted by an overall ranking of how well they match the incident.

The information in the **Match Criteria** group is the corresponding incident data. As plans are selected from the list, this section is updated to reflect how well the selected plan or plans fulfill the incident's criteria.

The plan list is divided into two sets of columns. The **Plan** columns display the identification information of the available plan definitions and each plan's overall match
ranking. The **Match** columns offer a summary of how well the plan fits the given match criteria. (The **Details** button can be used to show a detailed view of the selected plan or plans in the **Selected Plan(s)** group.).

### 3.7.3 Starting a Single Plan

This section details how an operator can perform the task of starting a single plan in the system from the Match Criteria window.

1. Select an active incident and run a scenario management plan in the Incident Management System and the dialog similar to the one shown in Exhibit 3.51 will be opened.
2. Select one plan to start running in the system as shown in Exhibit 3.52.

**Exhibit 3.52: Selected Plan Match**

3. Click the **Ok** pushbutton to proceed with the operation and launch the Plan window. Otherwise, select the **Cancel** pushbutton to close the dialog.
4. When the **Ok** pushbutton is clicked, the start plan window for the plan selected will loaded as shown in Exhibit 3.53.

**Exhibit 3.53: Start Plan Window**
5. Make last minute modifications (such as adding or removing steps) before actually starting the plan.
6. Start the scenario manager plan. See Section 3.4, Starting a Plan, for more information on starting a plan.

3.7.4 Starting Multiple Plans

This section details how an operator can perform the task of starting multiple plans to run in the system. When multiple plans have been selected you are not starting multiple plan instances: the selected plans are merged into a single plan consisting of all of the individual elements of the selected plans. The one exception to this is the region: at most, only one region can be associated with an active plan. If more than one of the selected plans has an associated region, you will be prompted for which of those regions to carry forward to the active plan.

1. Select an active incident and run a scenario management plan in the Incident Management System and the dialog similar to the one shown in Exhibit 3.51 will be opened.
2. Press and hold the CTRL key and select more than one plan to start running in the system as shown in Exhibit 3.54.

Exhibit 3.54: Multiple Plans Selected

3. Click the Ok pushbutton to proceed with the operation and the dialog shown in Exhibit 3.55 will be displayed asking the user to pick the primary plan or region. Otherwise, select the Cancel pushbutton to close the dialog.
4. Select a plan or region from the displayed list and click the **Ok** pushbutton to merge both plans together as shown in Exhibit 3.56. Otherwise, select the **Cancel** pushbutton to close the dialog.

```
Exhibit 3.55: Pick Primary Plan /Region
```

```
Exhibit 3.56: Merged Plans
```

5. Make last minute modifications (such as adding or removing steps) before actually starting the plan.
6. Start the scenario manager plan. See Section 3.4, Starting a Plan, for more information on starting a plan.
LOS ANGELES COUNTY
INFORMATION EXCHANGE NETWORK

IEN ALARM VIEWER
USER’S GUIDE

VERSION 2.4.1

Prepared for:
Los Angeles County
Department of Public Works

Prepared by:
TransCore
626 Wilshire Blvd
Suite 818
Los Angeles, California 90017

April 20th, 2012
# TABLE OF CONTENTS

<table>
<thead>
<tr>
<th>1. <strong>INTRODUCTION</strong></th>
<th>PAGE #</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.1 Purpose</td>
<td>1-1</td>
</tr>
<tr>
<td>1.2 User Privileges</td>
<td>1-1</td>
</tr>
<tr>
<td>1.3 Starting Alarm Viewer</td>
<td>1-1</td>
</tr>
<tr>
<td>1.4 Document Conventions</td>
<td>1-1</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>2. <strong>OVERVIEW</strong></th>
<th>PAGE #</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.1 Coordination Alarms</td>
<td>2-2</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>3. <strong>SCREEN AREAS</strong></th>
<th>PAGE #</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.1 Alarm List</td>
<td>3-1</td>
</tr>
<tr>
<td>3.2 Alarm Detail Window</td>
<td>3-2</td>
</tr>
<tr>
<td>3.3 Alarm Creation and Display Filters</td>
<td>3-3</td>
</tr>
<tr>
<td>3.3.1 Create Alarm Window</td>
<td>3-3</td>
</tr>
<tr>
<td>3.3.2 Filter Window</td>
<td>3-3</td>
</tr>
<tr>
<td>3.4 Menu Bar</td>
<td>3-5</td>
</tr>
<tr>
<td>3.4.1 System Menu</td>
<td>3-5</td>
</tr>
<tr>
<td>3.4.2 View Menu</td>
<td>3-5</td>
</tr>
<tr>
<td>3.4.3 Action Menu</td>
<td>3-5</td>
</tr>
<tr>
<td>3.4.4 Tools Menu</td>
<td>3-6</td>
</tr>
<tr>
<td>3.4.5 Help Menu</td>
<td>3-6</td>
</tr>
<tr>
<td>3.5 Status Bar</td>
<td>3-6</td>
</tr>
<tr>
<td>3.6 Toolbar</td>
<td>3-6</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>4. <strong>OPERATOR ACTIONS</strong></th>
<th>PAGE #</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.1 Creating Operator Alarms</td>
<td>4-1</td>
</tr>
<tr>
<td>4.2 Acknowledging Alarms</td>
<td>4-1</td>
</tr>
<tr>
<td>4.3 Clearing Alarms</td>
<td>4-1</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>5. <strong>ALARM VIEWER CONFIGURATION</strong></th>
<th>PAGE #</th>
</tr>
</thead>
<tbody>
<tr>
<td>5.1 Polling Interval</td>
<td>5-1</td>
</tr>
</tbody>
</table>

APPENDIX A – INDEX | A-1
<table>
<thead>
<tr>
<th>EXHIBIT</th>
<th>PAGE #</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exhibit 2.1: Alarm Viewer</td>
<td>2-1</td>
</tr>
<tr>
<td>Exhibit 3.1: Alarm Viewer Screen Areas</td>
<td>3-1</td>
</tr>
<tr>
<td>Exhibit 3.2: Alarm List Data Fields</td>
<td>3-1</td>
</tr>
<tr>
<td>Exhibit 3.3: Alarm Detail Window</td>
<td>3-2</td>
</tr>
<tr>
<td>Exhibit 3.4: Create Alarm Window</td>
<td>3-3</td>
</tr>
<tr>
<td>Exhibit 3.5: Alarm Filter Window</td>
<td>3-4</td>
</tr>
<tr>
<td>Exhibit 3.6: Alarm Status Bar</td>
<td>3-6</td>
</tr>
<tr>
<td>Exhibit 3.7: Alarm Toolbar</td>
<td>3-6</td>
</tr>
<tr>
<td>Exhibit 4.1: Create Alarm Window</td>
<td>4-1</td>
</tr>
<tr>
<td>VERSION</td>
<td>DATE</td>
</tr>
<tr>
<td>--------------------</td>
<td>------------</td>
</tr>
<tr>
<td>Draft</td>
<td>12/13/02</td>
</tr>
<tr>
<td>Interim Final</td>
<td>3/30/06</td>
</tr>
<tr>
<td>Final</td>
<td>4/2/07</td>
</tr>
<tr>
<td>FINAL, Revision 1</td>
<td>9/20/11</td>
</tr>
<tr>
<td>Version 2.4.1</td>
<td>4/20/12</td>
</tr>
</tbody>
</table>
1. INTRODUCTION

1.1 PURPOSE
This document describes the features and use of the IEN Alarm Viewer.

1.2 USER PRIVILEGES
All IEN users have access to the Alarm Viewer and may view all operator alarms within the system. Only users at the Agency of the operator who originally generated the alarm and members of the IEN Administrators user group can acknowledge or clear an operator alarm.

Access to TCS and Coordination alarms depends upon the privileges granted to the particular user. In order to view an alarm from a particular device, a user must hold the VIEW privilege for the device’s resource group. Operators must hold the MODIFY privilege for a device in order to acknowledge or clear its alarms.

The IEN System Administrator’s Guide and the online help screens within the IEN System Configuration Manager contain more information about IEN system privileges.

1.3 STARTING ALARM VIEWER
Alarm Viewer can be started by double-clicking the IEN Alarm Viewer icon on the desktop or by selecting START > ALL PROGRAMS > LOS ANGELES COUNTY IEN > IEN ALARM VIEWER.

1.4 DOCUMENT CONVENTIONS
There are locations in this document where formatted text is used, as illustrated below.

<table>
<thead>
<tr>
<th>C:&gt; <strong>edit readme.txt</strong></th>
<th>A monospace font is used to show displayed prompts and typed commands. The bold text is text that should be typed.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>&lt;TAB&gt;</strong></td>
<td>Text enclosed in brackets indicates keystrokes.</td>
</tr>
<tr>
<td><strong>&lt;SHIFT&gt;+&lt;F1&gt;</strong></td>
<td>A plus sign indicates that two keys are to be pressed simultaneously; the first key is held down while the second key is pressed.</td>
</tr>
<tr>
<td><strong>File</strong></td>
<td>A bold font represents a button or menu option such as the <strong>OK</strong> button.</td>
</tr>
</tbody>
</table>
2. OVERVIEW

Alarm Viewer displays current alarm conditions within the IEN.

Exhibit 2.1: Alarm Viewer

There are three types of alarms:

- **Operator**: Alarms generated manually by IEN operators. For example, an operator creates an alarm to notify other operators that an intersection controller is being taken offline for repairs.

- **TCS**: Alarms generated automatically when the IEN detects that a TCS device is reporting an alarm state. For example, an alarm is declared when an intersection controller reports events or states such as “conflict flash”, “cabinet door open,” or “internal error.”

- **Coordination**: Alarms generated automatically when the IEN detects that an intersection controller is running a different control mode, timing plan, cycle length, or offset than they did at the same time the previous week. Coordination alarms are reported only for intersections with coordination monitoring and alarms enabled.

Operator alarms are displayed to all IEN users. These alarms must be acknowledged and cleared from the system. There are two types of clearance policies for operator alarms:

- **Manual Clear** alarms must be acknowledged and cleared.

- **Clear on Acknowledge** alarms will clear automatically after being acknowledged.

TCS and coordination alarms are displayed only to those users who have been granted the VIEW privilege for the originating entity.

Alarms are acknowledged and cleared by authorized operators as they respond to the alarm condition. Acknowledging an alarm indicates that corrective action has been initiated. Alarms are cleared when the alarm condition no longer exists.
2.1 COORDINATION ALARMS

Coordination alarms are generated when the IEN detects that an intersection controller is running a different control mode, timing plan, cycle length, or offset than it did at the same time the previous week.

For the IEN to generate coordination alarms for a device, coordination monitoring and alarms must be enabled for that device for a minimum of one week to allow the IEN to build a set of reference coordination data. Administrators can configure the IEN to ignore coordination changes that occur on special days such as holidays.

The following conditions can cause the IEN to generate coordination alarms for intersections:

- An intersection’s current control mode differs from the historical control mode.
- An intersection’s current timing plan differs from the historical timing plan AND its communication status is good AND its control mode is not actuated.
- An intersection’s current offset or cycle length differs from the historical offset or cycle length AND its communication status is good AND its control mode is TIME_BASECOORDINATION or FIXED_TIME or EXTERNAL or TRAFFIC_RESPONSIVE.

Coordination monitoring and alarms are configured through the IEN System Configuration Manager application. See that application's help screens for more information.
3. SCREEN AREAS

The major screen components of Alarm Viewer, shown in Exhibit 3.1, are:

- Alarm list
- Dialogs
- Alarm detail
- Menu bar
- Status bar
- Toolbar

Exhibit 3.1: Alarm Viewer Screen Areas

3.1 ALARM LIST

The Alarm list, shown above in Exhibit 3.2, displays alarm records that match the selected filter criteria and view privileges of the logged on user.

Alarm records include the following information:

Exhibit 3.2: Alarm List Data Fields

<table>
<thead>
<tr>
<th>FIELD</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>The unique numeric identifier for the alarm.</td>
</tr>
<tr>
<td>Status</td>
<td>The status of the alarm:</td>
</tr>
<tr>
<td></td>
<td>- Active: Open, no correcting action has been initiated.</td>
</tr>
<tr>
<td></td>
<td>- Acknowledged: Open, correcting action has been initiated.</td>
</tr>
<tr>
<td></td>
<td>- Auto Cleared: Alarm condition no longer detected.</td>
</tr>
<tr>
<td></td>
<td>- Cleared: Cleared by operator.</td>
</tr>
<tr>
<td>Type</td>
<td>The type of alarm: Operator, TCS, or Coordination</td>
</tr>
<tr>
<td>Corridor</td>
<td>The corridor in which the generating device or user resides.</td>
</tr>
<tr>
<td>FIELD</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>-------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Site</td>
<td>The site at which the generating device or user is located.</td>
</tr>
<tr>
<td>System</td>
<td>The system through which the generating device is connected to the IEN.</td>
</tr>
<tr>
<td>Reporting Agency</td>
<td>The agency to which the generating device or user belongs.</td>
</tr>
<tr>
<td>Creator</td>
<td>The user or device that generated the alarm.</td>
</tr>
<tr>
<td>Message</td>
<td>The alarm description.</td>
</tr>
<tr>
<td>Created Date</td>
<td>The date and time that the alarm was generated.</td>
</tr>
<tr>
<td>Source</td>
<td>For operator alarms, the system on which the alarm was created.</td>
</tr>
<tr>
<td></td>
<td>For TCS and coordination alarms, the IEN software component which detected the alarm.</td>
</tr>
</tbody>
</table>

Hold down the `<SHIFT>` key to select multiple records in the alarm list.

### 3.2 ALARM DETAIL WINDOW

The Alarm Detail window, shown in Exhibit 3.3, can be opened by double-clicking an alarm record in the Alarm list. It provides additional alarm management information for the selected alarm. Click **OK** to close the window.

**Exhibit 3.3: Alarm Detail Window**
### 3.3 ALARM CREATION AND DISPLAY FILTERS

#### 3.3.1 Create Alarm Window

The Create Alarm window is used to create operator alarms. To open the window, select the **Create New** option on the Alarm menu or toolbar.

**Exhibit 3.4: Create Alarm Window**

The Create New Alarm window, shown in Exhibit 3.4, includes the following items:

- **Clearance Policy** is used to set the clearance policy for the alarm. **Manual Clear** alarms must be acknowledged *and* cleared. **Clear On Acknowledge** alarms change status automatically to "Auto Cleared" upon being acknowledged.

- The **Message** box enables the user to type the text of the alarm message.

Clicking **OK** declares a new alarm; clicking **Cancel** discontinues creation of the alarm and closes the window.

#### 3.3.2 Filter Window

The Alarm Filter window, shown in Exhibit 3.5, is used to select the types of alarms that are displayed in the alarm list. To open the filter, select the **Filter** option on the **Tools** menu or toolbar.
Exhibit 3.5: Alarm Filter Window

Alarms can be filtered by date, status, and type, and the location of the generating user or device. Only alarms that meet all specified criteria are displayed in the alarm list.

One of the Generated Since date filters is applied to the alarm list:

- No Date Filtering
- Last Hour
- Last 24 Hours
- Last 48 Hours
- Since [a specified date and time]
- Between [two specified dates and times]

One or more Alarm Status filters can be applied to the Alarm list:

- Active Alarm
- Acknowledged
- Cleared

One or more Alarm Type filters can be applied to the Alarm list:

- Operator Generated
- TCS Generated
- Coordination Generated

One or more Location filters can be applied to the Alarm list:

- Corridors
- Sites
- Systems
The Alarm Filter window includes the following buttons:
- **Apply** filters the Alarm list by the selected filter settings.
- **Cancel** discards any changes and closes the window.
- **Reset** restores the filter settings to their initial values.

### 3.4 MENU BAR

The Menu bar includes the following menus:
- System menu
- View menu
- Action menu
- Tools menu
- Help menu

#### 3.4.1 System Menu

The System menu contains three commands:
- **Connect** initiates communication between the IEN Alarm Server, which provides alarm data, and Alarm Viewer.
- **Disconnect** stops communication between the IEN Alarm Server and Alarm Viewer.
- **Exit** exits Alarm Viewer.

When Alarm Viewer starts, it attempts to connect to the IEN Alarm Server automatically. If communication with the server is disrupted, Alarm Viewer periodically attempts to reconnect.

#### 3.4.2 View Menu

The View menu contains three commands:
- When the **Status Bar** command is checked, the status bar is displayed; otherwise, it is hidden.
- When the **Message Window** command is checked, the Alarm Viewer Message Window is displayed; otherwise, it is hidden.
- **Refresh** polls the IEN Alarm Server for new alarm data.

Alarm Viewer polls the IEN Alarm Server automatically at the configured interval. The polling interval is described in Section 5.1.

#### 3.4.3 Action Menu

The Action menu contains three commands:
- **Create New** opens the Create Alarm window.
- **Acknowledge** acknowledges the selected alarm.
- **Clear Alarm** clears the selected alarm.

Action menu commands are also available on the toolbar.
3.4.4 Tools Menu
The Tools menu contains a single command, Filter, which opens the Alarm Filter window.

3.4.5 Help Menu
The Help menu contains two commands:
- Help Topics opens the online help screens for Alarm Viewer.
- About AlarmViewer displays copyright and version information.

3.5 STATUS BAR
The status bar, shown in Exhibit 3.6, displays status information for Alarm Viewer.

Exhibit 3.6: Alarm Status Bar

The status bar contains four panes (from left to right):
- The first pane indicates when Alarm Viewer is performing an action that requires the user to wait, such as polling for new alarm data. Copyright information is shown when no action is being performed. Pane 1 will also display help information when the mouse pointer is hovered over a menu command or a toolbar button.
- The second pane shows which alarm status and type filters are active.
- The third pane shows which date filter is active.
- The fourth pane shows the number of alarms that match the selected filters.

3.6 TOOLBAR
The toolbar, shown in Exhibit 3.7, contains five buttons:
- Create New Alarm opens the Create Alarm window.
- Acknowledge Selected Alarms changes the status of active alarms selected in the alarm list to acknowledged or auto cleared (depending on their clearance policy).
- Clear Selected Alarms changes the status of acknowledged alarms selected in the alarm list area to manual cleared.
- Create or Apply Alarm Filter opens the alarm Filter window.
- About opens the About AlarmViewer window.

Exhibit 3.7: Alarm Toolbar
4. OPERATOR ACTIONS

4.1 CREATING OPERATOR ALARMS

To create an operator alarm, follow these steps:

1. Select the Create New option from the Action menu or toolbar to open the Create Alarm window (shown in Exhibit 4.1).
2. Select a Clearance Policy. Manual Clear alarms must be acknowledged and cleared. Clear On Acknowledge alarms are automatically cleared when they are acknowledged.
3. Enter the alarm message
4. Click OK to create the alarm

Exhibit 4.1: Create Alarm Window

4.2 ACKNOWLEDGING ALARMS

To acknowledge an alarm, select it in the alarm list and then choose the Acknowledge option on the Action menu or toolbar. Only active alarms can be acknowledged.

4.3 CLEARING ALARMS

To clear an alarm, select it in the alarm list and then choose the Clear option on the Action menu or toolbar. Only acknowledged alarms can be cleared.
5. ALARM VIEWER CONFIGURATION

The following configuration parameters can be used to fine-tune the performance of Alarm Viewer:

5.1 POLLING INTERVAL

On workstations, the following registry key specifies the interval at which Alarm Viewer polls the IEN Alarm Server for new alarm data:

```
HKLM\SOFTWARE\TransCore\AlarmViewer "PollingInterval"=dword:0000003c
```

For optimum performance, the `PollingInterval` value should be set to 120 seconds or longer.
# APPENDIX A – INDEX

## About Alarm Viewer, 3-6

## Acknowledge, 3-5, 3-6

### Alarm clearance policy
- Clear on Acknowledge, 2-1
- Manual Clear, 2-1

## Alarm Created Date, 3-2

## Alarm Creator, 3-2

## Alarm Detail, 3-2

## Alarm ID, 3-1

## Alarm Message, 3-2

## Alarm Source, 3-2

## Alarm Status, 3-1

## Alarm Type, 3-1

## Alarm Viewer
- Configuration, 1
- Field descriptions, 3-1
- Filters, 3-3
- Menu bar, 3-5
- Status bar, 3-6
- Toolbar, 3-6

## Alarms
- Acknowledging, 4-1
- Clearing, 4-1
- Creating, 3-3, 4-1
- Operator, 2-1
- TCS, 2-1

## Browser List, 3-1

## Clear, 3-6

## Clear Alarm, 3-5

## Clear on Acknowledge, 3-3

## Configuration
- Polling Interval, 2

## Connect, 3-5

## Coordination alarms, 2-2

## Corridor, 3-1

## Create New, 3-5

## Create New Alarm, 3-6

## Disconnect, 3-5

## Filter, 3-6

## Filters
- Date, 3-4
- Location, 3-4
- Status, 3-4
- Type, 3-4

## Help Topics, 3-6

## Launch Alarm Filter, 3-6

## Manual Clear, 3-3

## Menu
- Action Menu, 3-5
- Help Menu, 3-6
- System Menu, 3-5
- Tools Menu, 3-6
- View Menu, 3-5

## Privileges
- MODIFY, 1-1
- VIEW, 1-1

## Reporting Agency, 3-2

## Site, 3-2

## System, 3-2
# TABLE OF CONTENTS

1. INTRODUCTION................................................................................................................ 1-1
   1.1 Purpose ................................................................................................................... 1-1
   1.2 System Log Viewer Privileges .............................................................................. 1-1
   1.3 Starting System Log Viewer ................................................................................. 1-1
   1.4 Document Conventions ....................................................................................... 1-1

2. OVERVIEW ......................................................................................................................... 2-1

3. SCREEN AREAS.................................................................................................................. 3-1
   3.1 Menu Bar ............................................................................................................... 3-1
      3.1.1 System Menu .............................................................................................. 3-2
      3.1.2 View Menu ............................................................................................... 3-2
      3.1.3 Tools Menu .............................................................................................. 3-2
      3.1.4 Help Menu ............................................................................................... 3-3
   3.2 Toolbar ..................................................................................................................... 3-3
   3.3 Filtering Selection Area ......................................................................................... 3-4
      3.3.1 Simple Filter .............................................................................................. 3-4
      3.3.2 Complex Filters ....................................................................................... 3-4
   3.4 List Area ................................................................................................................ 3-6
   3.5 Status Bar ............................................................................................................. 3-6

APPENDIX A - INDEX.......................................................................................................... A-1
## LIST OF EXHIBITS

<table>
<thead>
<tr>
<th>Exhibit</th>
<th>PAGE #</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exhibit 1.1: System Log Viewer Privileges</td>
<td>1-1</td>
</tr>
<tr>
<td>Exhibit 2.1: System Log Viewer</td>
<td>2-1</td>
</tr>
<tr>
<td>Exhibit 3.1: System Log Viewer Main Window</td>
<td>3-1</td>
</tr>
<tr>
<td>Exhibit 3.2: About System Log Viewer</td>
<td>3-3</td>
</tr>
<tr>
<td>Exhibit 3.3: Toolbar</td>
<td>3-3</td>
</tr>
<tr>
<td>Exhibit 3.4: Filtering Area</td>
<td>3-4</td>
</tr>
<tr>
<td>Exhibit 3.5: Complex Filter Window</td>
<td>3-5</td>
</tr>
<tr>
<td>Exhibit 3.6: List Area</td>
<td>3-6</td>
</tr>
<tr>
<td>Exhibit 3.7: Status Bar</td>
<td>3-6</td>
</tr>
</tbody>
</table>
## DOCUMENTATION REVISION HISTORY

<table>
<thead>
<tr>
<th>VERSION</th>
<th>DATE</th>
<th>DESCRIPTION</th>
<th>REVIEWED BY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Draft</td>
<td>12/13/02</td>
<td>Initial Draft</td>
<td>Chuck Dankocsik</td>
</tr>
<tr>
<td>Interim Final</td>
<td>3/30/06</td>
<td>COTS Migration updates</td>
<td>Jack Schneider</td>
</tr>
<tr>
<td>Final</td>
<td>4/2/07</td>
<td>Updated for IEN Software Version 1.09</td>
<td>Kevin Leamon</td>
</tr>
<tr>
<td>FINAL, Revision 1</td>
<td>9/20/11</td>
<td>Updated for IEN Multiple Corridor Server Project (IEN Software Version 2.02)</td>
<td>Chuck Dankocsik</td>
</tr>
<tr>
<td>Version 2.4.1</td>
<td>4/20/12</td>
<td>Updated for Freeway interface &amp; Outbound interface projects (IEN Software Version 2.4.1)</td>
<td>Chuck Dankocsik</td>
</tr>
</tbody>
</table>
1. INTRODUCTION

1.1 PURPOSE
This document describes how to filter and display event messages in the TransSuite ATMS System Log Viewer.

1.2 SYSTEM LOG VIEWER PRIVILEGES
Each ATMS user group is assigned specific access rights and privileges. Exhibit 1.1 shows the key commands accessible to each group.

Exhibit 1.1: System Log Viewer Privileges

<table>
<thead>
<tr>
<th>PRIVILEGE</th>
<th>SUPERVISOR</th>
<th>OPERATOR</th>
<th>EDITOR</th>
<th>GUEST</th>
</tr>
</thead>
<tbody>
<tr>
<td>View System Logs</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
</tbody>
</table>

1.3 STARTING SYSTEM LOG VIEWER
The TransSuite ATMS System Log Viewer can be started by double-clicking the TransSuite ATMS System Log Viewer icon on the desktop or by clicking TransSuite ATMS System Log Viewer on the Windows Start Menu (Start → All Programs → Information Exchange Network → TransSuite ATMS System Log Viewer).

1.4 DOCUMENT CONVENTIONS
There are locations in this document where formatted text is used, as illustrated below.

<table>
<thead>
<tr>
<th>C:&gt; edit readme.txt</th>
<th>A monospace font is used to show displayed prompts and typed commands. The bold text is text that should be typed.</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;TAB&gt;</td>
<td>Text enclosed in brackets indicates keystrokes.</td>
</tr>
<tr>
<td>&lt;SHIFT&gt;+&lt;F1&gt;</td>
<td>A plus sign indicates that two keys are to be pressed simultaneously; the first key is held down while the second key is pressed.</td>
</tr>
<tr>
<td>File</td>
<td>A bold font represents a button or menu in the application such as the File menu or the OK button.</td>
</tr>
</tbody>
</table>
2. OVERVIEW

The TransSuite ATMS System Log Viewer, shown in Exhibit 2.1, enables the user to view, filter, sort, and print messages generated by the ATMS programs. When System Log Viewer starts, no filters are applied and no log items are displayed. Simple or complex filters must be applied in order for log items to appear in the list. Section 3.3 provides more information on the log filters.

Log entries are created for all activities that change the operation of the ATMS or that affect the operation of connected systems. These events include operator login, the starting and stopping of services and applications, and the sending of commands to devices. Log entries are also created for detected errors and for other information that would be useful in diagnosing problems.

Exhibit 2.1: System Log Viewer
3. SCREEN AREAS

The main window of System Log Viewer is shown in Exhibit 3.1.

Exhibit 3.1: System Log Viewer Main Window

The window is made up of the following screen areas:

- Menu bar
- Toolbar
- Filter selection area
- List area
- Status bar

3.1 MENU BAR

The menu bar includes the following menus:

- System menu
- View menu
- Tools menu
- Help menu

Many of the commands that are found on these menus can be accessed on the toolbar or by keyboard shortcuts.
3.1.1 System Menu

The System menu includes the following four commands:

- **Print** opens the Print window, from which the user can print the current list of system log messages.
- **Print Preview** opens a preview window of the list of system log messages.
- **Print Setup** opens the Print Setup window.
- **Exit** exits System Log Viewer.

3.1.2 View Menu

The View menu contains the following eight commands. All of the commands, except the **Toolbar** and **Status Bar** commands, are also available on the toolbar and on the filtering selection area of the main window.

- **Toolbar** turns the program toolbar on or off. A check mark appears next to the command when the toolbar is turned on.
- **Status Bar** turns the status bar on or off. A check mark appears next to the command when the status bar is turned on.
- **Refresh** updates the system log message list by reapplying the active filter to all current system log data.
- **Retrieve Oldest Events First** reads the log entries from the database beginning with the oldest entries. The oldest entry in the list becomes the selected entry in the list. A check mark appears next to this command if it is the order currently applied to the list.
- **Retrieve Newest Events First** reads the log entries from the database beginning with the newest entries. The newest entry in the list becomes the selected entry in the list. A check mark appears next to this command if it is the order currently applied to the list.
- **The Complex Filter** and **Simple Filter** commands apply sets of filters to the system event log list, as described in Section 3.3.
- **Other programs can start System Log Viewer to show event messages for particular devices. This capability is provided by System Log Viewer’s automation interface. **
- **Detach** breaks the connection between an instance of System Log Viewer and the program that started it.

3.1.3 Tools Menu

The Tools menu contains only one command, **Open ATMS Navigator**, which starts the ATMS Map program.
3.1.4 Help Menu

The Help menu contains the following commands:

- **Help Topics** opens the online help for System Log Viewer.
- **About System Log Viewer** opens the version and copyright information window, shown in Exhibit 3.2.

![Exhibit 3.2: About System Log Viewer](image)

3.2 TOOLBAR

The Toolbar, which can be turned on or off from the View menu, provides easy access to five commands. These commands are also available on the View and Help menus.

The toolbar buttons, shown in Exhibit 3.3, are described from left to right:

![Exhibit 3.3: Toolbar](image)

- **Refresh** updates the system log message list by reapplying the active filter to all current system log data.
- **Retrieve Oldest Events First** reads the log entries from the database beginning with the oldest entries. The oldest entry in the list becomes the selected entry in the list. A check mark appears next to this command if it is the order currently applied to the list.
- **Retrieve Newest Events First** reads the log entries from the database beginning with the newest entries. The newest entry in the list becomes the selected entry in the list. A check mark appears next to this command if it is the order currently applied to the list.
- Other programs can start System Log Viewer to show event messages for particular devices. This capability is provided by System Log Viewer’s automation interface. **Detach** breaks the connection between an instance of System Log Viewer and program that started it.
- **About System Log Viewer** opens a window that includes copyright and version information about System Log Viewer.
3.3 FILTERING SELECTION AREA

The Filtering Selection area, shown in Exhibit 3.4, provides access to the complex and simple filters. This area contains the Complex and Simple command buttons as well as the simple filter criteria values.

Exhibit 3.4: Filtering Area

3.3.1 Simple Filter

Simple applies the simple filter criteria selected in the filtering pane shown in Exhibit 3.4. The filters are additive, so only messages meeting all of the selected criteria appear in the list area. The simple filter criteria include:

- **Generated Since** enables specification of a starting date and time. Only messages that have been generated since then are considered for inclusion in the filtered list display.
- **Severity** enables filtering by the type of system log.
- **Org** enables filtering by the organization of the entity that generated the system log.
- **Source** enables filtering by the system component that generated the system log.
- **Entity Type** enables filtering by a particular type of IEN entity.
- **ID** enables filtering the log to include only entries generated by a particular device. If no ID is specified, ID is not used to filter log messages.

The “*” symbol is used for the Severity, Source, and Entity Type values to indicate that all listed values for each list are included in the filtering.

3.3.2 Complex Filters

Complex opens the Complex Filter window, shown in Exhibit 3.5, which enables the construction of filtering criteria. Only system log messages that meet all the criteria are displayed in the list area.

One or more criteria must be selected in the Severity, Source, Entity Type, and Organization areas. At least one Severity value, one Source value, and one Entity Type value must be selected; otherwise, all messages are excluded in the list area.

One of the following options in the Generated Since can be selected:

- **Any Date** includes all messages regardless of the date.
- **Last hour** includes all messages generated within the last hour.
- **Last 24 hours** includes all messages generated within the last 24 hours.
- **Last 48 hours** includes all messages generated within the last 48 hours.
- **Since** includes all messages generated since the specified date and time.
- **Between** includes all messages generated between the specified dates and times.

If the list view is refreshed while either Last hour, Last 24 hours, or Last 48 hours in the Generated Since area is selected:
- The list is updated to include the most recent messages.
- Messages older than the selected period are removed from the list.

**Exhibit 3.5: Complex Filter Window**

A single entity ID or a list of entity ID’s can be typed, separated by spaces or commas, in the **Entity ID’s** area. Messages that match any of the entity id’s appear in the list.

In the **Message ID’s** area, a single message ID (message number) or a list of ID’s, separated by spaces or commas, can be typed. Only events with the specified message ID’s appear in the list.

Clicking **OK** applies the filters. The **Complex Filter** dialog box closes and the main window opens and displays the results of the filtering. Clicking **Cancel** closes the dialog box without applying the filters. Clicking **Reset** restores the **Complex Filter** values to their initial settings.
3.4 LIST AREA

The list area, shown in Exhibit 3.6, contains the system log messages that meet the selected filtering criteria. The messages are sorted in ascending order by date and time. The columns in the list can be resized by dragging the column dividers in the header.

Exhibit 3.6: List Area

<table>
<thead>
<tr>
<th>Generated</th>
<th>Org</th>
<th>Source</th>
<th>Entity Type</th>
<th>ID</th>
<th>Msg. #</th>
<th>Message</th>
<th>Log ID</th>
<th>Workstation Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>04/21/2009 08:14:36</td>
<td>LACO</td>
<td>RegSvr</td>
<td>RegSvr</td>
<td>1</td>
<td>507</td>
<td>Site4, distributed data 149 times, MaxMin...</td>
<td>13771279</td>
<td>Iens1</td>
</tr>
<tr>
<td>04/21/2009 08:14:36</td>
<td>LACO</td>
<td>RegSvr</td>
<td>RegSvr</td>
<td>1</td>
<td>507</td>
<td>Site4, distributed 0 bytes composed of 0...</td>
<td>13771280</td>
<td>Iens1</td>
</tr>
<tr>
<td>04/21/2009 08:14:36</td>
<td>LACO</td>
<td>RegSvr</td>
<td>RegSvr</td>
<td>1</td>
<td>506</td>
<td>Site9 collected data 334 out of 334 times,M...</td>
<td>13771281</td>
<td>Iens1</td>
</tr>
<tr>
<td>04/21/2009 08:14:36</td>
<td>LACO</td>
<td>RegSvr</td>
<td>RegSvr</td>
<td>1</td>
<td>506</td>
<td>Site5 collected 112887 bytes of data comp...</td>
<td>13771282</td>
<td>Iens1</td>
</tr>
<tr>
<td>04/21/2009 08:14:36</td>
<td>LACO</td>
<td>RegSvr</td>
<td>RegSvr</td>
<td>1</td>
<td>507</td>
<td>Site5, distributed data 300 times, MaxMin...</td>
<td>13771283</td>
<td>Iens1</td>
</tr>
<tr>
<td>04/21/2009 08:14:36</td>
<td>LACO</td>
<td>RegSvr</td>
<td>RegSvr</td>
<td>1</td>
<td>507</td>
<td>Site5, distributed 93175 bytes composed of...</td>
<td>13771284</td>
<td>Iens1</td>
</tr>
<tr>
<td>04/21/2009 08:14:36</td>
<td>LACO</td>
<td>RegSvr</td>
<td>RegSvr</td>
<td>1</td>
<td>506</td>
<td>Site8 collected data 328 out of 328 times,M...</td>
<td>13771285</td>
<td>Iens1</td>
</tr>
<tr>
<td>04/21/2009 08:14:36</td>
<td>LACO</td>
<td>RegSvr</td>
<td>RegSvr</td>
<td>1</td>
<td>506</td>
<td>Site8 collected 1077803 bytes of data comp...</td>
<td>13771286</td>
<td>Iens1</td>
</tr>
<tr>
<td>04/21/2009 08:14:36</td>
<td>LACO</td>
<td>RegSvr</td>
<td>RegSvr</td>
<td>1</td>
<td>507</td>
<td>Site8, distributed data 301 times, MaxMin...</td>
<td>13771287</td>
<td>Iens1</td>
</tr>
<tr>
<td>04/21/2009 08:14:36</td>
<td>LACO</td>
<td>RegSvr</td>
<td>RegSvr</td>
<td>1</td>
<td>507</td>
<td>Site8, distributed 129866 bytes composed of...</td>
<td>13771288</td>
<td>Iens1</td>
</tr>
<tr>
<td>04/21/2009 08:14:36</td>
<td>LACO</td>
<td>RegSvr</td>
<td>RegSvr</td>
<td>1</td>
<td>506</td>
<td>Site6 collected data 301 out of 449 times,M...</td>
<td>13771289</td>
<td>Iens1</td>
</tr>
<tr>
<td>04/21/2009 08:14:36</td>
<td>LACO</td>
<td>RegSvr</td>
<td>RegSvr</td>
<td>1</td>
<td>506</td>
<td>Site6 collected 132881 bytes of data comp...</td>
<td>13771290</td>
<td>Iens1</td>
</tr>
<tr>
<td>04/21/2009 08:14:36</td>
<td>LACO</td>
<td>RegSvr</td>
<td>RegSvr</td>
<td>1</td>
<td>507</td>
<td>Site6, distributed data 300 times, MaxMin...</td>
<td>13771291</td>
<td>Iens1</td>
</tr>
<tr>
<td>04/21/2009 08:14:36</td>
<td>LACO</td>
<td>RegSvr</td>
<td>RegSvr</td>
<td>1</td>
<td>507</td>
<td>Site6, distributed 71370 bytes composed of...</td>
<td>13771292</td>
<td>Iens1</td>
</tr>
<tr>
<td>04/21/2009 08:14:36</td>
<td>LACO</td>
<td>RegSvr</td>
<td>RegSvr</td>
<td>1</td>
<td>506</td>
<td>Site2 collected data 334 out of 334 times,M...</td>
<td>13771293</td>
<td>Iens1</td>
</tr>
<tr>
<td>04/21/2009 08:14:36</td>
<td>LACO</td>
<td>RegSvr</td>
<td>RegSvr</td>
<td>1</td>
<td>506</td>
<td>Site2 collected 297971 bytes of data comp...</td>
<td>13771294</td>
<td>Iens1</td>
</tr>
</tbody>
</table>

The first item in each row is a symbol that indicates the severity of the message:

- ☐ Informational message
- ☒ Warning message
- ☑ Failure message
- ☐ Debug message

The other columns are defined below:

- **Generated** is the date and time the message was generated.
- **Org** is the organization of the entity that generated the message.
- **Source** is the system component that generated the message.
- **Entity Type** is the type of entity to which the message refers.
- **ID** is the ID of the entity for which the message was generated.
- **Msg. #** is the message type number.
- **Message** is the text of the message.
- **Log ID** is the unique identifier for the event message.
- **Workstation Name** is the workstation from which the message was generated.

3.5 STATUS BAR

The status bar, shown in Exhibit 3.7, can be turned on or off by the **Status Bar** command on the **View** menu.

Exhibit 3.7: Status Bar
The status bar is composed of five panes:

- The **current activity** pane displays a description of the current system activity, such as “Reading Log Data.” When no tasks are being performed, the copyright information is displayed.

- The **filter** pane identifies the type of filter that has been applied to the system log, such as “No filtering”, “Simple filtering,” or “Complex filtering.”

- The **latest data-sampling** pane displays the time that the last data read occurred.

- The **number of messages** pane shows the number of messages in the list.

- The **message severity** pane indicates the most severe message in the current list. The hierarchy, from least to most severe, is debug, informational, warning, and failure.
APPENDIX A - INDEX

About System Log Viewer, 3-3
Access Privileges, 1-1
Any Date, 3-4
Between, 3-4
Complex, 3-4
Complex Filter, 3-2
Complex Filters, 3-4
Detach, 3-2, 3-3
Entity IDs, 3-5
Entity Type, 3-4, 3-6
Exit, 3-2
Generated, 3-6
Generated Since, 3-4
Help Topics, 3-3
ID, 3-4, 3-6
Last 24 Hours, 3-4
Last 48 Hours, 3-4
Last Hour, 3-4
Logs, 2-1

Menu
Help Menu, 3-3
System Menu, 3-2
Tools Menu, 3-2
View Menu, 3-2

Message, 3-6
Message IDs, 3-5
Msg. #, 3-6
Open ATMS Navigator, 3-2
Org, 3-4, 3-6
Print, 3-2
Print Preview, 3-2
Print Setup, 3-2
Refresh, 3-2, 3-3
Reset, 3-5
Retrieve Newest Events First, 3-2, 3-3
Retrieve Oldest Events First, 3-2, 3-3
Severity, 3-4
Simple, 3-4
Simple Filter, 3-2, 3-4
Since, 3-4
Source, 3-4, 3-6
Status Bar, 3-6
Status Bar toggle, 3-2
Toolbar, 3-3
Toolbar toggle, 3-2